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1 Introduction 

 

ELPLA (ELASTIC PLATE) is a program for analyzing raft foundations of arbitrary shape with 

the real subsoil model. The mathematical solution of the raft is based on the FE-Method. The 

program can analyze different types of subsoil models, especially the three-dimensional 

Continuum model that considers any number of irregular layers. A good advantage of this 

program is the capability to handle the three analyses of flexible, elastic and rigid foundations. In 

addition, the mesh of the rigid and flexible foundations can be constructed to be analogous to the 

finite elements mesh of the elastic foundation. Therefore the three analyses can be compared 

easily and correctly. ELPLA can also be used to represent the effect of external loads, 

neighboring foundations, tunneling and the influence of the temperature difference on the raft. 

 

ELPLA is a 32-bit, graphical software product that operates under Microsoft Windows 9x/ NT/ 

ME/ XP. The common "what you see is what you get" of Windows applications makes it easy to 

learn how to use ELPLA, especially if you are already familiar with the Windows environment.  

 

The program package ELPLA consists of 7 separate programs. These can run independently. The 

names and short descriptions of the separate programs are shown in Table A-1. 

 

Table A-1 Names and descriptions of ELPLA programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               Simple word processing program 
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2 Calculation methods 

 

In ELPLA 9 different numerical methods with 3 soil models are considered for analyzing raft 

foundations as follows: 

 

1)  Linear contact pressure 

(Simple assumption model) 

 

2)  Constant modulus of subgrade reaction 

(Winkler's model) 

 

3)  Variable modulus of subgrade reaction 

(Winkler's model) 

 

4)  Modification of modulus of subgrade reaction by iteration 

(Winkler's model/ Continuum model) 

 

5)  Modulus of compressibility method for elastic raft on half-space soil medium 

(Solving system of linear equations by elimination)  

(Isotropic elastic half-space soil medium - Continuum model) 

 

6)  Modulus of compressibility method for elastic raft  

(Solving system of linear equations by iteration) 

(Isotropic elastic half-space soil medium and layered soil medium - Continuum model) 

 

7)  Modulus of compressibility method for elastic raft on layered soil medium  

(Solving system of linear equations by elimination) 

(Layered soil medium - Continuum model) 

 

8)  Modulus of compressibility method for rigid raft  

(Isotropic elastic half-space soil medium and layered soil medium - Continuum model) 

 

9)  Modulus of compressibility method for flexible raft  

(Isotropic elastic half-space soil medium and layered soil medium- Continuum model) 

 

Beside the above 9 main methods ELPLA can also be used to analyze system of flexible, elastic 

or rigid foundations. Furthermore ELPLA can be used to analyze many other structural problems 

such as slab floors, grids, plane frame and plane stress. 

 

 

3 Geometry and loads 

 

It is possible to consider raft with any arbitrary shape including holes, Figure A-1. It is also 

possible to consider raft with variable thickness, Figure A-2. Loads on the raft can be applied 

independently on the mesh at any position. Loads may be defined in different types such as point 

loads, line loads and polygon uniform loads, Figure A-3. 
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Figure A-1 Arbitrary shape of raft with hole 

 

 
Figure A-2 Variable slab thickness 
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Figure A-3 Arbitrary type of loads 

 

 

4 Boundary conditions 

 

It is possible to define elastic or fixed rotations and displacements on the raft, Figure A-4. Also 

translational or rotational springs may be defined. 

 

 

5 Soil 

 

The soil is defined by a number of borings; each boring has multi-layers with different soil 

materials, Figure A-5. Variable thickness and discontinuous soil strata can be considered, Figure 

A-6. Loading and reloading of the soil modulus can be taken into account by the analysis, Figure 

A-7. Three different methods are used to determine the flexibility coefficients or the modulus of 

subgrade reaction: 

 

1 Hand-Division of boring logs to nodes 

2 Subareas method 

3 Interpolation method (Figure A-5) 

 

It is possible to draw soil layers by different symbols according to the German Standard DIN 

4023 for easy identification. Also the limit depth of soil layers can be determined. Variable 

foundation levels can be considered in the analysis (Figure A-6). 
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Figure A-4 Fixed displacements 

 

 
Figure A-5 The soil is defined by a number of borings 
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Figure A-6 Variable thickness soil strata 

 

 
Figure A-7 Loading and reloading soil modulus are considered 
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6 Design of the slab 

 

The design of the slab for determining reinforcement and punching stress can be carried out 

according to the following design codes: 

 

- EC 2   European Committee for Standardization, Design of Concrete Structures 

Eurocode 2 

 

- DIN 1045  German Institute for Standardization, Design and Construction 

    of Reinforced Concrete 

 

- ACI   American Concrete Institute Building Code Requirements 

for Structural Concrete 

 

- ECP   Egyptian Code of Practice for Design and Construction of 

    Reinforced Concrete Structures 

 

 

7 Graphical drawing of data and results 

 

You can display, plot and print data and results graphically using the sub program ELPLA-

Graphic. It is possible to draw raft geometry, boring locations, soil profiles, loading, boundary 

conditions, settlement, deformation, contact pressure, moment, shear, modulus of subgrade 

reaction and reinforcement (Figure A-8 to Figure A-14). 

 

The results and data can be presented graphically as follows: 

 

- Data in the plan 

- Data in isometric view 

- Boring locations 

- Boring logs 

- Limit depth 

- Arrangement of rafts including neighbor foundations  

- Result values in the plan 

- Distribution of results in the plan 

- Results as contour lines 

- Results in isometric view 

- Results as circular diagrams 

- Principal moments as streaks 

- Support reactions as arrows 

- Deformation 

- Girders 

 

The graphical drawing, if desired, can be saved as WMF-File, in which it can be exported into 

other Windows applications to prepare reports, slide presentations or add further information to 

the drawing. 
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Figure A-8 Results can be tabulated on the mesh 

 

 
Figure A-9 Results can be contoured 
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Figure A-10 Moment distribution on the raft can be plotted 

 

 
Figure A-11 Principal moments as streaks 
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Figure A-12 Raft deformation can be plotted as a deformed mesh 

 

 
Figure A-13 Results can be plotted in isometric shape 



 

 

ELPLA 

 

 

A-13 

 
Figure A-14 Results can be plotted as circular diagram 

 

 

8 Drawing sections 

 

Further more you can display, plot and print results at specified sections graphically using the 

sub program ELPLA-Section. It is possible to draw settlements, contact pressures, deformation, 

internal forces, modulus of subgrade reaction and reinforcement (Figure A-15 to Figure A-17). It 

is also possible to determine extreme values of the results from many load cases. The results can 

be presented graphically as follows: 

 

- Section in x-direction 

- Max./ Min. values in x-direction 

- Overlapping in x-direction 

- Section in y-direction 

- Max./ Min. values in y-direction 

- Overlapping in y-direction 

- Arbitrary section 

 

Also drawing sections, if desired, can be saved as WMF-Format files, in which they can be 

exported to other Windows applications to prepare reports, slide presentations or add further 

information. 
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Figure A-15 Results can be plotted at specified section 

 

 
Figure A-16 Results from many projects can be plotted together 
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Figure A-17 Max. and Min. values can be calculated and plotted together 

 

 

9 Tabulation of data and results 

 

You can list data and results using the sub program ELPLA-List. Listing the data and results can 

be displayed first on the screen and then can be sent to the printer (Figure A-18 to Figure A-20). 

The results and data can be listed as follows: 

 

- Display tables of data 

- Print tables of data 

- List tables of data through Text-Editor 

- Display tables of results 

- Print tables of results 

- List tables of results through Text-Editor 

 

The listed results and data, if desired, can be saved as ASCII-format Files, in which they can be 

exported to other Windows applications to prepare reports or add further information. 
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Figure A-18 Data can be tabulated 

 

 
Figure A-19 Results can be tabulated 
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Figure A-20 Data can be imported to other text editor applications 

 

 

10 Typical applications of ELPLA 

 

*  Soil-structure interaction problems 

*  Analysis and design of rafts 

* Analysis of rigid rafts 

* Analysis of flexible foundations 

*  Analysis and design of slab floors 

*  Determining the consolidation settlements 

*  Analysis and design of pile caps 

*  Determining forces on piles due to structure loads 

*  Settlement calculation of surface foundations 

*  Determining the settlement due to surcharge fills or surcharge concentrated loads 

*  Determining the surface settlement around rafts 

*  Determining the constant or variable modulus of subgrade reaction 

*  Effect of external loads or neighboring foundations 

*  Effect of temperature difference 

*  Effect of tunneling 

* Analysis of system of flexible, elastic or rigid foundations 

* Analysis of beams or grids by FE-Method 

* Simulation of excavations and construction of embankments 

* Determining the ultimate bearing capacity of the soil 

* Determining the limit depth 

* Eliminating negative contact pressure 

*  Design of slabs according to codes ACI, EC 2, DIN 1045 and ECP 

* Determining the stress in soil 
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1 Enhancements in ELPLA 9.1 (MUI) 

1.1 GEOTEC Office Applications with Multilingual User Interface 

The new English-language versions of GEOTEC Office applications with Multilingual User 

Interface (MUI) are now available. The Multilingual User Interface Pack is a set of language 

XML resource files that can be added to the English version of GEOTEC Office applications. 

MUI Pack allows the user interface language to be changed according to the preferences of 

individual users to one of the available supported languages. MUI Pack provides a single 

version of GEOTEC Office applications to which users can add one or more MUI Packs 

providing local user interface and help files. Now, three languages are already available in 

ELPLA 9.1; English, German and Arabic.  

 

The major benefits of the new MUI Pack are:  

- Allows user interface switching between languages 

- Easy to update with new languages 

- Language-specific updates do not affect all languages 

- Languages are XML based resources that make it easier to users to add their own 

languages. 

 

1.2 GEOTEC Office Language Settings 

Now the user can define the language of the user interface and help system used in GEOTEC 

Office applications. To select or change GEOTEC Office language setting, start “GEOTEC 

Office Language Settings” tool by clicking on the program icon in the Windows Start-Menu> 

GEOTEC Office> GEOTEC Office Tools. The language setting tool (Figure B-1) appears.  

  

- In the “Display menus and dialog boxes in” list box, user can change the language of the 

menus and dialog boxes used in the GEOTEC Office applications. After selecting a new 

language, the user must quit and restart any Office applications he is currently using. 

 

- In the “Display Help in” list box, the user can change the language of the Help system used 

in the GEOTEC Office applications. 
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Figure B-1 “GEOTEC Office Language Settings” Tools 

1.3 ELPLA Quick Tour 

When you starting ELPLA for the first time, the “ELPLA Quick Tour” program (Figure B-2) 

appears. The tour program gives a quick access to the main contents of the ELPLA package as 

shown in Table B-1.  

Table B-1 ELPLA Quick Tour Contents 

Contents Description 

Tutorial Taking the user step by step through some simple examples. 

 

These examples will help the user to become familiar with the most 

important functions of ELPLA. 

Verification 

Examples 

Verify the mathematical models used in program ELPLA by comparing 

ELPLA results with closed form or another published results. 

 

Illustrate how to use ELPLA for analyzing foundation by different subsoil 

models. 

User's Guide Display the complete User’s Guide in a PDF-Format. 

Start ELPLA Start ELPLA to create a new project 

 

In the "Show this screen each time ELPLA starts" check box, you can choose whether you 

need to start the Quick Tour program each time when ELPLA starting or not. Also, you can 

start the “ELPLA Quick Tour” program any time by clicking on the program icon in the 

Windows Start-Menu> GEOTEC Office> Welcome to ELPLA. 

 



ELPLA New features 

 

B-5 

 
Figure B-2 “ELPLA Quick Tour” Program 

1.4 Generating Circular Slab with Curved Element 

A new template for generating second-order curved elements, Figure B-3, is now available for 

circular slab. As shown in Figure B-4, the new mesh refinement provides a better distribution 

of the results around the center of the circle, which reduces the local error in the elements 

around the center. 
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Figure B-3 Circular slab with curved elements 

 
Figure B-4 Contour distribution for curved elements to the left and old elements to the 

right 
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1.5 Analysis of plane frame and plane stress 

Besides the four different analyses available in the program ELPLA to analyze isolated raft, 

system of rafts, slab floors and grid, a new two analyses: Analysis of plane frame and plane 

stress are added (Figure B-5 and Figure B-6).  

 

 
Figure B-5 Analysis of plane frame 
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Figure B-6 Analysis of plane stress 

2 Two-Dimensional Frame Problems 

2.1 Introduction 

The analysis of Two-Dimensional frame problems is now available in ELPLA. This section 

describes the frame modeling used for analysis this type of problems. It is recommended to 

read this section and to understand the procedures used by the program before starting to 

create any practical problem analysis.    

 

2.2 Coordinate Systems 

There are two different coordinates for Two-Dimensional frame problems; global coordinate 

system and local coordinate system (Figure B-7). Each of these coordinate systems is used to 

describe certain data such as the location of nodes or the direction of loads, displacements, 

internal forces and reactions. Understanding these different coordinate systems is essential for 

the user to define correctly the problem. 
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Figure B-7 System Coordinates 

2.3 Element Loads 

As shown in Figure B-8, ELPLA uses a different vertical direction for defining loads. The 

positive value of load means that it is a downward load. Nodal loads are applied on global 

coordinates while element loads are applied in three different cases as follow: 

 

a. Self weight: A vertical uniform load distributed along the length of the element.  

b. Snow load: A vertical uniform load distributed along the horizontal projection of the 

element. 

c. Wind load: A uniform load distributed along the length of the element with a direction 

perpendicular to the element (local x` axis). 
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Figure B-8 Cases of element loads, nodal loads and nodal reactions with directions 

2.4 Graphical output 

The graphical output of results such as displacements, rotations and internal forces (bending 

moments, shear forces and normal forces) are drawn in locale coordinate. 

 

 

 

 

 



 

 

GEOTEC Office Package  

I Introduction 

GEOTEC Office is a package for geotechnical and design engineering. The package contains the 

following programs and tools: 

 

Program Description 

 
ELPLA 

Analyzing footings, rafts, piled rafts, pile groups and foundation groups. 

ELPLA considers different soil models, especially the three dimensional 

continuum model that considers any number of irregular layers. The 

program is able to handle the three solutions of flexible, elastic and rigid 

foundations. ELPLA can also be used to represent the effect of external 

loads, neighboring foundations, tunneling and the influence of 

temperature change on the slab. 

  
BOHR 

Drawing borehole logging of soil layers by different symbols according to 

the German specification code DIN 4023. 

 
TIEF 

Analyzing single piles, pile walls, simple problems of rigid pile groups 

and rigid piled rafts. 

 

 

  
GeoTools 

Analyzing different problems in geotechnical engineering.  

 

  
Self-Adaptive 

Mesh Wizard 

Generating finite element mesh with better element/ node distributions.  

 
GEOTEC-Editor 

A simple word processing program for editing GEOTEC Office output. 

 

II Installing GEOTEC Office 

GEOTEC Office is distributed on a CD-ROM. The CD-ROM contains an installer program that 

installs the GEOTEC Office software on your computer.  

 

To install GEOTEC Office, follow these steps: 

 

A package for geotechnical and design engineering 



- Insert the CD-ROM into your drive. 

 

The installer program is automatically loaded when the CD-ROM is inserted into the drive 

(Figure 1). The installer will guide you through the steps required to install GEOTEC Office on 

your computer. 

 

 
Figure 1 GEOTEC Office Installer form 

- Click “Next” button in the form of Figure 1 to install GEOTEC Office on your 

computer. 

 

GEOTEC Office Installer program begins execution. Follow the instructions given by the 

GEOTEC Office Installer program, Figure 2. 

 

- Click “Next” button in the form Figure 2 to install GEOTEC Office software to 

the specified destination folder.  

 

You can specify the folder for GEOTEC Office files. By default, GEOTEC Office suggests the 

(..\Program Files\GEOTEC Office). However, you can indicate a different folder name. GEOTEC 

Office creates the folder name you specify. 

 



 
Figure 2 “Select Installation Folder” form 

After select the installation folder, GEOTEC Office Installer program will be ready to install 

GEOTEC Office software on your program (Figure 3).  

 

- Click “Next” button in the form of Figure 3 to start the installation.  

 

GEOTEC Office will be installed and a statues form will show the process of installation (Figure 

4). 

 



 
Figure 3 “Confirm installation” form 

 



Figure 4 “Installing GEOTEC Office” form 

GEOTEC Office installation will be completed and a message appears to inform you that the 

GEOTEC Office Installer was completed successfully (Figure 5). 

 

 
Figure 5 Final Installer message 

Note: 

Installer cannot install update system or shared files, if they are in use. Before installing 

GEOTEC Office, it is recommended that you close any application may be running.  
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1 Preface 

 

The program ELPLA is a part of the program group GEOTEC. The original program ELPLA 4.0 

was developed first under the operating system MS DOS and then it was new revised for the 

operating system MS Windows 95 in order to use the possibilities of the user interface offered in 

it. The program runs also under Windows XP/ Vista/ 7/ 8.  

 

ELPLA has a significant enhancement. The new features and enhancements are the result of 

feedback from users over the last years. The major enhancement in Version 9.0 is the ability to 

carry out a consolidation analysis beside elastic settlement analysis using the different 

calculation methods that are available in ELPLA. The program ELPLA also uses different types 

of finite elements, allowing the user to analyze any irregular shape of slabs with arc boundaries. 

Many improvements have been carried out in the generation of the flexibility matrix to allow the 

user solving large size problems faster. 

 

The most important enhancements in ELPLA of versions 8.0 and 9.0 are explained in the next 

paragraphs. 

 

 

2 Enhancements in version ELPLA 9.0 

2.1 Design for punching 

 

It is possible to design the slab floor or raft foundation for punching due to concentrated loads 

and reactions from columns, piles or supports. The design for punching is carried out according 

to 4 different codes: ACI, DIN 1054, EC2 and ECP. 

 

2.2 Soil models 

 

Now both layered soil model and isotropic elastic half-space soil model are available for all 

calculation methods. The isotropic elastic half-space soil model is added for the following 

methods: 

 

Method 4: Modification of Variable Modulus of Subgrade Reaction 

Method 6: Modulus of Compressibility (Iteration) 

Method 8: Modulus of Compressibility for rigid raft, Figure B-1 

Method 9: Modulus of Compressibility for flexible foundation 
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Figure B-1 Menu "Calculation method" 

 

2.3 Bearing capacity factors 

 

The bearing capacity factors used to determine the ultimate bearing capacity can optionally be 

defined according to different codes and authors. These factors are required to carry out the 

nonlinear analysis of the soil. The bearing capacity factors are defined according to Figure B-2: 

 

- German Standard DIN 1054 

- Euro Code   EC 7 

- Egyptian code  ECP 

- Terzaghi 

- Meyerhof 
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Figure B-2 Menu "Bearing capacity factors" 

 

2.4 Flexibility coefficients for interior nodes 

 

For rigid and elastic rafts it is convenient to determine the flexibility coefficient of interior node 

at the characteristic point of the loaded area on that node. While for flexible foundation it is real 

to determine the flexibility coefficient of interior node at that node. 

 

Now it is possible to determine the flexibility coefficient of the interior node due to a uniform 

load at that node, Figure B-3: 

 

-  at the characteristic point of the loaded area, where rigid settlement is equal to flexible 

settlement 

- at the midpoint of the loaded area, where maximum settlement occurs 

- at the interior node on the loaded area 

 

2.5 Flexibility coefficients for exterior nodes 

 

Earlier versions of ELPLA determine flexibility coefficients for both interior and exterior nodes 

by assuming uniform loaded areas on these nodes. This assumption needs to use the principle of 

superposition for determining the flexibility coefficients. Now it is possible, optionally to 

convert the loaded areas on exterior nodes to point loads (Figure B-3). By this way the program 

doesn’t need to use the principle of superposition in the analysis, making it much faster than the 

old analysis. The new way of analysis is consequently faster and more efficient for problems that 

contain a large finite element mesh. 
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2.6 Limit distance 

 

If the distance between two nodes is too large, the settlement of a node due to a load on the other 

will be small enough to be neglected. To reduce the time required for determining the flexibility 

coefficients for great rafts, a limit distance between node i and j for determining the flexibility 

coefficient c(i, j) may be defined (Figure B-3). 

 

 
Figure B-3 Menu "Flexibility coefficients" 

 

2.7 Soil properties 

 

Elastic settlement and consolidation settlement can be determined using their actual properties, 

where the soil properties of the individual layers are defined by: 

 

- Modulus of Compressibility Es (1/mv) 

- Modulus of Elasticity E 

- Compression Index Cc 

 

This option enables ELPLA to analyze rafts on consolidated clay deposits by the different 

calculation methods that are available in ELPLA (Figure B-4). Also the user doesn’t need to 

convert a soil parameter to another. When defining soil properties by the Modulus of Elasticity 

E, the Poisson’s ratio νs can be different for every layer. 
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Figure B-4 Menu "Soil data" 

 

2.8 FE-Net 

 

Different element types are developed to generate the FE-Net of the slab according to Grid-based 

approach for both triangular and rectangular elements and according to Delaunay’s triangular 

generation for triangular elements. 

 

A user-friendly embedded program for mesh generation is developed. The essential features in 

this embedded program are: 

 

- generating the FE-Net for square, rectangular and irregular slabs using 6 different types 

of nets, Figure B-5 

 

- generating the FE-Net for circular and ring slabs using 8 different types of nets, 

Figure B-6 

 

- It can represent an irregular slab with openings and arc boundaries using a refine mesh, 

Figure B-7 

 

- It is possible to use combined rectangular, quadratic and triangular finite elements at 

the same time for the slab, Figure B-8 

 

- It is possible to define reference points and lines on the slab, Figure B-9. Reference points 

and lines are used to define the positions of girders, supports, piles, etc on the slab. Each 

time that the user generates the mesh, nodes of the FE-Net are passed automatically 

through these references. This provides the flexibility to make changes in the finite 

element mesh without having to redefine the positions of girders, supports, piles, etc 
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- You can refine the mesh in a specified region such as around supports to present the 

concentration of stress, moment and settlement in this region, Figure B-10 

 

- It is possible to optimize the dimension of FE-Net by making all elements having nearly 

the same area using the option "smoothing the mesh" 

 

- FE-Net can be displayed in separated elements, Figure B-11 

 

 
Figure B-5 Generation type for square, rectangular and irregular slabs 
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Figure B-6 Generation type for circular and ring slabs 

 

 
Figure B-7 Irregular slab with triangular finite elements 
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Figure B-8 Irregular slab with combined rectangular, quadratic  

and triangular finite elements 

 

 
Figure B-9 Reference points and lines on the FE-Net 



 

 

ELPLA 

 

 

B-11 

 
Figure B-10 Refining the mesh around a specified node 

 

 
Figure B-11 FE-Net in separated elements 

 

2.9 Unit systems 

 

It is possible to set different unit systems such as SI-system or English-system without changing 

the real value of any previously defined data, Figure B-12. 
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Figure B-12 Menu "Setting unit system" 

 

2.10 Creating tasks through Wizard assistance 

 

Simple step-by-step Wizard assistance in different tasks is possible, such as creating input data, 

redefining existing data or generating the net of finite elements. The Wizard assistance simplifies 

the process of creating and redefining the data using the standard and familiar "wizard" interface. 

A Wizard is a series of forms in a special window helping you through a task. The Wizard is 

used throughout Windows and by many Windows applications. The Wizard interface is ideal if 

you want to know as little about the task as possible. With the Wizard you simply click the 

"Next" button few times to carry out the task. Figure B-13 shows an example for Wizard 

assistance when defining the calculation method. 
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Figure B-13 Menu "Calculation methods" through Wizard assistance 

 

2.11 Undo and Redo of commands 

 

It is possible to undo and redo all commands in ELPLA-Data when defining a project. You may 

wish to undo the effects of a selected command and return to a previous state, Figure B-14. 

 

 
Figure B-14 Undo and redo the commands when defining FE-Net 



 

 

ELPLA 

 

 

B-14 

2.12 Compressing data files into one file 

 

The files of input data, intermediate results or final results for a project can now optionally be 

stored in one compressed file. Instead of storing hundreds of data files, you can now have one 

automatically compressed file for each project. This makes it easier to send projects to other 

persons or simply manage your own files. It also reduces the amount of disk space required to 

store all of your data files. The compressed file is ZIP-compatible, allowing you to manually 

extract the data files using WinZip or other data compression tools if you wish, Figure B-15. 

 

 
Figure B-15 Menu "Compressed project files" 

 

2.13 Floating toolbars and icon menus 

 

Many menu items and toolbars have been modified to make the commands easier to use: 

 

- New toolbars have been added to ELPLA for quicker access to commonly used 

commands. These toolbars can be placed anywhere in ELPLA-window or can be hidden 

from view, Figure B-16 

 

- Most of Menus and Popup-Menus in ELPLA have icons to easy identify the command, 

Figure B-17 
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Figure B-16 Toolbars can be placed anywhere in the ELPLA-window 

 

 
Figure B-17 Menu "Graphic" with icons 
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2.14 Graphic output 

 

- Line formats setting for ELPLA-Data and ELPLA-Graphic are the same, Figure B-18 

 

- Max. ordinates setting for ELPLA-Data and ELPLA-Graphic are the same, Figure B-19 

 

- Fill colors setting for ELPLA-Data and ELPLA-Graphic are the same, Figure B-20 

 

- The boundaries between contour regions are improved to be very smooth, Figure B-21 

 

- It is possible to draw girders in isometric view with actual size, Figure B-22 

 

- Each girder type has a specific color to easy identify the girder system, Figure B-22 

 

 
Figure B-18 Line formats for Data and Graphic are the same setting 
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Figure B-19 Max. Ordinates for Data and Graphic are the same setting 

 

 
Figure B-20 Fill colors for Data and Graphic are the same setting 



 

 

ELPLA 

 

 

B-18 

 
Figure B-21 Boundaries between contour regions are very smooth 

 

 
Figure B-22 Girder system in isometric view with actual size 

 

 

 

 

 



 

 

ELPLA 

 

 

B-19 

2.15 Diagrams 

 

- It is easy to define the required section where a plan of the raft with the chosen section is 

displayed when defining that section, Figure B-23 

 

- It can be drawn with the diagram, a legend shows the plan of FE-Net with line indicating 

the chosen section, Figure B-24 

 

- It is possible to plot a diagram at any section of the raft, Figure B-24 

 

- It is possible to export diagrams from ELPLA-Section to MS Excel 

 

- It is possible to define a diagram in ELPLA-Graphic by Mouse and to send it to ELPLA-

Section, Figure B-26 

 

 
Figure B-23 Menu "Section in x-direction" 

 

 

 



 

 

ELPLA 

 

 

B-20 

 
Figure B-24 Diagram with a legend showing a plan of FE-Net 

 

 
Figure B-26 Defining a diagram in ELPLA-Graphic 
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2.16 Loads 

 

- It is possible to define a polygon load with variable ordinates to represent dam or 

embankment loads, Figure B-27 

 

- It is possible to define a line moment to represent moments from walls or line supports, 

Figure B-27 

 

- Point load is never applied in reality. If a point load represents a column load on a mesh 

of refine finite elements, the moment under the column will be higher than the real 

moment. To take the effect of the load distribution through the slab thickness, the column 

load must be distributed outward at 45 [°] from the column face until reaching the center 

line of the slab. Now it is possible, to overcome this problem by converting the point load 

to an equivalent uniform load over an appropriate area, Figure B-28 

 

 

 

 
Figure B-27 Polygon load with variable ordinates and line moment 
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Figure B-28 Distributing the column point load over an appropriate area 

 

 

2.17 Column cross-section and punching area 

 

- It is possible to define column dimensions that are used to design columns for punching 

and to convert column concentrated load to equivalent distributed load, Figure B-29 

 

- Column cross-section can be drawn with column load, Figure B-29 

 

- It is possible to draw column cross-sections in colored groups to easy identify the column 

capacity, Figure B-30 

 

- Area of punching can be displayed according to the specified code of design with column 

cross-section, Figure B-31 
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Figure B-29 Column cross-sections with column loads 

 

 

 
Figure B-30 Column cross-sections in colored groups 
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Figure B-31 Punching areas according to ACI with column cross-sections 

 

2.18 Output list 

 

- It is possible to open many projects at the same time in one view in the program ELPLA-

List to compare between their results, Figure B-32 

 

 
Figure B-32 Two projects are opened at the same time in the program ELPLA-List 
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3 Enhancements in version ELPLA 8.1 

3.1 Analysis of grid 

 

Besides the three different analyses available in the program ELPLA to analyze foundations and 

slab floors, a new analysis "Analysis of grid" is added (Figures B-33 and B-34). 

 

 
Figure B-33 Menu "Analysis type" 
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Figure B-34 Beam-Moments 

 

3.2 Determining stresses, strains and displacements in soil 

 

You can determine the stresses, strains and displacements in soil under the foundation in a net in 

z-direction (Figures B-35 to B-38). 

 

ELPLA can display results of stresses, strains and displacements in different forms such as: 

 

- Soil deformation as deformed mesh, Figure B-39 

- Soil deformation as vectors, Figure B-40 

- Principal soil stresses as streaks, Figure B-41 

- Principal soil strains as streaks, Figure B-42 
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Figure B-35 Menu "Net of soil elements in z-direction" 

 

 
Figure B-36 Z-Stresses Sigma_z 
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Figure B-37 Z-Strains Epsilon_z 

 

 
Figure B-38 Z-Displacements w 
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Figure B-39 Soil deformation as deformed mesh 

 

 
Figure B-40 Soil deformation as vectors 
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Figure B-41 Principal soil stresses as streaks 

 

 
Figure B-42 Principal soil strains as streaks 

 

3.3 Language of the help 

 

You can define the language of the help system used in ELPLA applications. The three 

languages are English, German and Arabic (Figures B-43 to B-46). 
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Figure B-43  Menu "Help language settings" 

 

 
Figure B-44  Help language in German 
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Figure B-45  Help language in English 

 

 
Figure B-46  Help language in Arabic 

 

3.4 Converting Loads 

 

Contact pressures on nodes or reactions may be converted to applied loads on these nodes,  

Figure B-47. 



 

 

ELPLA 

 

 

B-33 

3.5 Displaying axis arrows 

 

You can display axis arrows in x-, y- and z-directions, Figure B-48. 

 

 
Figure B-47  Contact pressures on nodes as applied loads 

 

 
Figure B-48  Raft with x- and y-axis arrows 
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3.6 Boring logs 

 

The display of soil properties C and Phi is optional. This option allows displaying more borings 

together, Figure B-49. 

 

Soil colors according to German Standard DIN 4023 are considered automatically, if desired, in 

the drawing of boring logs, Figure B-50. 

 

 
Figure B-49  Many borings together 
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Figure B-50  Boring log with soil colors according to German Standard DIN 4023 

 

 

4 Enhancements in version ELPLA 8.0 

4.1 Calculation methods 

 

- Besides the eight different calculation methods available in ELPLA to analyze 

foundations, a new method "Flexible foundation (method 9)" is added. This method can 

be used for settlement calculations of flexible foundations such as embankments, dams or 

direct loads on the ground, Figure B-51 

 

- You can analyze system of flexible, elastic and rigid foundations together, Figure B-52 

 

- You can determine the influence of flexible neighbor foundations or external loads of 

different arts on the examined foundation. Until now only the influence of elastic or rigid 

neighbor foundations could be considered, Figure B-53 
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Figure B-51 Flexible foundation 

 

 
Figure B-52 System of flexible, rigid and elastic foundations  
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Figure B-53 Influence of flexible neighbor foundations 

 

- You can introduce translational or rotational spring stiffness on nodes for the rigid slab 

(method 8). Until now, it was possible only for methods 1 to 7. The springs can be used 

for analysis of rigid pile caps, Figure B-54 

 

- Negative contact pressure can be eliminated for methods 1 to 8, if it appears on the 

bottom of the foundation. Until now, elimination of negative contact pressures was 

available for methods 4, 6 and 8, Figure B-55 

 

4.2 Soil 

 

- Not only bilinear but also nonlinear soil deformations can be taken into account, as 

example for plastic deformations at heavy loading, Figure B-56 

 

- For all nodes the bearing capacity of foundation on a variable soil can be determined 

through interpolation, Figure B-57 
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Figure B-54 Rigid raft with translational and rotational spring 

 

 
Figure B-55 Elimination of negative contact pressure 
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Figure B-56 Nonlinear soil deformation 

 

 
Figure B-57 Bearing capacity for variable soil 
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4.3 Plot parameters 

 

- Line formats can be defined and saved, Figure B-58 

 

- The fill color can be defined and saved, Figure B-59 

 

- Font format (size, type …) can be defined and saved, Figure B-60 

 

- You can define and save the maximum ordinate, length, side or diameter of symbols for 

the drawing, Figure B-61 

 

4.4 Input data 

 

- The menus are extended by some explanation figures, Figure B-62 

 

- The values of data, if desired, can be displayed on the FE-Net, Figure B-63 

 

- The additional settlement can be defined graphically, Figure B-64 

 

- Boring fields can be defined graphically, Figure B-65 

 

- Boring logs can be inserted from a file, Figure B-66 

 

- Besides the definition of girder section by moment of inertia and torsion moment of 

inertia, the section can be also defined by its width and height, Figure B-67 

 

 
Figure B-58 Line formats 
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Figure B-59 Fill color 

 

 
Figure B-60 Font 
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Figure B-61 Max. ordinate 

 

 
Figure B-62 Menu with explanation figure 
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Figure B-63 Displaying values 

 

 
Figure B-64 Defining additional settlements 
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Figure B-65 Defining boring fields 

 

 
Figure B-66 Inserting the boring log from file 
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Figure B-67 Defining the girder section by width and height 

 

- The stiffness of girders those have T/ L-section can be simulated on the slab by using 

additional beam elements. The stiffness of the girder can be obtained through a 

replacement beam arranged in the center plan of the slab. The dimensions of the 

replacement beam can be determined as in DIN 1075 or EC 2, Figure B-68 

 

- When defining a set of data (for example FE-Net), another data with this set can be 

displayed - for example FE-Net with loads and boring locations, Figure B-69 

 

- The date can be defined from the computer calendar, Figure B-70 

 

- When all data sets are defined and saved, changes are carried out to one set, the data that 

are affected by these changes can be automatically fixed (for example the data those are 

set outside the FE-Net), Figure B-71 

 

- It is possible to import or export data to MS Excel, Figure B-72 
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Figure B-68 Defining the girder of T/L-section 

 

 
Figure B-69 View grouping data 
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Figure B-70 Defining the date from computer calendar 

 

 
Figure B-71 Fixing data outside FE-Net 
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Figure B-72 Exporting and importing data to MS Excel 

 

4.5 File list 

 

- Not only all project data can be deleted but also intermediate results or final results can 

be separately deleted, Figure B-73 

 

- Deleted files by ELPLA are sent to the recycle pin, Figure B-74 

 

- It is possible to sort ELPLA-files according to project identification data (file name, 

description, date and project), Figure B-75 
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Figure B-73 Deleting intermediate and finial results 

 

 
Figure B-74 Sending deleted files to recycle pin 
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Figure B-75 Sorting ELPLA-files 

 

4.6 Templates 

 

- Templates for different types of FE-Net are available, Figure B-76 

 

 
Figure B-76 Templates for different types of FE-Net 
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4.7 Graphic 

 

- The limit depth can be drawn, if desired, beside its corresponding boring log, Figure B-77 

 

- When drawing a group of boring logs or limit depths in one presentation, the user has the 

possibility to choose the sequence of boring logs or limit depths (for example boring 6 at 

the left, boring 1 at the right next to it, boring 3 at the right next to boring 1 etc.). So the 

user can draw subsoil sections, Figure B-78 

 

- The intensity of numbers on the contour lines can be decided through a writing factor, 

Figure B-79 

 

- Legend for the maximum ordinate is inserted for results in isometric view, distribution of 

results in the plan, results as circular diagrams, deformation and principal moments as 

streaks, Figure B-80 

 

- When studying the effect of neighbor foundations, all foundations can be drawn with data 

or results in one representation, Figure B-81 

 

 
Figure B-77 Limit depth beside boring log 
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Figure B-78 Choosing the sequence of boring logs in the drawing  

 

 
Figure B-79 Writing factor for contour lines 
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Figure B-80 Legend for maximum ordinate 

 

 
Figure B-81 Drawing a group of foundations with data 
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- You can draw a group of data with results or a group of data together in one presentation 

(for example contour lines of settlements with loads and slab thickness, or loads with 

boring locations), Figure B-82 

 

- When defining view angles about x-, y- and z-axis for a drawing in three-dimensional, 

the drawing is previewed on a small menu before displaying it on the screen, Figure B-83 

 

- New expressed symbols for boundary conditions and supports are presented, Figure B-84 

 

- If the system is symmetrical, the symbols of symmetry will be automatically drawn, 

Figure B-85 

 

- The graphical drawing can be copied in Metafile-Format to Clipboard and then inserted 

directly to other Windows-programs, Figure B-86 

 

 
Figure B-82 Drawing data and results in one presentation 
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Figure B-83 Viewing angle 

 

 
Figure B-84 New expressed symbols for boundary conditions  
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Figure B-85 Drawing symbols of symmetry  

 

 
Figure B-86 Copying the drawing to clipboard 
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4.8 List 

 

- It is possible to export results to MS Excel, Figure B-87 

 

- It is possible to export results to MS Word, Figure B-88 

 

- A new user interface for the program ELPLA-List is developed. The user can deal with 

different results in different windows at the same time, Figure B-89 

 

- With project Explorer it is possible to swap between data and results easily, Figure B-90 

 

 
Figure B-87 Export results to MS Excel 
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Figure B-88 Export results to MS Word 

 

 
Figure B-89 Many windows of data and results in ELPLA-List 
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Figure B-90 Swapping between data and results 

 

4.9 Languages 

 

ELPLA is available in three languages: English, German and Arabic. An exchange of data for the 

three versions is possible with full compatibility . 

 

 

4.10 Boring log 

 

The new separate program ELPLA-Boring is developed. By the program the user can define 

boring logs graphically and draw limit depths, Figure B-94. 
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Figure B-94 ELPLA-Boring 

 

4.11 ELPLA-Editor 

 

A new separate program ELPLA-Editor is developed. The program is a simple editor program 

and can deal with text files that are created by ELPLA, Figure B-95. 

 

 
Figure B-95 ELPLA-Editor 
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4.12 Group functions 

 

- The 7 separate programs ELPLA-Data, ELPLA-Solver, ELPLA-Graphic, ELPLA-

Section, ELPLA-List, ELPLA-Boring and ELPLA-Editor can run independently of each 

other or as a group, Figure B-96 

 

- All program menus are represented also by icons (Toolbar), Figure B-97 

 

- Page setup (portrait format, landscape format, printer, ... ) is saved separately for each of 

the programs ELPLA-Graphic, ELPLA-List, ELPLA-Section, ELPLA-Boring and 

ELPLA-Editor, Figure B-98 

 

- The user can connect directly through ELPLA with ELPLA-Website in Internet, Figure 

B-99 

 

 
Figure B-96 ELPLA-Graphic alone 
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Figure B-97 Menu with Toolbars and icons 

 
Figure B-98 Page setup for each program 
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Figure B-99 The user can connect to internet through ELPLA 

 

- The computer knows the files of the ELPLA-project automatically. Running the program 

can be carried out by clicking on the icons of the files *.PO1, *.PO2 or *.BAU, Figure B-

100 

 
Figure B-100 Running ELPLA by clicking on project icon  

 

4.13 Help file 

 

- The help file in HTML-Format contains the text of the user’s guide, Figure B-101 
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Figure B-101 Help file in HTML-Format 
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1 Self-Adaptive Mesh Wizard 

The Self-Adaptive Mesh Wizard is a tool that helps the user for generating finite element 

mesh with better element/ node distributions. The wizard is used to regenerate the finite 

element mesh for slab floor and raft problems. The new mesh will be generated based on the 

strain energy distribution. The self-adaptive technique used in this wizard reduces general 

system error besides enhances stress distributions. Adaptive mesh is generated either by using 

Delaunay generation or by using Grid-based generation (Figure 1).  

 

Although the Self-Adaptive Mesh Wizard works with ELPLA Limit Edition, it is 

recommended to be used with ELPLA professional edition because the adapted mesh resulted 

from this wizard always has more than 300 nodes.  

 

Note: 

This wizard does not analyze any project. The project must be analyzed before running this 

wizard. Also the adapted project must be analyzed again after running the wizard. 

 

 
a-Original Mesh 

 

 

  

 

 
b-Adaptive mesh (Delaunay generation) 

 
c-Adaptive mesh (Grid-based generation) 

  

Figure 1 Two types of adaptive mesh generation: Delaunay generation and 

Grid-based generation 
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Figure 2 shows the first form in the wizard which contains the following options: 

Open Project 

Displays the name and path of the selected project. You may type in the name and path of a 

project or choose a project using the “Browse” button. 

Browse 

Displays a dialog box you can use to browse to a project.  

Recalculate Mesh Boundary 

The Self-Adaptive Mesh Wizard can not detect any change made to the mesh boundary after 

generating mesh. For example, removing node from mesh will produce opening that can not 

be detected from the original mesh boundary. In this case, the “Recalculate Mesh Boundary” 

check box must be selected to ignore the original mesh boundary and create a new mesh 

boundary according to the last mesh modification. 

Help 

Displays the help topic for this step. Also pressing F1, gives the same action. 

Cancel 

Cancels previous actions and closes the Application Wizard. 

Back 

Moves to the previous step. 

Next 

Moves to the next step. 

Finish 

Accepts any selections that have been entered and the defaults for the remaining steps, then 

creates the adaptive mesh. 

 

 
Figure 2 “Project” Form 



Self-Adaptive Mesh Wizard 

 

5 

The next form of the wizard is the “Generation Type” form. There are two types of mesh 

generation: Delaunay and Grid-based. Mesh optimization options are only available for 

Delaunay generation. 

Smoothing mesh 

By the “Smoothing mesh” option, the dimension of FE-Net can be optimized by making all 

element sides around each node having nearly the same length. 

Directing border elements 

By the “Directing border elements” option, all elements on the slab borders can be directed 

and arranged (see ELPLA-Data User’s Guide for more details). This command is useful to 

present contact pressures at raft edges in good manner when analyzing the raft by Continuum 

model in which the contact pressure at raft edges are higher than that at the middle. 

 

Element dimension parameters defined in the next wizard form depends on the generation 

type as follow: 

Delaunay Generation 

In the Delaunay generation (Figure 4), the minimum angle, element circumradius and 

minimum element circumradius are required to define.  

Grid-Based Generation 

In the Grid-based generation (Figure 5), the element size (length/width) and minimum 

element size (length/width) are required to define.  

 

 
Figure 3 “Generation Type” Form 
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Figure 4 Delaunay generation parameters 

 
Figure 5 Grid based generation parameters 

Adaptive Project 

The last wizard form shown in Figure 6 displays the name and path of the output project. For 

selected project name, e.g. ProjectName, the wizard automatically displays an output name, 

e.g. ProjectName_Adaptive.  You may type in the file name and path of the output project. 

You can also use the “Browse” button to navigate to the location where you want to save the 

project.  

 

 
Figure 6 Grid based generation parameters 
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2 Samples for adaptive mesh 

For the mesh of Example1 (Page 1), page 2 shows the adaptive mesh using Delaunay 

generation while page 3 shows the adaptive mesh using Grid-based generation. 
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1 An overview of ELPLA-Data 

 

ELPLA-Data is used to define the FE-Net, calculation methods, boundary conditions, soil 

properties, slab properties, project identification, boring fields, etc. for a new problem. The 

program may also be used to modify the data of a problem that already exists.  

 

The input project data can be defined through ELPLA-Data in the following steps: 

 

- Calculation methods 

- Project identification  

- FE-Net data 

- Girders 

- Spring supports 

- Supports/ Boundary conditions 

- Piles 

- Soil properties 

- Net of soil elements in z-direction 

- Limit depth  

- Foundation (or slab) properties 

- Reinforcement 

- Boring fields 

- Loads 

- Neighboring foundations 

- Temperature change 

- Additional settlements 

 

 

2 Description of ELPLA-Data 

 

ELPLA-Data is a 32-bit, graphical software product that operates under Microsoft Windows XP/ 

Vista/ 7/ 8. The common "what you see is what you get" of Windows applications makes it easy 

to learn how to use ELPLA-Data, especially if you are already familiar with the Windows 

environment. 

 

The program package ELPLA consists of 7 separate programs. The programs can run 

independently. The name and short description of the seven separate programs are given in 

Table C-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed by using ELPLA-Solver. Finally, 

the results can be presented as graphical drawing, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor.  
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Table C-1 Names and descriptions of the seven separate programs 

Program name       Description of the program 

ELPLA-Data                 Editing project data 

ELPLA-Solver                    Analyzing the project problem 

ELPLA-Graphic            Displaying data and results graphically 

ELPLA-List                     Listing project data and calculated results 

ELPLA-Section                 Displaying results graphically at specified sections 

ELPLA-Boring                Editing and displaying boring logs graphically 

GEOTEC-Editor           A simple text editor program 

 

Table C-2 gives a list of files, which are read or created by ELPLA-Data. The files can be 

classified in three groups. 

 

Table C-2 Names of file groups 

Group    Saved from the program  

A    Main data files                 ELPLA-Data 

B    Data files (*.DAT)  ELPLA-Data 

C    Project data files             ELPLA-Data 

 

Further more, Table C-3 shows the filenames, contents and groups of all files that may be read 

or created by ELPLA-Data. 

 

Table C-3 Names and contents of files 

 

A Main data files 

Filename    Contents  

FIRMA   Firm header 

STEU                       Default directory for files that are saved by ELPLA 

NOFORMAT            Number formats  

RFT    Design code parameters 

UNITS    System of units 

PREFEREN.DAT  FE-Net and calculation preferences 

 

B Data files 

Filename         Contents 

PLOTPAR. DAT  Plot parameters 

FONT.DAT                     Font data 

NODISPLA.DAT            Data of display values 

LINEFORM. GRA      Line formats 

PAINT.GRA                Fill color data 

ORDINATE.GRA           Max. ordinate data 
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C Project data files 

Filename  Contents 

* .PO1          System data (Analysis of isolated raft) 

* .PO2          System data (Analysis of system of rafts) 

*. AUF        Project identification 

*. BAU        Soil properties 

*. LDH      Data of the limit depth   

*. PC1         Load data for slab and grid 

*. PCF         Load data for plane frame 

*. PCW        Load data for plane stress 

*. PL6       Node coordinates and element connectivity 

*. PL8       Slab boundary 

*. GL1       Girder data (Part 1) 

*. GL2       Girder data (Part 2) 

*. P21         Data of slab properties/ levels/ coordinates 

*. P23         Reinforcement data 

*. P31        Data of supports/ boundary conditions for slab and grid 

*. P61        Data of supports/ boundary conditions for plane frame 

*. P71        Data of supports/ boundary conditions for plane stress 

*. P35       Data of spring supports for slab and grid 

*. P81       Data of spring supports for plane frame 

*. P91       Data of spring supports for plane stress 

*. P41        File of boring fields 

*. PT1        Data of temperature change 

*. PP1        File of neighboring foundations 

*. PV1       Data of additional soil settlements 

*. DSS      FE-Net in z-direction 

*. PIL       Pile properties 

The asterisk (*) matches any filename with the specified extension. 

 

The next paragraphs describe the purpose and function of each ELPLA-Data command.  
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3 Starting ELPLA-Data 

 

Start ELPLA-Data by clicking the program icon in the Windows "Start"-Menu. The introduction 

screen (Figure C-1) appears. 

 

 
Figure C-1 Introduction screen of the program ELPLA-Data 

 

The menu head of Figure C-1 contains the following five commands: 

 

- File 

- Data 

- View 

- Main data 

- Help 

 

After clicking one of the five menu commands, other sub-commands or options become 

available, which are presented and described in the following paragraphs 4 to 11. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- New project 

- Open project 

- Save project as 

- File list 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu –"New project" command 

 

By the "New Project" command the current project is closed, if one is loaded, and a new project 

is initialized for starting a new problem definition. "New project" command has the same action 

as quitting ELPLA-Data and then restarting ELPLA-Data. After clicking this command, the 

following Wizard assistance in Figure C-2 appears. This wizard will help the user to define the 

analysis type and the calculation method of the problem through a series of forms. The first form 

of "Calculation methods" Wizard is the "Analysis type" Form. 

 

 
Figure C-2 "Analysis type" Form 

 

ELPLA is used to analyze not only isolated raft but also slab floor, grid, plane frame, plane 

stress and system of rafts. In the "Analysis type" Dialog box (Figure C-2) choose one of the six 

analyses. 

 

4.2 File Menu –"Open project" command 

 

By the "Open project" command the current project is closed, if one is loaded, and an existing 

project is opened. Figure C-3 shows the "Open" Dialog box used to open a specified project. 

Because ELPLA is used to analyze an isolated raft and system of rafts, ELPLA can read two 

types of filenames. One has the extension of PO1, which represents the isolated raft and the 

other has the extension of PO2, which represents the system of rafts. 
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Figure C-3 "Open project" Dialog box 

 

In case of one of the data files is not found, the following Message box appears (Figure C-4). 

This menu shows the project data that are not found. These data are important for the analysis. 

 

 
Figure C-4 "Open project" Message box 

 

4.3 File Menu –"Save project as" command 

 

By this command the current project is saved under a new file name. Figure C-5 shows the 

"Save as" Dialog box used to save the project.  

 

 
Figure C-5 "Save as" Dialog box  
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4.4 File Menu –"File list" command 

 

By the "File list" command the user can delete, compress or extract projects, intermediate 

results, final results or print file lists of projects (Figure C-6). It is possible to sort ELPLA-files 

according to project identification data (file name, title, date and project). 

 

 
Figure C-6 "ELPLA File list" Dialog box 

 

When the user chooses to delete a project, a Message box will appear (Figure C-7). Not only all 

project data can be deleted but also intermediate results or final results can be separately deleted. 

 

Note 
Deleted files by ELPLA go to the recycled pin. 

 

 
Figure C-7 "Delete project" Message box 

 

4.5 File Menu –"Files 1, 2, 3, 4" command 

 

By the "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

 

4.6 File Menu –"Exit" command 

 

By the "Exit" command the current project is closed and ELPLA-Data is quitted, Figure C-8. 

 

 
Figure C-8 "Exit" Message box 
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In case of one of the project data is not defined, the following Message box in Figure C-9 

appears. This menu shows the project data that are not defined. These data are important for the 

analysis. 

 

 
Figure C-9 "Close project" Message box 

 

 

5 Data Menu 

 

The Data Menu is the main menu, which is used to define the problem. 

The Data Menu commands are: 

 

- Calculation methods 

- Project identification  

- FE-Net data 

- Girders 

- Spring supports 

- Supports/ Boundary conditions 

- Piles 

- Soil properties 

- Net of soil elements in z-direction 

- Limit depth  

- Foundation (or slab) properties 

- Reinforcement data 

- Boring fields 

- Loads 

- Neighboring foundations 

- Temperature change 

- Additional settlements 

 

5.1 Data Menu–"Calculation methods" command 

 

By this command the analysis method of the project is defined. When choosing the "Calculation 

method" command, the "Calculation methods" Wizard in Figure C-2 appears with the "Analysis 

type" Form. In this Form define the analysis type of the problem from different structural 

systems that are available in ELPLA. After selecting the structural system, click "Next" button to 

go to the next Form. 
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Calculation methods for an isolated slab foundation 

Nine different numerical calculation methods are considered for the analysis of rafts according 

to Figure C-10. Choose one of the methods No. 1 to 9. 

 

 
Figure C-10 "Calculation methods" Dialog box 

 

System symmetry 
The next Form is the "System symmetry" Form, Figure C-11. In this form select system 

symmetry and click "Next" button to go to the next Form. 

 

 
Figure C-11 "System symmetry" Form 

 

By using the system symmetry, if the problem is symmetrical in loading, shape and soil about x- 

or y-axis, the computational time and computer storage can be considerably reduced.  
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By defining the project data for simple symmetrical or antisymmetrical slab system the data are 

defined according to Figure C-12, in which only the lower half slab is considered for symmetry 

about x-axis while only the left half slab is considered for symmetry about y-axis. 
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Figure C-12 Simple symmetrical slab system 

 

By defining the project data for double symmetrical slab system the data are defined according 

to Figure C-13. Only the left lower quarter of the slab is considered.  
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Figure C-13 Double symmetrical loaded slab 

 

If the slab is symmetrical in shape and unsymmetrical in loading, it is also possible to divide this 

general case of loading into two cases having symmetrical and antisymmetrical loading, Figure 

C-14. 
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Figure C-14 General case of loading by symmetrical and antisymmetrical loading 

 

The symmetrical cases are available for all calculation methods 1 to 9. The antisymmetrical case 

is only possible for calculation methods 4 to 8. 
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Determination of modulus of subgrade reactions 
In ELPLA it is possible to analyze the raft by modulus of subgrade reaction method in which the 

modulus can be determined by three ways: 

 

a) Modulus is defined by the user 

b) Modulus is calculated from Half-space 

c) Modulus is calculated from soil layers 

 

In item a) the user can define a constant modulus for the entire raft (Method 2) or a variable 

modulus at nodes (Method 3). 

 

In items b) and c) the modulus is calculated through the settlement calculation of the soil 

depending on boring logs and soil properties. 

 

By the modulus of subgrade reaction method, specify the way for determining the modulus of 

subgrade reaction by selecting one of the available three options in Figure C-2. 

 

Options 
Some options are available in ELPLA such as concrete design of sections, additional springs, 

supports, girders and piles, determining the limit depth, nonlinear subsoil model, determining 

displacements, stresses and strains and in soil. Also, ELPLA can study some external influences 

on the raft such as temperature change, additional settlements or neighboring foundations. In the 

menu of Figure C-15 check the options that you want to consider in the analysis. 

 

 
Figure C-15 "Options" Check box 

 

Analysis of system of many slab foundations 

In the "Analysis type" Form (Figure C-2), if the option "Analysis of system of many slab 

foundations" is chosen, the following Dialog box in Figure C-16 appears. Three different 

numerical calculation methods are considered for the analysis of system of slab foundations, 

flexible, elastic or rigid. For the analysis of system of many slab foundations the project 

filenames (slab foundations) are required. 
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Figure C-16 "Analysis of system of many slab foundations" Dialog box 

 

Analysis of a slab floor, plane frame or plane stress 

By choosing the analysis of a slab floor, plane frame or plane stress only the "System symmetry" 

Form and "Options" Check box will appear. 

 

5.2 Data Menu–"Project identification" command 

 

By the "Project identification" command the information to identify the problem can be 

specified, Figure C-17. This information is required for printing and plotting the data and results. 

The date can be defined from the computer calendar, Figure C-18. 

 

 
Figure C-17 "Project identification" Dialog box 
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Figure C-18 Input Date information 

 

5.3 Data Menu–"FE-Net data" command 

 

By the "FE-Net data" command the net of the finite elements is defined. When the "FE-Net data" 

command is chosen, the following embedded program appears (Figure C-19). 

 

 
Figure C-19 "FE-Net" embedded program 
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The menu head of Figure C-19 contains the following nine menus: 

 

- File 

- View 

- Graphically 

- FE-Net Generation 

- In table 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the nine menus other sub-menus or commands become available. The 

following paragraph presents and describes the nine menu commands and their sub-commands. 

 

5.3.1 File Menu 

 

This menu contains the following commands: 

 

- New FE-Net 

- Open FE-Net 

- Save FE-Net 

- Save FE-Net as 

- Close FE-Net 

 

File Menu–"New FE-Net" command 

A new FE-Net is created. When choosing this command, the following templates for different 

types of FE-Net appear (Figure C-20). 

 

 
Figure C-20 Templates for different types of FE-Net 

 

File Menu–"Open FE-Net" command 

Loads are saved as FE-Net again. Then the loaded FE-Net, if desired, can be redefined. 

 

File Menu–"Save FE-Net" command 

The command saves the active FE-Net under the available name. 
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File Menu–"Save FE-Net as" command 

The active FE-Net is saved under a new name. 

 

File Menu–"Close FE-Net" command 

Closes the FE-Net embedded program and returns to ELPLA-Data. 

 

5.3.2 View Menu 

 

The View Menu command is Tool bars. 

 

View Menu–"Tool bars" command 

The "Tool bars" command displays tool bars located just below the menu head. Tool bars 

contain icons of program menus. 

 

5.3.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Select nodes 

- Remove nodes 

- Add nodes 

- Slab corners by Mouse 

- Add opening 

- Add reference points 

- Add reference lines 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Select nodes" command 

The function of "Select nodes" command is to provide a method for deleting nodes. When 

"Select nodes" command is chosen, the cursor will change from an arrow to a cross hair. The 

commands "Remove nodes" in the menu "Graphically" will be enabled, indicating the mode in 

which is being operated. The desired nodes are selected by clicking on each node individually or 

selecting a group of nodes as shown in Figure C-21. A group of nodes can be selected by 

holding the left mouse button down at the corner of the region and dragging the mouse until a 

rectangle encompasses the desired group of nodes. When the left mouse button is released, all 

nodes in the rectangle are selected. 
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Figure C-21 Select nodes to be removed 

 

Graphically Menu–"Remove nodes" command 

"Remove nodes" command is used to remove the selected nodes. Any elements bonded the 

deleted nodes are also deleted (Figure C-22). 

 

 
Figure C-22 Selected nodes were removed 
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Graphically Menu–"Add nodes" command 

By the "Add nodes" command nodes can be added at anywhere to the FE-Net. Clicking by 

Mouse inside the required element adds a new node in the element (Figure C-23). 

 

 
Figure C-23 Selected nodes were added 

 

Graphically Menu–"Slab corners by Mouse" command 

In ELPLA there are two alternative possibilities to define slab corners either by Mouse or by 

editing in a table. "Slab Corners by Mouse" Command is used to define corners of irregular slab 

by Mouse. The coordinates of corner positions (x, y) are related to the left bottom corner of the 

corresponding slab. Corners are set as a polyline, which is a connected sequence of lines or arc 

segments created as a single object. 

 

To draw a slab polyline containing a line and arc combination by Mouse (Figure C-27): 

  

- Choose the "Slab Corners by Mouse" Command from the "Graphically" Menu. The 

cursor will change from an arrow to a cross hair 

 

- Click the left mouse button on the position of the start point of the first line segment and 

drag the mouse until the position of the end point of this segment. Then click on the end 

point position to consider the first line segment (Figure C-24) 
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- Press "A" key to switch to arc segment mode. The first point of the arc is the endpoint of 

the previous segment. As you drag the mouse, ELPLA draws an arc connected to the 

previous line segment and extended to the mouse position, Figure C-25. For drawing the 

arc segment the rotation direction and the radius of the arc segment is required to define. 

There are four cases concerning the rotation direction and the radius as shown in Figure 

C-26. Two of these cases are related to the position of the arc center relative to the line 

connected the arc points (Figure C-26a). The other two cases are related to the direction 

of the arc rotation starting from the first point of the arc to the second point, Figure C--

26b. The arc can be drawn clockwise or anticlockwise 

 

- Press "R" key to switch between the two possibilities of the arc center position 

 

- Press "C" key to switch between the arc clockwise and anticlockwise directions 

 

- Click the left mouse button on the position of the end point of the arc to consider the arc 

segment 

 

- Press "A" key again to switch to line segment mode 

 

- Repeat the previous steps for drawing arc or line segment whenever is applicable until 

finishing the polyline 

 

- Double click the left mouse button on the position of the endpoint of the last segment to 

finish the "Slab Corners by Mouse", Figure C-27 

 

 
Figure C-24 Drawing the first line segment 
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Figure C-25 Drawing the arc segment 

 

 

 

C2 C1 

Arc 1 

Arc 2 

Arc 3 

Arc 4 

a) Two center positions b) Two rotation directions 
 

 

Figure C-26 Four cases for drawing arc segments 
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Figure C-27 Slab after defining corner points 

 

Graphically Menu–"Add opening" command 

To define an opening in the slab (Figure C-28), the position (x, y) of the opening corners must be 

entered by Mouse. The coordinates of corner positions (x, y) are related to the left bottom corner 

of the corresponding mesh. To draw an opening with arc segments, consider the same steps in 

drawing slab corners with arc segments. 
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Figure C-28 Defining opening corners in the slab by Mouse 

 

Graphically Menu–"Add reference points" command 

By this option it is possible to define reference points on the slab by Mouse, Figure C-29. 

Reference points are used to define the positions of boundary points such as supports, springs, 

piles on the slab. Each time that the user generates the mesh, nodes of the FE-Net are passed 

automatically through these references. This provides the flexibility to make changes in the finite 

element mesh without having to redefine the positions of the boundary points. 
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Figure C-29 Reference points on the FE-Net 

 

Graphically Menu–"Add reference lines" command 

By the option "Add reference lines" it is possible to define reference lines on the slab by Mouse, 

Figure C-30. Reference lines are used to define the positions of boundary lines such as girders 

on the slab. Each time the user generates the mesh, nodes of the FE-Net are passed automatically 

through these references. This provides the flexibility to make changes in the finite element 

mesh without having to redefine the positions of the boundary lines. 
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Figure C-30 Reference lines on the FE-Net 

 

Graphically Menu–"Cartesian grid" command 

The Dialog box in Figure C-31 appears to define a Cartesian grid, which is a background grid of 

points to assist in drawing the finite element mesh. These points can be 'Snapped to' when 

creating the mesh geometry in order to create nodes and elements with exact coordinates. 

 

 
Figure C-31 "Cartesian grid" Dialog box 
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5.3.4 FE–Net Generation Menu 

 

This menu contains the following commands: 

 

- Generation type 

- New generation 

- Generating FE-Net  

- Smoothing the mesh 

- Directing border elements 

- Refining the mesh 

 

FE–Net Generation Menu–"Generation type" command 

By the option "Generation type" the following Menu in Figure C-32 appears to define the type of 

FE-Net. There are 6 different element types to generate the FE-Net of the slab. The generation is 

carried out according to Grid-based approach for both triangular and rectangular elements and 

according to Delaunay’s triangular generation for triangular elements. 

 

 
Figure C-32 Generation type for square, rectangular and irregular slabs 

 

When generating circular and ring slabs for the first time, the Menu of Figure C-33 appears with 

8 different types of nets. 

 

 
Figure C-33 Generation type for circular and ring slabs 



 

 

ELPLA-Data 

 

 

C-28 

FE–Net Generation Menu–"New generation" command 

When FE-Net is defined, a new generation with new dimensions of elements or even slab can be 

carried out using "New generation" command. 

 

FE–Net Generation Menu–"Generating FE-Net" command 

After defining the slab corners, element dimensions and type of FE-Net the generation of the FE-

Net can be created automatically by choosing the option "Generating FE-Net". 

 

FE–Net Generation Menu–"Smoothing the mesh" command 

By the option "Smoothing the mesh" it is possible to optimize the dimension of FE-Net by 

making all elements having nearly the same area as possible as. 

 

FE–Net Generation Menu–"Directing border elements" command 

It is possible to direct and arrange all elements on the slab borders (Figure C-34). This option is 

useful to present contact pressures at raft edges in good manner when analyzing the raft by 

Continuum model, in which the contact pressure at raft edges are higher than that at the middle. 

 

 
Figure C-34 Directing border elements 

 

FE–Net Generation Menu–"Refining the mesh" command 

It is possible to refine the mesh in a specified region such as around supports, springs and piles 

to present the concentration of stress, moment and settlement in this region (Figure C-35). 
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Figure C-35 Refining the mesh around a specified node 

 

5.3.5 In table Menu 

 

This menu contains the following commands: 

 

- Slab corners 

- Opening corners 

- Reference points 

- Reference lines 

- Node coordinates 

- Connectivity nodes 

 

In table Menu –"Slab corners" command 

By the option "Slab corners" the position (x, y) of the slab corners can be defined (Figure C-36). 

The coordinates of corner positions (x, y) are related to the left bottom corner of the 

corresponding slab. 
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Figure C-36 Defining slab corners in a table 

 

In table Menu–"Opening corners" command 

Openings in the slab can be defined, Figure C-37. To define an opening in the slab, the position 

(x, y) of the opening corners must be entered in the Menu of Figure C-37. The coordinates of 

corner positions (x, y) are related to the left bottom corner of the corresponding mesh. 

 

 
Figure C-37 Defining opening corners in a table 

 

In table Menu–"Reference points" command 

By this option it is possible to define reference points on the slab in Table, Figure C-38. 

Reference points are used to define the positions of boundary points such as supports, springs, 

piles on the slab. Each time the user generates the mesh, nodes of the FE-Net are passed 

automatically through these references. This provides the flexibility to make changes in the finite 

element mesh without having to redefine the positions of the boundary points. 
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Figure C-38 Defining reference points in Table 

 

In table Menu–"Reference lines" command 

By the option "Reference lines" it is possible to define reference lines on the slab in Table, 

Figure C-39. Reference lines are used to define the positions of boundary lines such as girders 

on the slab. Each time that the user generates the mesh, nodes of the FE-Net are passed 

automatically through these references. This provides the flexibility to make changes in the finite 

element mesh without having to redefine the positions of the boundary lines. 

 

 
Figure C-39 Defining reference lines in a table 

 

In table Menu–"Node coordinates" command 

After choosing the option "Node coordinates" the following Table in Figure C-40 appears to 

define node coordinates of FE-Net. 
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Figure C-40 Table "Node coordinate" 

 

In table Menu–"Connectivity nodes" command 

After choosing this option the following Table in Figure C-41 appears to define connectivity 

nodes of the elements. 

 

 
Figure C-41 Table "Net of finite elements" 

 

5.3.6 Options Menu 

 

The Options Menu has the following commands: 

 

- Plot parameters 

- Display values 

- View grouping 

 

Options Menu–"Plot parameters" command 

Plot parameters may be set as default values by the program, or may be fully specified by the 

user. By this command the following plot parameters can be specified, Figure C-42: 

 

- Display node numbering 

- Display coordinates x, y 

- Display element numbering 

- Display Column types 

- Display FE-Net in separated elements 
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- Color girders 

- Draw girder thickness 

- Display Cartesian grid 

- Grid over entire area 

- Color element groups and slab thickness 

- Display boring subareas boundary  

- Color boring subareas 

- Mark boring subareas 

- Snap to grid or node 

 

 
Figure C-42 "Plot parameters" Dialog box 

 

Display Item 

Turns on and off the display of the item on the drawing 

 

Snap to grid 

This command turns on and off the capability to snap to the grid when creating the mesh 

geometry. 

 

Options Menu–"Display values" command 

The values of the following items can be displayed, if desired, on the drawing (Figure C-43): 

 

- Loads 

- Boundary conditions 

- Spring supports 

- Element groups 

- Girder system 

- Piles 

- Additional settlements 
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Figure C-43 "Display values" Dialog box 

 

Options Menu–"View grouping" command 

By the "View grouping" command you can draw a group of data together in one presentation 

(for example supports with loads and girders), Figure C-44. 

 

 
Figure C-44 Group of data together 

 

5.3.7 Format Menu 

 

The Format Menu has the following commands: 

 

- Line formats 

- Fill color 

- Max. ordinate 

- Font 

- Grid 
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Format Menu–"Line formats" command 

By the "Line formats" command the color, style and thickness of drawing lines can be defined, 

Figure C-45. The way a line is drawn depends on the setting of the color and style properties. 

There are 15 different colors and 5 styles available for line formats. The following list shows the 

available lines, which can be formatted: 

 

- Slab boundary 

- Elements 

- Isometric view 

- Distribution drawing 

- Contour lines 

- Legends 

- Circular diagrams 

- Arrows of support reactions 

- Page boundary 

- Identification box  

- Streaks of principal moments (+ve) 

- Streaks of principal moments (-ve)  

- Slab dimensions 

- Loads 

- Boundary conditions 

- Boring logs 

- Slab thickness 

- Axes of symmetry  

- Beam elements 

- Spring supports 

- Axes of symmetry 

- Symbol of symmetry 

- Vectors of soil deformation 

- Deformed mesh of soil deformation 

- Axis arrows 

- Girder axes 

- Piles in plan 

- Pile length 

- Pile hatching 

- Additional settlements 

- Reference points and lines 

- Columns 

- Cartesian grid 

- Punching shear 

- Borders of block elements 
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Figure C-45 "Line formats" Dialog box 

 

Format Menu–"Fill color" command 

By the "Fill color" command the fill color of drawing can be defined (Figure C-46). 

 

The following list shows the available items, which can be filled with a specified color: 

 

- Loads 

- Boundary conditions 

- Springs 

- Zone type I: Bilinear interpolation among three boring logs 

- Zone type II: Linear interpolation between two boring logs 

- Zone type III: Node corresponds to boring 

- Circle of boring 

- Additional settlements 

- (+ve) Circular diagrams 

- (-ve) Circular diagrams 

- Punching shear 

- Material No. 

- Girder group No. 

- Sub area of boring No. 

- Pile group No. 

- Column group No. 

 

 
Figure C-46 "Fill color" Dialog box 

 

Format Menu–"Max. ordinate" command 

By "Max. ordinate" command the maximum ordinate, maximum diameter, maximum side, 

maximum width and maximum length for the drawing can be defined, Figure C-47. 
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Figure C-47 "Max. ordinate" Dialog box 

 

Format Menu–"Font" command 

Here the font size (Figure C-48) and font type (Figure C-49) for the drawing can be defined. 

 

 

Figure C-48 "Font size" Dialog box 

 

 
Figure C-49 "Font type" Dialog box 

 

5.3.8 Window Menu 

 

The Window menu has the following commands: 

 

- Zoom in 

- Zoom out 

- Zoom window 

- Zoom % 

- Original size 
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Window Menu–"Zoom in" command 

By the "Zoom in" command the size of the drawing on the screen can be reduced. 

 

Window Menu–"Zoom out" command 

By the "Zoom out" command the size of the drawing on the screen can be increased. 

 

Window Menu–"Zoom window" command 

By the "Zoom window" command the size of the drawing on a specified area can be increased. 

 

Window Menu–"Zoom %" command 

When you choose "Zoom %" command the following Dialog box appears, Figure C-50. 

 

 
Figure C-50 "Zoom %" Dialog box 

 

By the "Zoom %" command the size of drawing on the screen can be specified. Choosing "Zoom 

%" allows you to increase or decrease the size at which the drawing is displayed. Choosing 

"100%" displays the drawing at its original size. Clicking on the percentage changes the drawing 

size to the specified percentage. The drawing can be displayed at any size by typing the desired 

percentage in the specified Edit box. 

 

Window Menu–"Original size" command 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using the "Original size" 

command. 

 

5.3.9 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Data 

 

Help Menu–"Contents" command 

The "Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide (Figure C-51). 
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Figure C-51 Menu "Contents" 

 

Help Menu–"Short description of ELPLA" command 

The "Short description of ELPLA" command gives a short description of ELPLA package. 

 

Help Menu–"New in ELPLA" command 

The "New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

Help Menu–"About ELPLA-Data" command 

Clicking the command "About ELPLA-Data" displays the information form of ELPLA-Data as 

shown in Figure C-52, which gives information about ELPLA-Data and the calculation method 

of the loaded project. 
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Figure C-52 Information form of program ELPLA-Data 

 

5.3.10 Important notes 

 

Element size 

Sometimes edge moments M  0 appear on the slab, this means the element sizes are not optimal 

for the analysis. Therefore, if the moments of the slab are required, the length or width of the 

elements must be not longer than three times of slab thickness. Further more, the size of the 

middle element must be not more than three times the size of neighboring elements. 

 

Change or modification of FE-Net 

If the FE-Net of the slab is changed or modified for a new analysis, the input data of girders, 

boundary conditions, spring supports, slab properties, boring fields, etc. must be renewed. When 

closing a modified FE-Net, a Dialog box will appear (Figure C-53). This Dialog box shows the 

data that are set outside the FE-Net. To select the data to fix, check the boxes of these data. 

 

 
Figure C-53 Select the data to fix Dialog box 

 

 



 

 

ELPLA-Data 

 

 

C-41 

5.4 Data Menu–"Girders" command 

 

In ELPLA beam elements are considered to represent the girder action in the slab. When the 

"Girders" command is chosen, the following embedded program appears, Figure C-54. 

 

 
Figure C-54 "Girders" embedded program 

 

The menu head of Figure C-54 contains the following commands: 

 

- File 

- View 

- Graphically 

- In table 

- Options 

- Format 

- Window 

- Help 

 

The following paragraph presents and describes the menu commands and their sub-commands. 

 

5.4.1 File Menu 

 

This menu contains five commands: 

 

- New girders 

- Open girders 

- Save girders  

- Save girders as 

- Close girders 
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File Menu–"New girders" command 

New girders are defined. 

 

File Menu–"Open girders" command 

Existing girders-file are opened again. Then the girders, if desired, can be redefined. 

 

File Menu–"Save girders" command 

Saves the active girders under the available name 

 

File Menu–"Save girders as" command 

Saves the active girders under a new name 

 

File Menu–"Close girders" command 

Closes the Girders-embedded program and returns to ELPLA-Data. 

 

5.4.2 View Menu (See paragraph 5.3.2) 

 

5.4.3 Graphically Menu 

 

The menu "Graphically" contains the following commands: 

 

- Undo 

- Redo 

- Remove girders 

- Add girders 

- Edit girders 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Remove girders" command 

When "Remove girders" command is chosen, the cursor is changed from an arrow to a cross 

hair. The desired girder is deleted by double clicking on it. 

 

Graphically Menu–"Add girders" command 

"Add girders" command is used to define and add a new girder. To add a girder, click the left 

mouse button on the start node of the girder and drag the mouse until the end node of the girder, 

then click on the end node. 

 

Graphically Menu–"Edit girders" command 

The main function of "Edit girders" command is to provide a method for redefining girders. 

When "Edit girders" command is chosen, the cursor is changed from an arrow to a cross hair. 

The desired girder is redefined by double clicking on it. Then, the following Dialog box of 

Figure C-55 appears. 
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Figure C-55 "Girder elements" Dialog box 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.4.4 In table Menu 

 

In ELPLA there are two alternative possibilities to define girders on the slab, graphically or 

numerically (in a table). The menu "In table" contains the following commands: 

 

- Girder groups 

- Girders 

 

In table Menu–"Girder groups" command 

When "Girder groups" command is chosen, the following Dialog box in Figure C-56 appears 

first to chose the option of cross section definition. 

 

 
Figure C-56 "Cross section definition" Dialog box 

 

In the "Cross section definition" Dialog box (Figure C-56) choose the option to define the girder 

cross section. The three alternative possibilities to define the girder groups are: 

 

- Rectangular cross sections (Figure C-57) 

- General cross sections (Figure C-58) 

- T/L-Girders (Figure C-59) 
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Figure C-57 "Defining girder groups – Rectangular cross section" Dialog box 

 

 
Figure C-58 "Defining girder groups – General cross section" Dialog box 

 

 
Figure C-59 "Defining girder groups – T/L-Girder" Dialog box 
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In the Dialog boxes of Figure C-57 and Figure C-58 E-Modulus, G-Modulus, girder section and 

girder weight for each group are required to define. Girder group is defined as a group of beam 

elements that have the same properties. 

 

In the Dialog box of Figure C-59 the stiffness of girders that have T/L-section can be simulated 

in the slab by using additional beam elements. The stiffness of the girder can be obtained 

through a replacement beam arranged in the center plan of the slab. The dimensions of the 

replacement beam can be taken as in DIN 1075 or EC 2. 

 

In table Menu–"Girders" command 

Girder as beam element is defined through start and end nodes that at them the girder starts and 

ends (Figure C-60). 

 

 
Figure C-60 "Girders in x-direction" Dialog box 

 

5.4.5 Options Menu (See paragraph 5.3.6) 

 

5.4.6 Format Menu (See paragraph 5.3.7) 

 

5.4.7 Window Menu (See paragraph 5.3.8) 

 

5.4.8 Help Menu (See paragraph 5.3.9) 
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5.5 Data Menu–"Spring supports" command 

 

By the "Spring supports" command elastic support or node stiffness on the slab is defined. When 

the command is chosen, the following embedded program appears (Figure C-61). 

 

 
Figure C-61 "Spring supports" embedded program 

 

Treatment of spring supports 

The following types of spring supports are possible: 

 

- Vertical spring kz 

- Rotational spring about x-direction ktx 

- Rotational spring about y-direction kty 

 

Figure C-61 and the Dialog box of Figure C-63 show some samples of spring supports that may 

be used in ELPLA. 

 

The menu head of Figure C-61 contains the following eight commands: 

 

- File 

- View 

- Graphically  

- In table 

- Options 

- Format 

- Window 

- Help 
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After clicking one of the eight commands (options) other sub-commands or options become 

available. The following paragraph presents and describes the eight menu commands and their 

sub-commands. 

 

5.5.1 File Menu 

 

This menu contains five commands: 

 

- New spring supports 

- Open spring supports 

- Save spring supports 

- Save spring supports as 

- Close spring supports 

 

File Menu–"New spring supports" command 

Defines new spring supports. 

 

File Menu–"Open spring supports" command 

Opens existing spring supports-file again. Then the spring supports, if desired, can be redefined. 

 

File Menu–"Save spring supports" command 

Saves the active spring supports under the available name. 

 

File Menu–"Save spring supports as" command 

Saves the active spring supports under a new name. 

 

File Menu–"Close spring supports" command 

Closes the spring supports-embedded program and returns to ELPLA-Data  

 

5.5.2 View Menu (See paragraph 5.3.2) 

 

5.5.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Select nodes 

- Add spring supports 

- Remove spring supports 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 
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Graphically Menu–"Select nodes" command 

The main function of "Select nodes" command is to provide a method for removing or adding 

elastic nodes. When "Select nodes" command is chosen, the cursor is changed from an arrow to 

a cross hair. In this case, "Add spring supports" and also "Remove spring supports" will be 

enabled, indicating the modes in which are being operated. The desired nodes are selected by 

clicking on each node individually or selecting a group of nodes. A group of nodes can be 

selected by holding the left mouse button down at the corner of the region and dragging the 

mouse until a rectangle encompasses the desired group of nodes. When the left mouse button is 

released, all nodes in the rectangle are selected. 

 

Graphically Menu–"Remove spring supports" command 

This command is used to make the selected nodes free from spring supports. 

 

Graphically Menu–"Add spring supports" command 

It is used to define the stiffness for the selected nodes. Any old spring supports of the selected 

nodes will be replaced by the new editing. When "Add spring supports" command is chosen, the 

following Dialog box of Figure C-62 appears to define springs and column type. 

 

 
Figure C-62 "Add spring supports" Dialog box 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.5.4 In table Menu 

 

This menu contains the following commands: 

 

- Column types 

- Spring supports 
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In table Menu–"Column types" command 

When the "Column types" command is chosen, the following Table in Figure C-63 appears to 

define the column dimensions. Column dimensions are required for design of the slab for 

punching shear. 

 

 
Figure C-63 Defining column dimensions 

 

In table Menu–"Spring supports" command 

When this command is chosen, the following Table in Figure C-64 appears. In this Table the 

elastic support is described by spring stiffness. 

 

 
Figure C-64 Defining spring stiffness in a table 

 

5.5.5 Options Menu (See paragraph 5.3.6) 

 

5.5.6 Format Menu (See paragraph 5.3.7) 

 

5.5.7 Window Menu (See paragraph 5.3.8) 

 

5.5.8 Help Menu (See paragraph 5.3.9) 
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5.6 Data Menu–"Supports/ Boundary conditions" command 

 

By this command supports or boundary conditions on the slab are defined. When this command 

is chosen, the following embedded program appears (Figure C-65). 

 

 
Figure C-65 "Supports/ Boundary conditions" embedded program 

 

Treatment of rigid or elastic supports 

Rigid or elastic nodes may represent the point and line supports. The following types of supports 

or boundary conditions are possible: 

 

- Elastic or rigid displacements w 

- Elastic or rigid rotations about x-direction θx 

- Elastic or rigid rotations about y-direction θy 

 

Figure C-65 and the Dialog box of Figure C-68 show some samples of supports and boundary 

conditions that may be used in ELPLA. 

 

Illustrative example for point and line supports 

The following example is used to describe point and line supports. The problem is an arbitrary 

slab foundation with variable type of supports as shown in Figure C-65 and the Dialog box of 

Figure C-68. The supports are: 

 

- Support 1 is a line support in x-direction. All nodes are fixed against vertical 

displacement. No rotation is permissible about y-axis and the rotation about x-axis is free 

 

- Support 2 is a line support in y-direction. All nodes have w =2 [cm] vertical 

displacement. No rotation is permissible about y-axis and the rotation about x-axis is θx = 

0.00005 

Support 1 

Support 3 

Support 4 
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- Support 3 is a point support. This point is fixed against vertical displacement and the 

rotations about x- and y-axis are free 

 

- Support 4 is a group of point supports (inclined line support). All nodes are fixed against 

vertical displacement and the rotations about x- and y-axis are free 

 

The menu head of Figure C-65 contains the following eight commands: 

 

- File 

- View 

- Graphically  

- In table 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the eight commands (options) other sub-commands or options become 

available. The following paragraph presents and describes the eight menu commands and their 

sub-commands. 

 

5.6.1 File Menu 

 

This menu contains five commands: 

 

- New supports/ boundary conditions  

- Open supports/ boundary conditions 

- Save supports/ boundary conditions  

- Save supports/ boundary conditions as 

- Close supports/ boundary conditions  

 

File Menu–"New supports/ boundary conditions" command 

Defines new supports/ boundary conditions 

 

File Menu–"Open supports/ boundary conditions" command 

Opens existing supports/ boundary conditions-file again on the screen. Then the supports/ 

boundary conditions, if desired, can be redefined. 

 

File Menu–"Save supports/ boundary conditions" command 

Saves the active supports/ boundary conditions under the available name 

 

File Menu–"Save supports/ boundary conditions as" command 

Saves the active supports/ boundary conditions under a new name 

 

File Menu–"Close supports/ boundary conditions" command 

Closes the supports/ boundary conditions embedded program and returns to ELPLA-Data 

 

5.6.2 View Menu (See paragraph 5.3.2) 
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5.6.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Select nodes 

- Add boundaries 

- Remove boundaries 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Select nodes" command 

The main function of "Select nodes" command is to provide a method for removing or adding 

restrains to nodes. When "Select nodes" command is chosen, the cursor is changed from an 

arrow to a cross hair. In this case "Add boundaries" and also "Remove boundaries" will be 

enabled, indicating the modes in which are being operated. The desired nodes are selected by 

clicking on each node individually or selecting a group of nodes. A group of nodes can be 

selected by holding the left mouse button down at the corner of the region and dragging the 

mouse until a rectangle encompasses the desired group of nodes. When the left mouse button is 

released, all nodes in the rectangle are selected. 

 

Graphically Menu–"Remove boundaries" command 

"Remove boundaries" command is used to make the selected nodes free from restraints. 

 

Graphically Menu–"Add boundary" command 

"Add boundary" command is used to define the restraints for the selected nodes. Any old 

restraints of the selected nodes will be replaced by the new editing. When "Add boundary" 

command is chosen, the following Dialog box of Figure C-66 appears to define supports, 

boundary conditions and column types. 
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Figure C-66 Defining node restraints 

 

The following input characters in the Dialog box of Figure C-66 mean: 

 

- "0"  means rigid support 

- "F"   means free displacement or rotation 

- "0<or>0" means the value of elastic support 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.6.4 In table Menu 

 

This menu contains the following commands: 

 

- Column types 

- Node restraints 

 

In table Menu–"Column types" command 

When this command is chosen, the following Table in Figure C-67 appears to define the column 

dimensions. Column dimensions are required for design of the slab for punching shear. 
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Figure C-67 Defining column dimensions 

 

In table Menu–"Node restraints" command 

When the "Node restraints" command is chosen, the following Table in Figure C-68 appears. In 

this Table define the node restraints and column types. 

 

 
Figure C-68 Defining node restraints in a table 

 

5.6.5 Options Menu (See paragraph 5.3.6) 

 

5.6.6 Format Menu (See paragraph 5.3.7) 

 

5.6.7 Window Menu (See paragraph 5.3.8) 

 

5.6.8 Help Menu (See paragraph 5.3.9) 

 

5.7 Data Menu–"Piles" command 

 

By the "Piles" command piles on the slab are defined. When the "Piles" command is chosen, the 

following embedded program appears (Figure C-69). 
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Figure C-69 "Piles" embedded program 

 

The menu head of Figure C-69 contains the following eight commands: 

 

- File 

- View 

- Graphically  

- In table 

- Options 

- Format 

- Window 

- Help 

 

The following paragraph presents and describes the menu commands and their sub-commands. 

 

5.7.1 File Menu 

 

This menu contains five commands: 

 

- New piles 

- Open piles 

- Save piles 

- Save piles 

- Close piles 

 

File Menu–"New piles" command 

Defines new piles 
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File Menu–"Open piles" command 

Opens existing piles-file again. Then the piles, if desired, can be redefined. 

 

File Menu–"Save piles" command 

Saves the active piles under the available name 

 

File Menu–"Save piles as" command 

Saves the active piles under a new name 

 

File Menu–"Close piles" command 

Closes the piles-embedded program and returns to ELPLA-Data  

 

5.7.2 View Menu (See paragraph 5.3.2) 

 

5.7.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Select nodes 

- Add spring supports 

- Remove spring supports 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Select nodes" command 

The main function of this command is to provide a method for removing or adding piles. When 

"Select nodes" command is chosen, the cursor is changed from an arrow to a cross hair. In this 

case "Add piles" and also "Remove piles" will be enabled, indicating the modes in which are 

being operated. The desired nodes are selected by clicking on each node individually or selecting 

a group of nodes. A group of nodes can be selected by holding the left mouse button down at the 

corner of the region and dragging the mouse until a rectangle encompasses the desired group of 

nodes. When the left mouse button is released, all nodes in the rectangle are selected. 

 

Graphically Menu–"Remove piles" command 

"Remove piles" command is used to make the selected nodes free from piles. 

 

Graphically Menu–"Add piles" command 

"Add piles" command is used to add piles at the chosen nodes and to define the pile group No. 

for these piles. Any old piles of the selected nodes will be replaced by the new editing. When 

"Add piles" command is chosen, the following Dialog box of Figure C-70 appears. 
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Figure C-70 "Add piles" Dialog box 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.7.4 In table Menu 

 

This menu contains the following commands: 

 

- Pile groups 

- Pile location and groups 

- Pile material 

 

In table Menu–"Pile groups" command 

In ELPLA there are different calculation methods to analyze the raft on piles. Therefore the pile 

groups for each method are required to define according to the used soil model as described in 

the next paragraphs. 

 

Pile groups for Simple Assumption Model 

In this model all forces acting on the raft will be transmit linearly on the piles. When the "Pile 

groups" command is chosen for this model, the following Table in Figure C-71 appears to define 

the pile diameter. Pile diameter is required for design of the slab for punching shear. 

 

 
Figure C-71 Defining pile groups for Simple Assumption Model 

 

Pile groups for Winkler’s Model 

For the two methods of Constant and Variable Modulus of Subgrade Reaction (methods 2 and 

3), when the modulus of subgrade reaction is required to define by the user, pile groups in this 

case will be the pile diameter and the pile stiffness (Figure C-72). 
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Figure C-72 Defining pile groups for Winkler’s Model 

 

Pile groups for Isotropic Elastic Half-Space and Layered soil Models 

When pile groups are required to define for one of these two soil models, the following Dialog 

box of Figure C-73 appears. The soil data around and under the pile are required to define. Soil 

data are used to determine the pile stiffness due to the soil type by ELPLA.  

 

 
Figure C-73 Defining pile groups for Half-Space and Layered soil Models 
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In table Menu–"Pile locations and groups" command 

When this command is chosen, the following Table in Figure C-74 appears. In this Table define 

the pile locations and their groups. Pile group is a group that has the same dimension and soil 

properties. 

 

 
Figure C-74 Defining pile locations and groups in a table 

 

In table Menu–"Pile material" command 

When "Pile material" command is chosen, the following Dialog box in Figure C-75 appears. In 

this dialog box E-Modulus of the pile and the unit weight of the pile material are defined. Pile 

material are used to determine the pile stiffness due to its material type. 

 

 
Figure C-75 "Defining element groups" Dialog box 

 

5.7.5 Options Menu (See paragraph 5.3.6) 

 

5.7.6 Format Menu (See paragraph 5.3.7) 

 

5.7.7 Window Menu (See paragraph 5.3.8) 

 

5.7.8 Help Menu (See paragraph 5.3.9) 
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5.8 Data Menu–"Soil properties" command 

 

In ELPLA there are nine different calculation methods with different subsoil models. Therefore 

the soil properties for each method are required to define according to the used soil model as 

described in the next paragraphs.   

 

Soil properties for Simple Assumption Model 

There is no interaction between the subsoil and the foundation for Simple Assumption model 

(Linear Contact Pressure method - method 1). Therefore the soil data are not required in this 

method (only groundwater Gw and foundation level Tf are required). When soil properties are 

required to define for the calculation methods 1 (Linear Contact Pressure method), the following 

Dialog box of Figure C-76 appears. 

 

If the water table is located above the foundation, the foundation will be exposed to an additional 

negative pressure. In the Dialog box of Figure C-76 define the groundwater depth under the 

ground surface Gw in order to take the effect of groundwater pressure in the analysis.   

 

 
Figure C-76 "Soil properties" Dialog box (method 1) 

 

Soil properties for Winkler’s Model 

For the two methods of Constant and Variable Modulus of Subgrade Reaction (methods 2 and 

3), when the modulus of subgrade reaction is required to define by the user, soil properties in 

this case will be the modulus of subgrade reaction ks besides its coordinates (x, y) in the global 

system and groundwater depth under the ground surface Gw. If the nonlinear analysis is required, 

the ultimate bearing capacity of the soil qult must be defined (Figure C-77). 

 

 
Figure C-77 "Soil properties" Dialog box (methods 2 and 3)  
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Soil properties for Isotropic Elastic Half-Space Model 

When soil properties are required to define for the calculation method 2 (Modulus of subgrade 

reaction is determined from Half-Space) and calculation method 5 (Isotropic Elastic Half-

Space), the following Dialog box of Figure C-78 appears. 

 

 
Figure C-78 "Soil properties" Dialog box (methods 2 and 5) 

 

In the Dialog box of Figure C-78 define the settlement reduction factor α, Poisson’s ratio of the 

soil νs, groundwater depth under the ground surface Gw and the modulus of compressibility of 

the soil Es. If the nonlinear analysis is required, the angle of internal friction φ and the cohesion c 

of the soil must be defined. 

 

Soil properties for Layered soil Model 

Layered soil model is used in the analysis of the calculation methods shown in Table C-4. When 

soil properties are required to define for one of the calculation methods shown in this Table, the 

following embedded program (Figure C-79) appears with default-boring logs. 
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Table C-4 Numerical calculation methods (Layered soil model) 

Method 

No. 

Method 

2 

 

 

3 

 

 

4 

 

 

6 

 

 

 

7 

 

 

 

8 

 

 

9 

Constant modulus of subgrade reaction 

Winkler's model, Modulus of subgrade reaction is determined from soil layers 

 

Variable modulus of subgrade reaction 

Winkler's model, Modulus of subgrade reaction is determined from soil layers 

 

Modification of modulus of subgrade reaction by iteration 

Winkler's model/ Continuum model 

 

Modulus of compressibility method for elastic raft on layered soil medium  

Solving system of linear equations by iteration, 

Layered soil medium - Continuum model 

 

Modulus of compressibility method for elastic raft on layered soil medium  

Solving system of linear equations by elimination, 

Layered soil medium - Continuum model 

 

Modulus of compressibility method for rigid raft on layered soil medium, 

Layered soil medium - Continuum model 

 

Modulus of compressibility method for flexible foundation on layered soil 

medium, Layered soil medium - Continuum model 

 

 

 
Figure C-79 "Soil properties" embedded program 
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The menu head of Figure C-79 contains the following nine commands: 

 

- File 

- View 

- Data 

- Graphically 

- Options 

- Formats 

- Main data 

- Window 

- Help 

 

After clicking one of the nine menus other sub-menus or commands become available. The 

following paragraph presents and describes the nine menu commands and their sub-commands. 

 

5.8.1 File Menu 

 

This menu contains five commands: 

 

- New boring logs 

- Open boring logs 

- Save boring logs 

- Save boring logs as 

- Close boring logs 

 

File–"New boring logs" command 

Defines new boring logs 

 

File–"Open boring logs" command 

Opens existing boring log-files again on the screen. Then they, if desired, can be redefined. 

 

File–"Save boring logs" command 

Saves the active boring logs under the available name 

 

File–"Save boring logs as" command 

Saves the active boring logs under a new name 

 

File–"Close boring logs" command 

Closes the Boring-embedded program and returns to ELPLA-Data. 

 

5.8.2 View Menu (See paragraph 5.3.2) 

 

5.8.3 Data Menu 

 

The menu "Data" contains the following commands: 

 

- Soil data 

- Main soil data 
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Data Menu–"Soil data" command 

When "Soil data" command is chosen, the following Dialog box in Figure C-80 appears. 

 

 
Figure C-80 "Soil data" Dialog box 

 

Elastic settlement and consolidation settlement can be determined using their actual properties, 

where the soil properties of the individual layers are defined by: 

 

- Modulus of Compressibility Es (1/mv) 

- Modulus of Elasticity E 

- Compression Index Cc 

 

This option enables ELPLA to analyze rafts on consolidated clay deposits by the different 

calculation methods that are available in ELPLA. Also the user doesn’t need to convert a soil 

parameter to other. When defining soil properties by the Modulus of Elasticity E, the Poisson’s 

ratio νs can be different for every layer. 

 

In the Dialog box of Figure C-80 the soil under the foundation may be defined by a number of 

boring logs. Each boring log has multi-layers with different soil materials. The geotechnical data 

for each layer are unit weight of the soil γs, modulus of compressibility for loading Es (or 

Modulus of Elasticity E or Compression Index Cc) and for reloading Ws and Poisson’s ratio of 

the soil νs. If the nonlinear analysis is required, the angle of internal friction φ and the cohesion c 

of the soil must be defined; besides the boring coordinates x, y in the global system and its label 

are required to define. In order to draw the soil layers by different symbols according to the 

German specification code DIN 4023, define soil art and color in the Dialog box of Figure C-80. 

 

Copy, Insert and Delete commands for both soil layer and boring log are available in the Dialog 

box of Figure C-80. Further more, boring logs can be inserted from a file by checking the option 

"From file" in the "Boring insert" Frame box (Figure C-81). 
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Figure C-81 Boring log can be inserted from a file 

 

Data Menu–"Main soil data" command 

Main soil data is the general data for all soil layers and boring logs. When "Main soil data" 

command is chosen, the following Dialog box in Figure C-82 appears.  

 

Settlement reduction factor 

According to experience the real consolidation settlements are different from those calculated. 

Therefore the settlement s may be multiplied by a factor α according to the German standard 

DIN 4019. According to the German standard DIN 4019 the following reduction factors α can be 

applied: 

 

Sand and silt       α = 0.66 

Normally and slightly over consolidated clay  α = 1.0 

Heavily over consolidated clay    α = 0.5-1.0 

 

In the Dialog box of Figure C-82 define the settlement reduction factor α and the groundwater 

depth under the ground surface Gw. 
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Figure C-82 "Main soil data" dialog box 

 

Bearing capacity factors 

The bearing capacity factors used to determine the ultimate bearing capacity can optionally be 

defined according to different codes and authors. These factors are required to carry out the 

nonlinear analysis of the soil. The bearing capacity factors are defined according to Figure C-83: 

 

- German Standard DIN 1054 

- Euro Code   EC 7 

- Egyptian code  ECP 

- Terzaghi 

- Meyerhof 
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Figure C-83 Menu "Bearing capacity factors" 

 

Flexibility coefficients for interior nodes 

For rigid and elastic rafts it is convenient to determine the flexibility coefficient of interior node 

at the characteristic point of the loaded area on that node. For flexible foundation it is real to 

determine the flexibility coefficient of interior node at that node. 

 

Now it is possible to determine the flexibility coefficient of the interior node due to a uniform 

load at that node (0): 

 

- at the characteristic point of the loaded area, where rigid settlement is equal to flexible 

settlement 

- at the midpoint of the loaded area, where maximum settlement occurs 

- at the interior node on the loaded area 

 

Flexibility coefficients for exterior nodes 

Earlier versions of ELPLA determine flexibility coefficients for both interior and exterior nodes 

by assuming uniform loaded areas on these nodes. This assumption needs to use the principle of 

superposition for determining the flexibility coefficients. Now it is possible, optionally to 

convert the loaded areas on exterior nodes to point loads, Figure C-84. By this way the program 

doesn’t need to use the principle of superposition in the analysis, making it much faster than the 

old analysis. The new way of analysis is consequently faster and more efficient for problems that 

contain a large finite element mesh. 
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Limit distance 

If the distance between two nodes is too large, the settlement of a node due to a load on the other 

will be small enough to be neglected. To reduce the time required for determining the flexibility 

coefficients for great rafts, a limit distance between node i and j for determining the flexibility 

coefficient c(i, j) may be defined, Figure C-84. 

 

 
Figure C-84 Menu "Flexibility coefficients" 

 

5.8.4 Graphically Menu 

 

In the program ELPLA it is also possible to define the boring logs graphically. This makes the 

definition of the boring logs very easy. This option is used also for drawing the defined boring 

logs to make a control on the input soil data and parameters. 

 

The menu "Graphically" contains one command: 

 

- Drawing boring logs  

 

Graphically Menu–"Drawing boring logs" command 

When "Drawing boring logs" command is chosen, the following Dialog box in Figure C-85 

appears. In this Dialog box chose the boring logs you want to draw, then click on Button "OK". 

Then the menu of Figure C-86 appears to control input soil data and parameters or to redefine 

the boring data. 
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Figure C-85 "List of boring logs" Dialog box 

 

 
Figure C-86 Boring logs on the screen 

 

Definition of boring logs graphically 

By double-clicking the left mouse Button on a specified screen position, the user can also define 

soil data and input parameters. 

 

- By double-clicking on the geotechnical data of a soil layer the corresponding Dialog box 

to define the geotechnical data of that layer appears, Figure C-87 
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Figure C-87 "Geotechnical data of the layer" Dialog box 

 

- By double-clicking on the layer level the corresponding Dialog box to define the layer 

depth under the ground surface appears, Figure C-88 

 

 
Figure C-88 "Layer depth under the ground surface" Dialog box 

 

- By double-clicking on the soil symbol of a soil layer the corresponding Dialog box to 

define the soil symbols of that layer appears, Figure C-89 

 

 
Figure C-89 "Sand and rock symbols" Dialog box 

 

- By double-clicking on the groundwater level the corresponding Dialog box to define the 

groundwater depth under the ground surface appears, Figure C-90 
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Figure C-90 "Groundwater" Dialog box 

 

- By double-clicking on the label of a boring log the corresponding Text box to define the 

label of that boring log appears, Figure C-91 

 

 
Figure C-91 "Label of the boring log" Text box 

 

5.8.5 Options Menu 

 

The Options Menu has the following commands: 

 

- Plot parameters  

- Display values 

 

Options Menu–"Plot parameters" command 

Plot parameters may be set as default values by the program, or may be fully specified by the 

user.  

 

By the "Plot parameters" command the following plot parameters can be specified, Figure C-92:   

 

- Color soil layers 

- Draw water table 

- Simple drawing of boring logs 

- Setting soil colors according to DIN 4023 

- Display soil properties c, Phi and Nue 

 

 
Figure C-92 "Plot parameters" Dialog box 

 

 

 



 

 

ELPLA-Data 

 

 

C-72 

Options Menu–"Display values" command 

By this command the values of the following items can be displayed on the drawing, Figure C-

93: 

 

- Label of boring 

- Layer description 

- Layer depth 

- Display text of soil symbols 

- Measurement bar (available in ELPLA-Boring) 

- Foundation (available in ELPLA-Boring) 

- Water level 

- Limit depth (available in ELPLA-Boring) 

- Stress value (available in ELPLA-Boring) 

 

 
Figure C-93 "Display values" Dialog box 

 

5.8.6 Format Menu 

 

The Format Menu has the following commands: 

 

- Line formats 

- Fill color 

- Max. width 

- Font 

 

Format Menu–"Line formats" command 

By the "Line formats" command the color, style and thickness of drawing lines can be defined, 

Figure C-94. The way a line is drawn depends on the setting of the color and style properties. 

There are available 15 different colors and 5 styles for line formats. 

 

The following list shows the available lines, which can be formatted: 

 

- Identification box (available in ELPLA-Boring) 

- Page Boundary (available in ELPLA-Boring) 

- Boring boundary 

- Soil layer levels 

- Soil symbols 

- Groundwater 

- Foundation (available in ELPLA-Boring) 

- Measurement bar (available in ELPLA-Boring) 

- Limit depth (available in ELPLA-Boring) 
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Figure C-94 "Line formats" Dialog box 

 

Format Menu–"Fill color" command 

By the "Fill color" command the fill color of drawing can be defined, Figure C-95. The 

following list shows the available items, which can be filled with a specified color: 

 

- Groundwater 

- Foundation (available in ELPLA-Boring) 

- Measurement bar (available in ELPLA-Boring) 

- Stress due to foundation (available in ELPLA-Boring) 

- Stress from neighboring foundations (available in ELPLA-Boring) 

- Stress from soil weight  (available in ELPLA-Boring) 

 

 
Figure C-95 "Fill color" Dialog box 

 

Format Menu–“Max. width” command 

Here the maximum width for the drawing can be defined, Figure C-96.  

 

 
Figure C-96 "Max. width" Dialog box 
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Format Menu–"Font" command 

By this command Font size (Figure C-97) and Font type (Figure C-98) can be defined. 

 

 
Figure C-97 "Font size" Dialog box 

 

 
Figure C-98 "Font type" Dialog box 

 

5.8.7 Main data Menu 

 

The Main data Menu has the following command: 

 

- Preferences 

 

Main data Menu–"Preferences" command 

When "Preferences" command is chosen, the following Dialog box in Figure C-99 appears. 

 

 
Figure C-99 "Preferences" Dialog box 
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In the Dialog box of Figure C-99 the user can specify the following items: 

 

- In the Dialog box "Default soil data" the user can specify the file of default soil data. 

Default soil data are considered when creating new boring logs 

 

- In the Dialog box "Number formats" the user can specify how the numbers of soil 

parameter values (levels, depths, dimensions, etc.) are displayed or printed 

 

The following examples describe the number formats: 

 

Number = 5459.3472 

Format "0.000" gives 5459.347 

Format "0.00"  gives 5459.35 

Format "0.0"   gives 5459.4 

Format "0"  gives 5459 

Format "00E+00"  gives 55E+02     (Exponential format) 

 

5.8.8 Window Menu (See paragraph 5.3.8) 

 

5.8.9 Help Menu (See paragraph 5.3.9) 

 

5.9 Data Menu–"Net of soil elements in z-direction" command 

 

The number of elements and element sizes of the net of soil elements in z-direction are defined. 

This net is required for determining displacements, stresses and strains in soil. When the 

command is chosen, the following Dialog box of Figure C-100 appears. In order to activate the 

option of variable element sizes in z-direction, the corresponding item must be unchecked. 

 

 
Figure C-100 "Net of soil elements in z-direction" Dialog box 

 

5.10 Data Menu–"Limit depth" command 

 

It is found from experience that the number of layers under foundation depends on the limit 

depth Zg, where no settlement occurs. The limit depth Zg is defined as the level of which the 

stress due to the foundation loads reaches a standard ratio Cs of the initial vertical stress due to 

the self-weight of the soil layers. According to the German Standard DIN 4019 part 1 the 

recommended standard value of Cs is 0.2. 
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By the "Limit depth" command limit depth of the soil layers in a boring is defined. When the 

"Limit depth" command is chosen, the following Dialog box of Figure C-101 appears. 

 

 
Figure C-101 "Limit depth" Dialog box 

 

The Dialog box of Figure C-101 shows the available boring logs in the project. To determine the 

limit depth of a boring log, check the box of that boring log. 

 

5.11 Data Menu–"Foundation (Slab) properties" command 

 

When the "Foundation properties" command is chosen, the following embedded program 

appears, Figure C-102. 

 

 
Figure C-102 "Foundation properties" embedded program 
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The menu head of Figure C-102 contains the following nine commands: 

 

- File 

- View 

- Graphically 

- In table 

- Foundation (Slab) properties 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the nine menus other sub-menus or commands become available. The 

following paragraph presents and describes the nine menu commands and their sub-commands. 

 

5.11.1 File Menu 

 

This menu contains five commands: 

 

- New foundation properties 

- Open foundation properties 

- Save foundation properties 

- Save foundation properties as 

- Close foundation properties 

 

File Menu–"New foundation properties" command 

Defines new foundation properties 

 

File Menu–"Open foundation properties" command 

Opens existing foundation properties-files again on the screen. Then the foundation properties, if 

desired, can be redefined. 

 

File Menu–"Save foundation properties" command 

Saves the active foundation properties under the available name 

 

File Menu–"Save foundation properties as" command 

Saves the active foundation properties under a new name 

 

File Menu–"Close foundation properties" command 

Closes the Foundation properties-embedded program and returns to ELPLA-Data  

 

5.11.2 View Menu (See paragraph 5.3.2) 
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5.11.3 Graphically Menu 

 

The menu "Graphically" contains the following commands: 

 

- Undo 

- Redo 

- Select elements 

- Element groups 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Select elements" command 

The main function of the command is to provide a method to define the element properties. 

When the command is chosen, the cursor is changed from an arrow to a cross hair. The desired 

elements are selected by selecting a group of elements or click by Mouse on each element 

individually. A group of elements can be selected by holding the left mouse button down at the 

corner of the region and dragging the mouse until a rectangle encompasses the desired group of 

elements. When the left mouse button is released, all elements in the rectangle are selected. 

 

Graphically Menu–"Element groups" command 

When "Element groups" command is chosen, the following Dialog box in Figure C-103 appears. 

In this Dialog box define the group No..  

 

 
Figure C-103 Defining group No. 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.11.4 In table Menu 

 

The menu "In table" contains the following commands: 

 

- Element groups 

- Group regions 

 

In table Menu–"Element groups" command 

When "Element groups" command is chosen, the following Dialog box in Figure C-104 appears. 

In this Dialog box E-Modulus of the slab, Poisson’s ratio of the slab and slab thickness are 

defined. Element group is a group that has the same thickness and material. 
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Figure C-104 "Defining element groups" Dialog box 

 

In table Menu–"Group regions" command 

By the program ELPLA there are two alternative possibilities to define group regions 

graphically or numerically (in a table). If it is required to define the group regions in a table, the 

user must choose "Group regions" command from In table Menu. When "Group regions" 

command is chosen, the following Dialog box in Figure C-105 appears. Here the element groups 

of the elements are defined. 

 

 
Figure C-105 "Group regions" Dialog box 

 

5.11.5 Foundation (Slab) properties Menu 

 

The menu "Foundation properties" contains the following commands: 

 

- Unit weight of the foundation 

- Foundation depth 

- Origin coordinates 

- Foundation level from a fixed datum 

 

Foundation properties Menu–"Unit weight of the foundation" command 

When the command is chosen, the following Dialog box in Figure C-106 appears. To consider 

the self-weight of the slab in the analysis, define the unit weight of the slab material. 
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Figure C-106 "Unit weight of the foundation" Dialog box 

 

Foundation properties Menu–"Foundation depth" command 

When "Foundation depth" command is chosen, the following Dialog box in Figure C-107 

appears.  

 

 
Figure C-107 "Foundation depth" Dialog box 

 

In ELPLA, there are three different possibilities to define the slab thickness: 

 

- Slab thickness is constant for the entire slab. In this case there is only one group, Figure 

C-108 

 

- Variable slab thickness with constant foundation level, Figure C-109 

 

- Variable slab thickness with variable foundation level, Figure C-110 

 

 
 

d =1.00 m 

Tf = 2.0 m 

Ground surface 

 
Figure C-108 The slab thickness d is constant for the entire slab 
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Ground surface 

 
Figure C-109 Variable slab thickness with constant foundation level 

 

 

0.50 

0.70 0.90 1.00 m Tk = 1.5 m 

Ground surface 

 
Figure C-110 Variable slab thickness with variable foundation level 

 

In the Dialog box of Figure C-107 define the foundation depth under the ground surface Tf, if 

the foundation level is constant or define the depth of the slab surface under the ground surface 

Tk, if the foundation level is variable. 

 

Foundation properties Menu–"Origin coordinates" command 

By analysis of a system of slab foundations or study the effect of neighboring foundations, every 

slab is defined in a global system through the origin coordinates xo, yo and angle o between the 

x-axes of global and local systems. 

 

When "Origin coordinates" command is chosen, the following Dialog box in Figure C-112 

appears. In this Dialog box define the origin coordinates xo, yo and angle βo between the x-axes 

of global and local systems. 

 

Note 

In the analysis of an isolated slab without consideration of neighboring foundations, the origin 

coordinates play no roles in the analysis. 
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Figure C-111 Geometrical plan by studding the influence of slab k on the slab i 

 

 
Figure C-112 "Origin coordinates" Dialog box 

 

Foundation properties Menu–"Foundation level from a fixed datum" command 

Sometimes, when determining the influence of the neighboring slabs or the interaction of a 

system of slabs, the slabs are constructed with variable foundation levels, Figure C-113. This can 

be considered through the command "Foundation level from a fixed datum" as shown in Figure 

C-114. In this case, the foundation levels of the slabs must be related to a specified datum Hm. 

 

 

 



 

 

ELPLA-Data 

 

 

C-83 

Note 

In the analysis of an isolated slab without consideration of neighboring foundations, the levels 

Hm play no roles in the analysis. 

 

 o

i

Stress due to raft i

 D

Fixed datum

Stress due to 
raft k

k
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Figure C-113 Influence of slab k on the slab i 

 

 
Figure C-114 "Foundation level from a fixed datum" Dialog box 

 

5.11.6 Options Menu (See paragraph 5.3.6) 

 

5.11.7 Format Menu (See paragraph 5.3.7) 

 

5.11.8 Window Menu (See paragraph 5.3.8) 

 

5.11.9 Help Menu (See paragraph 5.3.9) 
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5.12 Data Menu–"Reinforcement data" command 

 

The design of the slab for flexure moment and punching shear can be carried out according to 

the design codes EC 2, DIN 1045, ACI and ECP (working stress and limit state design methods). 

When "Reinforcement data" command is chosen, the following Dialog box in Figure C-115 

appears. In this Dialog box define design code, concrete grade, steel grade and concrete covers. 

 

 
Figure C-115 "Reinforcement" dialog box 

 

5.13 Data Menu–"Boring fields" command 

 

If the subsoil under the slab foundation is characterized by more than one boring, the variation in 

the subsoil in the three directions must be taken into consideration according to ELPLA-Theory. 

By the "Boring fields" command the boring fields can be defined. It is also possible to define the 

boring fields graphically, which makes the definition of the boring fields very easy, or 

numerically (in a table). When the "Boring fields" command is chosen, the following embedded 

program appears, Figure C-116. 
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Figure C-116 "Boring fields" embedded program 

 

The menu head of Figure C-116 contains the following nine commands: 

 

- File 

- View 

- Graphically  

- In table 

- Boring fields 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the nine commands (options) other sub-commands or options become 

available. The following paragraph presents and describes the nine menu commands and their 

sub-commands. 

 

5.13.1 File Menu 

 

This menu contains five commands: 

 

- New boring fields 

- Open boring fields 

- Save boring fields 

- Save boring fields as 

- Close boring fields 
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File Menu–"New boring fields" command 

Defines new boring fields 

 

File Menu–"Open boring fields" command 

Opens existing boring fields-file again. Then the boring fields, if desired, can be redefined. 

 

File Menu–"Save boring fields" command 

Saves the active boring fields under the available name 

 

File Menu–"Save boring fields as" command 

Saves the active boring fields under a new name 

 

File Menu–"Close boring fields" command 

Closes the boring fields-embedded program and returns to ELPLA-Data  

 

5.13.2 View Menu (See paragraph 5.3.2) 

 

5.13.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Select nodes 

- Zone type I 

- Zone type II 

- Zone type III 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Select nodes" command 

The main function of "Select nodes" command is to provide a method for defining the nodes of 

Zone type III. Soil properties for nodes lying in this zone are defined according to a specified 

boring by the user. Zone type III contains also the nodes that are outside the zones I and II.  

 

When "Select nodes" command is chosen, the cursor is changed from an arrow to a cross hair. In 

this case, "Zone type I" and also "Zone type II" will be disabled. The desired nodes are selected 

by clicking on each node individually or selecting a group of nodes. A group of nodes can be 

selected by holding the left mouse button down at the corner of the region and dragging the 

mouse until a rectangle encompasses the desired group of nodes. When the left mouse button is 

released, all nodes in the rectangle are selected. 
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Graphically Menu–"Zone type I" command 

Zone type I is defined as a triangular region; such a region is confined by three boring logs. The 

flexibility coefficient or the modulus of subgrade reaction for a node that lies at a triangular 

region, can be obtained through interpolation among the three values of the parameters of these 

three boring logs. 

 

When "Zone type I" command is chosen, the cursor is changed from an arrow to a cross hair. 

The desired triangular region of Zone type I is selected by clicking on the three borings that 

confine it, Figure C-117. 

 

 
Figure C-117 Zone type I 

 

Graphically Menu–"Zone type II" command 

Zone type II is a region that is confined by one or more sides of the foundation and two borings. 

The flexibility coefficient or the modulus of subgrade reaction for a node in this region may be 

obtained by assuming a linear interpolation between the values of the parameters of these two 

boring logs. 

 

When "Zone type II" command is chosen, the cursor is changed from an arrow to a cross hair. 

The desired region of Zone type II is selected by clicking on the two borings that confine it, then 

clicking on any point inside that region, Figure C-118. 
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Figure C-118 Zone type II 

 

Graphically Menu–"Zone type III" command 

When "Zone type III" command is chosen, the following Dialog box of Figure C-119 appears to 

define the boring of the selected nodes. 

 

 
Figure C-119 "Definition of boring fields" Dialog box 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.13.4 In table Menu 

 

This menu contains the following commands: 

 

- Zone type I 

- Zone type II 

- Zone type III 
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In table Menu–"Zone type I" command 

When the "Zone type I" command is chosen, the following Dialog box appears. In the Dialog 

box of Figure C-120 each region of Zone type I is defined by the three borings that confine it. 

 

 
Figure C-120 "Zone type I" Dialog box 

 

In table Menu–"Zone type II" command 

When the "Zone type II" command is chosen, the following Dialog box appears, Figure C-121. 

In this Dialog box each region of Zone type II is defined by the two borings that confine it as 

well as a corner of the foundation lies inside it. The corner of the foundation can be described as 

follows: 

 

- Corner No. 1: bottom left corner of the foundation 

- Corner No. 2:  bottom right corner of the foundation 

- Corner No. 3:  top left corner of the foundation 

- Corner No. 4: top right corner of the foundation 

 

 
Figure C-121 "Zone type II" Dialog box 

 

In table Menu–"Zone type III" command 

When the "Zone type III" command is chosen, the following Dialog box appears. In the Dialog 

box of Figure C-122 define the borings of nodes that are not considered in Zone type I or II. 
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Figure C-122 "Zone type III" Dialog box 

 

5.13.5 Boring fields Menu 

 

Using the Boring fields Menu allows the user to choose one of the three different possibilities to 

determine the boring fields. This menu contains the following command: 

 

- Interpolation method 

- Subarea method 

- Hand-Division of boring logs to nodes 

 

Boring fields Menu–"Interpolation method" command 

Interpolation method is an accurate one to determine the three-dimensional flexibility coefficient 

or variable modulus of subgrade reaction for arbitrary foundation on irregular subsoil. The 

"Interpolation method" command allows the user to define the interpolation zones I and II, and 

also Zone type III automatically. When the "Interpolation method" command is chosen, the 

following Figure C-123 appears. 
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Figure C-123 Boring locations and region types by Interpolation method 

 

Boring fields Menu–"Subarea method" command 

In the Subarea method the entire foundation area is divided into subareas. Each subarea is 

corresponding to one of the boring logs. This method may be used if there is a little difference in 

soil properties of boring logs. The "Subarea method" command allows the user to define the 

subareas automatically. When the command is chosen, the following Figure C-124 appears. 
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Figure C-124 Boring locations and subareas by Subarea method 

 

Boring fields Menu–"Hand-Division of boring logs to nodes" command 

This command allows the user to define the zone types I, II, III graphically by using the 

commands of Graphically Menu or manually through In table Menu. 

 

5.13.6 Options Menu (See paragraph 5.3.6) 

 

5.13.7 Format Menu (See paragraph 5.3.7) 

 

5.13.8 Window Menu (See paragraph 5.3.8) 

 

5.13.9 Help Menu (See paragraph 5.3.9) 

 

Numbering of borings 

To determine the subareas or the interpolation zones automatically by ELPLA, the boring No. 1 

must be always a central position for the other borings, if the subsoil is characterized through 

more than three borings. Figure C-125 to C-129 show five borings defining the subsoil under a 

raft. It can be carried out different arrangements of interpolation zones using the above role. 

Another arrangement for the boring numbering may cause some errors. In this case, the Hand-

Division of the boring logs to the nodes by the user must be used. 
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B1

B5

B4

B3

B2

 
Figure C-125 Division of interpolation zones (numbering of boring a) 

B1

B4

B3

B2

B5

 
Figure C-126 Division of interpolation zones (numbering of boring b) 
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Figure C-127 Division of interpolation zones (numbering of boring c) 
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B2

B3

B5

B4

 
Figure C-128 Division of interpolation zones (numbering of boring d) 
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B1

B2

B5

B4

B3

 
Figure C-129 Division of interpolation zones (numbering of boring e) 

 

5.14 Data Menu–"Loads" command 

 

By the "Loads" command the loads on the slab such as point loads, line loads, distributed loads 

or moments at any position independently on the FE-Net are defined. When this command is 

chosen, the following embedded program appears, Figure C-130. 

 

 
Figure C-130 "Loads" embedded program 
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The menu head of Figure C-130 contains the following nine commands: 

 

- File 

- View 

- Graphically 

- In table 

- Using formula 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the nine commands (options) other sub-commands or options become 

available. The nine menu commands and their sub-commands are presented and described in the 

following paragraphs. 

 

5.14.1 File Menu 

 

This menu contains five commands: 

 

- New loads 

- Open loads 

- Save loads 

- Save loads as 

- Close loads  

 

File Menu–"New loads" command 

Defines new loads 

 

File Menu–"Open loads" command 

Opens existing load file again on the screen. Then the loads, if desired, can be redefined. 

 

File Menu–"Save loads" command 

Saves the active loads under the available name 

 

File Menu–"Save loads as" command 

Saves the active loads under a new name 

 

File Menu–"Close loads" command 

Closes the loads-embedded program and returns to ELPLA-Data  

 

5.14.2 View Menu (See paragraph 5.3.2) 
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5.14.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Point loads 

- Moments Mx 

- Moments My 

- Line loads 

- Line moments 

- Distributed loads (Polygon) 

- Distributed loads (Rectangle) 

- Remove loads 

- Edit loads 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Point loads" command 

By the "Point loads" command the vertical concentrated loads can be defined at any position (x, 

y). The position of the load is independent on the FE-Net. When "Point loads" command is 

chosen, the cursor is changed from an arrow to a cross hair. Then, the load can be defined by 

clicking on the screen (slab). When the screen is clicked, the following Dialog box of Figure C-

131 appears and the following data is required to define: 

 

- Column type 

- Load value 

- Position of the load (x, y) in the local coordinates 
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Figure C-131 "Point loads P" Dialog box 

 

Graphically Menu–"Moments Mx" command 

By this command the applied moment about x-axis can be defined at any position (x, y). The 

position of applied moment is independent on the FE-Net. When the command is chosen, the 

cursor is changed from an arrow to a cross hair. Then, the moment can be defined by clicking on 

the screen. When the screen is clicked, the following Dialog box of Figure C-132 appears and 

the following data is required to define: 

 

- Moment value 

- Position of the moment (x, y) in the local coordinates 

 

 
Figure C-132 "Moments Mx" Dialog box 
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Graphically Menu–"Moments My" command 

By the "Moments My" command the applied moment about y-axis can be defined at any position 

(x, y). The position of applied moment is independent on the FE-Net. When "Moments My" 

command is chosen, the cursor is changed from an arrow to a cross hair. Then, the moment can 

be defined by clicking on the screen. When the screen is clicked, the following Dialog box of 

Figure C-133 appears and the following data is required to define: 

 

- Moment value 

- Position of the moment (x, y) in the local coordinates 

 

 
Figure C-133 "Moments My" Dialog box 

 

Graphically Menu–"Line loads" command 

By the "Line loads" command the applied load per Meter can be defined at any position from 

point (x1, y1) to point (x2, y2). The position of the applied load is independent on the FE-Net. 

When "Line loads" command is chosen, the cursor is changed from an arrow to a cross hair. 

Then, the line load can be defined by clicking on the starting point of the line load. As the cursor 

is moved, a black line appears; indicating a line load is being defined. When the ending point is 

clicked, the following Dialog box of Figure C-134 appears and the following data is required to 

define: 

 

- Values of start and end points of the load 

- Position of starting the line load (x1, y1) in the local coordinates 

- Position of ending the line load (x2, y2) in the local coordinates 
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Figure C-134 "Line loads pl" Dialog box 

 

Graphically Menu–"Line moments" command 

By the "Line moments" command the applied moment can be defined at any position from point 

(x1, y1) to point (x2, y2). The position of the applied moment is independent on the FE-Net. 

When "Line moments" command is chosen, the cursor is changed from an arrow to a cross hair. 

Then, the line moment can be defined by clicking on the starting point of the line moment. As 

the cursor is moved, a black line appears; indicating a line moment is being defined. When the 

ending point is clicked, the following Dialog box of Figure C-135 appears and the following data 

is required to define: 

 

- Values of start and end points of the moment 

- Position of starting the line moment (x1, y1) in the local coordinates 

- Position of ending the line moment (x2, y2) in the local coordinates 
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Figure C-135 "Line moments Ml" Dialog box 

 

Graphically Menu–"Distributed loads (Polygon)" command 

By this command the applied load per Meter square can be defined for a polygon load. The 

position of the applied load is independent on the FE-Net. When this command is chosen, the 

cursor is changed from an arrow to a cross hair. To define a polygon load, click the polygon 

corners by Mouse to define the polygon. When double-click by Mouse on the last corner of the 

polygon, the following Dialog box of Figure C-136 appears and the following data is required to 

define: 

 

- Load intensity at corners 

- Corners position of the polygon 

 

 
Figure C-136 "Distributed loads p" Dialog box 
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Graphically Menu–"Distributed loads (Rectangle)" command 

By this command the applied load per Meter square can be defined at any diagonal position (x1, 

y1) to (x2, y2). The position of the applied load is independent on the FE-Net. When "Distributed 

loads (Rectangle)" command is chosen, the cursor is changed from an arrow to a cross hair. 

Then, the load can be defined by holding the left mouse button down at the starting point of the 

distributed load. As the mouse is dragged, a box appears, indicating a distributed load is being 

defined. When the left mouse button is released, the following Dialog box of Figure C-137 

appears and the following data is required to define: 

 

- Distributed load value 

- Position of the starting point (x1, y1) in the local coordinates 

- Position of the ending point (x2, y2) in the local coordinates 

 

 
Figure C-137 "Distributed loads (Rectangle)" Dialog box 

 

Graphically Menu–"Remove loads" command 

The main function of "Remove loads" command is to provide a method for deleting loads. When 

the command is chosen, the cursor changes from an arrow to a cross hair. Then, the desired loads 

can be removed by double clicking on each load individually. 

 

Graphically Menu–"Edit Loads" command 

The main function of this command is to provide a method for redefine or editing loads. When 

"Edit loads" command is chosen, the cursor changes from an arrow to a cross hair. Then, the 

desired loads can be selected by double clicking on each load individually. 

 

Note 

If the snap to grid option in "Grid" Dialog box is checked, the cursor will snap to a grid point 

each time the screen is clicked at a point. 

 

Graphically Menu–"Cartesian grid" command 
(See paragraph 5.3.3) 
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5.14.4 In table Menu 

 

This menu contains the following commands: 

 

- Distributing the point load 

- Column type 

- Point loads 

- Moments Mx 

- Moments My 

- Line loads 

- Line moments 

- Distributed loads (Polygon) 

- Distributed loads (Rectangular) 

 

In table Menu –"Distributing the point load" command 

Point load never applied in realty. If a point load represents a column load on a mesh of refine 

finite elements, the moment under the column will be higher than the real moment. To take the 

effect of the load distribution through the slab thickness, the column load must be distributed 

outward at 45 [°] from the column face until reaching the center line of the slab. To convert the 

point load to an equivalent uniform load over an appropriate area, check the “Distribute column 

load” check box in the Dialog box of Figure C-138. 

 

 
Figure C-138 Distributing the column point load over an appropriate area 

 

In table Menu–"Column types" command 

When the command is chosen, the following Table in Figure C-139 appears to define the column 

dimensions. Column dimensions are required for design of the slab for punching shear. 
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Figure C-139 Defining column dimensions 

 

In table Menu –"Point loads" command 

In the Dialog box of Figure C-140 the external point load P at the position (x, y) is defined. The 

coordinates for the input load are related to the left bottom corner of the corresponding slab 

(local coordinates). 

 

 
Figure C-140 "Point loads P" Dialog box 

 

In table Menu–"Moments Mx" command 

In the Dialog box of Figure C-141 the external moment Mx at the position (x, y) is defined. The 

coordinates for the input moment Mx are related to the left bottom corner of the corresponding 

slab (local coordinates). 
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Figure C-141 "Moments Mx" Dialog box 

 

In table Menu–"Moments My" command 

In the Dialog box of Figure C-142 the external moment My at the position (x, y) is defined. The 

coordinates for the input moment My are related to the left bottom corner of the corresponding 

slab (local coordinates). 

 

 
Figure C-142 "Moments My" Dialog box 

 

In table Menu–"Line loads" command 

In the Dialog box of Figure C-143 the external line load pl from the position (x1, y1) to (x2, y2) is 

defined. The coordinates for the input line load pl are related to the left bottom corner of the 

corresponding slab (local coordinates). 
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Figure C-143 "Line loads pl" Dialog box 

 

In table Menu–"Line moments" command 

In the Dialog box of Figure C-144 the external line moment Ml from the position (x1, y1) to (x2, 

y2) is defined. The coordinates for the input line moment Ml are related to the left bottom corner 

of the corresponding slab (local coordinates). 

 

 
Figure C-144 "Line moments Ml" Dialog box 

 

In table Menu–"Distributed loads (Polygon)" command 

When "Distributed loads (Polygon)" command is chosen, the Dialog box of Figure C-136 

appears to define load intensity at corners and corners position of the polygon. 

 

In table Menu–"Distributed loads (Rectangle)" command 

In the Dialog box of Figure C-145 the external distributed load p from the diagonal position (x1, 

y1) to (x2, y2) is defined. The coordinates for the input distributed load p are related to the left 

bottom corner of the corresponding slab (local coordinates). 
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Figure C-145 "Distributed loads p" Dialog box 

 

Note 

If an element loaded area is overlap over another, the last input loaded area will be the valid one. 

 

5.14.5 Using formula Menu 

 

This menu contains the following commands: 

 

- Point loads 

- Moments Mx 

- Moments My 

- Line loads 

- Line moments 

- Distributed loads (Polygon) 

- Distributed loads (Rectangle) 

 

Using formula–"Point loads" command 

This option is used to modify the load values through formula for existing load data. The option 

also may use to modify the load positions through formula in order to control the eccentricities 

ex and ey, Figure C-146. 

 

 
Figure C-146 "Load values using formula" Dialog box 
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Line loads, moments and distributed loads may be also modified independently using formula in 

the dialog box of Figure C-146. 

 

5.14.6 Options Menu (See paragraph 5.3.6) 

 

5.14.7 Format Menu (See paragraph 5.3.7) 

 

5.14.8 Window Menu (See paragraph 5.3.8) 

 

5.14.9 Help Menu (See paragraph 5.3.9) 

 

5.15 Data Menu–"Neighboring foundations" command 

 

To take the effect of neighboring foundations on the slab, the filenames for projects of 

neighboring foundations are required. In the Dialog box of Figure C-147 the filenames for 

projects of neighboring foundations can be defined. 

 

 
Figure C-147 "Neighboring foundations" Dialog box 

 

5.16 Data Menu–"Temperature change" command 

 

To take the effect of temperature change on the slab, the temperature difference Td and the 

coefficient of thermal expansion of the slab material are required in Figure C-148. Temperature 

difference Td occurs between the upper and lower surface of the slab foundation. If Td is 0 that 

means no temperature effect will occur. A positive Td means the temperature above the slab is 

greater than that under the slab. According to German Standard DIN 1045, the coefficient of 

thermal expansion of the concrete slab  = 0.00001 [1/°C]. 

 

 
Figure C-148 "Data of temperature change" Dialog box 
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5.17 Data Menu–"Additional settlements" command 

 

By this command additional settlements on the slab can be defined. It is also possible to define 

the additional settlements graphically, which makes the definition of the additional settlements 

very easy, or numerically (in a table). When the "Additional settlements" command is chosen, 

the following embedded program appears (Figure C-149). 

 

 
Figure C-149 "Additional settlements" embedded program 

 

The menu head of Figure C-149 contains the following eight commands: 

 

- File 

- View 

- Graphically  

- In table 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the eight commands (options) other sub-commands or options become 

available. The following paragraph presents and describes the eight menu commands and their 

sub-commands. 
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5.17.1 File Menu 

 

This menu contains five commands: 

 

- New additional settlements 

- Open additional settlements 

- Save additional settlements 

- Save additional settlements as 

- Close additional settlements 

 

File Menu–"New additional settlements" command 

Defines new additional settlements 

 

File Menu–"Open additional settlements" command 

Opens existing additional settlements-file again on the screen. Then the additional settlements, if 

desired, can be redefined. 

 

File Menu–"Save additional settlements" command 

Saves the active additional settlements under the available name 

 

File Menu–"Save additional settlements as" command 

Saves the active additional settlements under a new name 

 

File Menu–"Close additional settlements" command 

Closes the additional settlements-embedded program and returns to ELPLA-Data  

 

5.17.2 View Menu (See paragraph 5.3.2) 

 

5.17.3 Graphically Menu 

 

This menu contains the following commands: 

 

- Undo 

- Redo 

- Select nodes 

- Remove additional settlements 

- Add additional settlements 

- Cartesian grid 

 

Graphically Menu–"Undo" command 

This command is used to undo the effects of a selected command and return to a previous state. 

 

Graphically Menu–"Redo" command 

This command is used to redo the last action of "Undo" command. 

 

Graphically Menu–"Select nodes" command 

The main function of "Select nodes" command is to provide a method for removing or adding 

additional settlement on nodes. When "Select nodes" command is chosen, the cursor is changed 

from an arrow to a cross hair. In this case, "Add additional settlements" and also "Remove 

additional settlements" will be enabled, indicating the modes in which are being operated. The 
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desired nodes are selected by clicking on each node individually or selecting a group of nodes. A 

group of nodes can be selected by holding the left mouse button down at the corner of the region 

and dragging the mouse until a rectangle encompasses the desired group of nodes. When the left 

mouse button is released, all nodes in the rectangle are selected. 

 

Graphically Menu–“Remove additional settlements” command 

The command is used to make the selected nodes free from additional settlements. 

 

Graphically Menu–"Add additional settlements" command 

This command is used to define the settlement value for the selected nodes. Any old additional 

settlements of the selected nodes will be replaced by the new editing. When this command is 

chosen, the following Dialog box of Figure C-150 appears to define the additional settlement. 

 

 
Figure C-150 "Add additional settlements" Dialog box 

 

Graphically Menu–"Cartesian grid" command 

See paragraph 5.3.3 

 

5.17.4 In table Menu 

 

This menu contains the following command: 

 

- Additional settlements 

 

In table Menu–"Additional settlements" command 

When the "Additional settlements" command is chosen, the following Dialog box appears. In 

this Dialog box (Figure C-151) define the additional settlement si at node i. 

 

 
Figure C-151 Defining additional settlements in a table 
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5.17.5 Options Menu (See paragraph 5.3.6) 

 

5.17.6 Format Menu (See paragraph 5.3.7 
 

5.17.7 Window Menu (See paragraph 5.3.8) 
 

5.17.8 Help Menu (See paragraph 5.3.9) 

 

 

6 View Menu (See paragraph 5.3.2) 

 

 

7 Main Data Menu 

 

The Main Data Menu has the following commands: 

 

- Firm header 

- Directory of data 

- Preferences 

- Help language setting 

- System of units 

- Number formats 

- Design code parameters 

 

7.1 Main Data–"Firm header" command 

 

The "Firm header" is two lines text to give information about your firm, company, institute or 

office, Figure C-152. The information is printed as headers at the top of the pages, which contain 

the tables of data and results that created by ELPLA-List. The information is also printed at the 

identification box for graphical drawings of data and results created by ELPLA-Graphic, 

ELPLA-Sections and ELPLA-Boring. 

 

 
Figure C-152 "Firm header" Dialog box 

 

7.2 Main Data–"Directory of data" command 

 

Instead of storing hundreds of project files, the files of input data, intermediate results or final 

results for a project can optionally be stored automatically in one compressed file. This makes it 

easier to send projects to other persons or to simply manage your own files. It also reduces the 

amount of disk space required to store all of your data files. The compressed file is ZIP-

compatible, allowing you to manually extract the data files using WinZip or other data 

compression tools if you wish. 



 

 

ELPLA-Data 

 

 

C-113 

In the Dialog box of Figure C-153 specify which directory is used as default directory for files 

that are saved or opened by ELPLA. Also, check the files to be compressed. 

 

 
Figure C-153 "Directory of data" Dialog box 

 

7.3 Main Data–"Preferences" command 

 

In the Dialog box of Figure C-154 define the FE-Net and calculation of internal force 

preferences. To improve the distribution of the internal forces on the FE-Net, two possibilities 

for determining internal forces are available: 

 

1. The internal forces are determined firstly at the element centers, and then distributed to the           

element nodes (recommended for triangular elements) 

 

2. The internal forces are determined directly at the element nodes (recommended for 

rectangular elements) 

 

 
Figure C-154 "Preferences" Dialog box 
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7.4 Main Data–"Help language setting" command 

 

It can define the language of the help system used in ELPLA applications (Figure C-155). The 

three languages are English, German and Arabic. 

 

 
Figure C-155 "Help language setting" Dialog box 

 

7.5 Main Data–"System of unit" command 

 

It is possible to set different unit systems such as SI-system or English-system without changing 

the real value of any previously defined data, Figure C-156. 

 

 
Figure C-156 "System of units" Dialog box 

 

7.6 Main Data–"Number formats" command 

 

By the "Number formats" command the user can choose, how the numbers of results and data 

are listed or printed, Figure C-157. 

 

The following examples describe the number formats: 

 

Number = 5459.3472 

Format "0.000"  gives 5459.347 

Format "0.00"  gives 5459.35 

Format "0.0"   gives 5459.4 

Format "0"  gives 5459 

Format "00E+00"  gives 55E+02     (Exponential format) 
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Figure C-157 "Number formats" Dialog box 

 

7.7 Main data–"Design code parameters" command 

 

The design of the slab for flexure moment and punching shear can be carried out according to 

the following design codes: 

 

- EC 2  

European Committee for Standardization, Design of Concrete Structures - Eurocode 2 

 

- DIN 1045  

German Institute for Standardization, Design and Construction of Reinforced Concrete 

 

- ACI  

American Concrete Institute Building Code Requirements for Structural Concrete 

 

- ECP 

Egyptian Code of Practice for Design and Construction of Reinforced Concrete 

Structures 

 

In the menu of Figure C-158 the design code parameters may be redefined if desired. Also, the 

minimum reinforcements of tension and compression steel are defined. 

 

 
Figure C-158 "Design code parameters" Dialog box 
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8 Help Menu (See paragraph 5.3.9) 

 

 

9 Tips and Tricks 

9.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table C-5 to Table C-19: 

 

Table C-5 Shortcut keys of menu head 

Shortcut keys Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+f]     "FE-Net Generation" 

[Alt+i]     "In Table" 

[Alt+g]     "Graphically" 

[Alt+d]     "Data" 

[Alt+m]     "Main data" 

[Alt+a]     "Foundation properties" 

[Alt+b]     "Boring fields" 

[Alt+u]     "Using formula" 

[Alt+o]     "Option" 

[Alt+f]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table C-6 Shortcut keys of File-Command for embedded programs 

Shortcut keys Action 

[Ctrl+n] or [Alt+f] then [n]  Calling command  "New ***" 

[Ctrl+o] or [Alt+f] then [o]    "Open ***" 

[Alt+f] then [s]     "Save ***" 

[Alt+f] then [a]     "Save  *** as" 

[Ctrl+q] or [Alt+f] then [c]     "Close  ***" 

[Alt+f] then [l]     "File list" 

[Alt+f] then [1] Calling the first project from the last four defined projects 

[Alt+f] then [2]  Calling the second project from the last four defined projects 

[Alt+f] then [3]  Calling the third project from the last four defined projects 

[Alt+f] then [4]  Calling the fourth project from the last four defined projects 

[Ctrl+q] or [Alt+f] then [x] Calling command  "Exit" 

The asterisks (***) matches any of the embedded program name or the word “project”. 
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Table C-7 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b] Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [f]    "Tool bars-FE-Net" 

[Alt+v] then [t], then [e]    "Tool bars-Edit" 

[Alt+v] then [t], then [g]    "Tool bars-Graphically" 

[Alt+v] then [t], then [d]    "Tool bars-Data" 

[Alt+v] then [t], then [m]    "Tool bars-Main data" 

[Alt+v] then [t], then [g]    "Tool bars-Girders" 

[Alt+v] then [t], then [s]    "Tool bars-Spring supports" 

[Alt+v] then [t], then [s]    "Tool bars-Supports/ Boundary  

   conditions" 

[Alt+v] then [t], then [p]    "Tool bars-Piles" 

[Alt+v] then [t], then [z]    "Tool bars-Net of soil elements in z- 

   direction" 

[Alt+v] then [t], then [a]    "Tool bars-Foundation properties" 

[Alt+v] then [t], then [b]    "Tool bars-Boring fields" 

[Alt+v] then [t], then [l]    "Tool bars-Loads" 

[Alt+v] then [t], then [a]    "Tool bars-Additional settlements" 

[Alt+v] then [t], then [o]    "Tool bars-Option" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Tool bars-Reset Toolbar" 
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Table C-8 Shortcut keys of FE-Net Generation-Command 

Shortcut keys Action 

[Alt+n] then [g] Calling command  "Generation type" 

[Alt+n] then [n]    "New generation" 

[Alt+n] then [f]    "Generating FE-Net" 

[Alt+n] then [s]    "Smoothing mesh" 

[Alt+n] then [b]    "Directing border elements" 

[Alt+n] then [r]    "Refining mesh" 

 

Table C-9 Shortcut keys of Graphically-Command for embedded programs 

Shortcut keys Action 

[Alt+g] then [r] Calling command  "Undo" 

[Alt+g] then [r]    "Redo" 

[Alt+g] then [r]    "Remove girders, spring supports,  

   boundaries, piles or loads" 

[Alt+g] then [a]    "Add nodes, girders, spring supports, 

   boundaries or piles" 

[Alt+g] then [e]    "Edit node, girders or loads" 

[Alt+g] then [s]    "Select nodes, elements" 

[Alt+g] then [m]    "Slab corner by Mouse" 

[Alt+g] then [a]    "Add opening" 

[Alt+g] then [p]    "Add reference points" 

[Alt+g] then [l]    "Add reference lines" 

[Alt+g] then [o]    "Boring logs" 

[Alt+g] then [z]    "Zone type I" 

[Alt+g] then [o]    "Zone type II" 

[Alt+g] then [n]    "Zone type III" 

[Alt+g] then [p]     "Point loads" 

[Alt+g] then [x]     "Moments Mx" 

[Alt+g] then [y]     "Moments My" 

[Alt+g] then [l]     "Line loads" 

[Alt+g] then [m]     "Line moments" 

[Alt+g] then [d]    "Distributed loads (Polygon)" 

[Alt+g] then [t]    "Distributed loads (Rectangle)" 

[Alt+g] then [c]     "Cartesian grid" 
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Table C-10 Shortcut keys of In table-Command for embedded programs 

Shortcut keys  Action 

[Alt+i] then [c]  Calling command  "Column types" 

[Alt+i] then [l]    "Distributing the point load" 

[Alt+i] then [n]    "Net of finite elements" 

[Alt+i] then [g]     "Girder groups" 

[Alt+i] then [d]     "Girders" 

[Alt+i] then [t]     "Spring supports" 

[Alt+i] then [n]     "Node restraints" 

[Alt+i] then [e]     "Element groups" 

[Alt+i] then [r]     "Pile groups" 

[Alt+i] then [p]     "Pile locations and groups" 

[Alt+i] then [m]     "Pile material" 

[Alt+i] then [g]     "Group regions" 

[Alt+i] then [z]     "Zone type I" 

[Alt+i] then [o]     "Zone type II" 

[Alt+i] then [n]     "Zone type III" 

[Alt+i] then [p]     "Point loads" 

[Alt+i] then [x]     "Moments Mx" 

[Alt+i] then [y]     "Moments My" 

[Alt+i] then [l]     "Line loads" 

[Alt+i] then [m]     "Line moments" 

[Alt+i] then [d]     "Distributed loads (Polygon)" 

[Alt+i] then [t]     "Distributed loads (Rectangle)" 

[Alt+i] then [s]     "Additional settlements" 
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Table C-11 Shortcut keys of Data-Command 

Shortcut keys Action 

[Alt+d] then [s] Calling command  "Soil data" 

[Alt+d] then [o]    "Main soil data" 

[Alt+d] then [c]    "Calculation methods" 

[Alt+d] then [p]    "Project identification" 

[Alt+d] then [f]    "FE-Net data" 

[Alt+d] then [g]    "Girders" 

[Alt+d] then [t]    "Spring supports" 

[Alt+d] then [u]    "Supports/ Boundary conditions" 

[Alt+d] then [p]    "Piles" 

[Alt+d] then [i]    "Soil properties" 

[Alt+d] then [z]    "Net of soil elements in z-direction" 

[Alt+d] then [h]    "Limit depth" 

[Alt+d] then [a]    "Foundation (or slab) properties" 

[Alt+d] then [r]    "Reinforcement data" 

[Alt+d] then [b]    "Boring fields" 

[Alt+d] then [l]    "Loads" 

[Alt+d] then [n]    "Neighboring foundations" 

[Alt+d] then [t]    "Temperature change" 

[Alt+d] then [s]    "Additional settlements" 

[Alt+d] then [f]    "Filenames of slab foundations" 

 

Table C-12 Shortcut keys of Main data-Command for ELPLA-Data und the embedded 

program Soil properties 

Shortcut keys Action 

[Alt+m] then [f] Calling command  "Firm header" 

[Alt+m] then [d]    "Directory of data" 

[Alt+m] then [n]    "Number formats" 

[Alt+m] then [p]    "Preferences" 

[Alt+m] then [h]    "Help language setting" 

[Alt+m] then [s]    "System of units" 

[Alt+m] then [r]    "Design code parameters" 
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Table C-13 Shortcut keys of Foundation properties-Command for the embedded program 

Foundation properties 

Shortcut keys Action 

[Alt+a] then [u] Calling command  "Unit weight of the foundation" 

[Alt+a] then [f]    "Foundation depth" 

[Alt+a] then [o]    "Origin coordinates" 

[Alt+a] then [f]    "Foundation level from fixed datum" 

 

Table C-14 Shortcut keys of Boring fields-Command for the embedded program Boring fields 

Shortcut keys Action 

[Alt+ b] then [i] Calling command  "Interpolation method" 

[Alt+ b] then [s]    "Subarea method" 

[Alt+ b] then [h]    "Hand-Division of borings to nodes" 

 

Table C-15 Shortcut keys of Using formula-Command for the embedded program loads 

Shortcut keys Action 

[Alt+u] then [p]  Calling command  "Point loads" 

[Alt+u] then [x]     "Moments Mx" 

[Alt+u] then [y]     "Moments My" 

[Alt+u] then [l]     "Line loads" 

[Alt+i] then [m]     "Line moments" 

[Alt+u] then [d]    "Distributed loads (Polygon)" 

[Alt+u] then [t]     "Distributed loads (Rectangle)" 

 

Table C-16 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [d]     "Display values" 

[Alt+o] then [v]     "View grouping" 
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Table C-17 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+t] then [i]     "Fill color"  

[Alt+t] then [x]     "Max. ordinate"  

[Alt+t] then [f]     "Font"  

[Alt+t] then [g]     "Grid" 

 

Table C-18 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out"  

[Alt+w] then [w]     "Zoom window"  

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 

 

Table C-19 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "New in ELPLA" 

[Alt+h] then [n]    "Short description of ELPLA" 

[Alt+h] then [a]     "About ELPLA-Data" 

 

9.2 Mouse 

 

By clicking the right mouse Button on the screen, the user can also obtain the Popup-Main data-

Menu, Figure C-159. 
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Figure C-159 Menu "Popup-Main data" 

 

By clicking the right mouse Button on the screen for one of the embedded programs, the user 

can also obtain the Popup-Options-Menu, Figure C-160. 

 

 
Figure C-160 Menu "Popup-Options" 
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1 An Overview of ELPLA-Solver  

 

When project data were defined and stored, ELPLA-Solver can carry out many calculations and 

finally solve the system of linear equations. The calculation steps, which are carried out by 

ELPLA-Solver, can be listed as follows: 

 

  1 Assembling the load vector 

  2 Preparing the calculation 

  3 Determining the ultimate bearing capacity 

  4 Determining the limit depth 

  5 Determining the modulus of subgrade reaction 

  6 Determining flexibility coefficients of piles 

  7 Determining flexibility coefficients of the soil 

  8 Determining flexibility coefficients for system of rafts 

  9 Assembling the soil stiffness matrix 

10 Influence of neighboring foundations on settlements 

11 Influence of the temperature change on raft 

12 Influence of additional settlements on raft 

13 Assembling the girder stiffness matrix 

14 Assembling the slab stiffness matrix 

15 Solving the system of linear equations 

16 Iteration process 

17 Analysis of the rigid raft 

18 Analysis of the flexible foundation 

19 Performing the nonlinear analysis 

20 Performing the nonlinear analysis of piled raft foundation 

21 Determining deformation, internal forces, contact pressures 

22 Design of the slab 

23 Determining displacements, stresses and strains in soil 

24 Analysis of the plane frame 

25 Analysis of the plane stress 

26 Computation of all 

  

All results are saved as ASCII-format in separate files and can therefore be read with any text 

editor. The file format is straightforward so that an interface for any self-developed or 

commercial package can be easily used. 

 

 

2 Description of ELPLA-Solver 

 

ELPLA-Solver is a 32-bit, analysis and design software product that operates under Microsoft 

Windows 9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows 

applications makes it easy to learn how to use ELPLA-Solver, especially if you are already 

familiar with the Windows environment. 

 

ELPLA package consists of 7 separate programs. The programs can run independently. The 

name and short description of the seven separate programs are given in Table D-1. 
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The usage of ELPLA is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed by using ELPLA-Solver. Finally, 

the results can be presented as graphical drawing, graphs and tables using 5 separate programs 

ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor.  

 

Table D-1 Names and descriptions of the 7 separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                        Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               Simple word processing program 

 

In order to use ELPLA-Solver, first the user must define the project data by ELPLA-Data. Table 

D-2 gives a list of files, which are read or created by ELPLA-Solver. The files can be classified 

in four groups. 

 

Table D-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Project data files                      ELPLA-Data 

C    Intermediate result files            ELPLA-Solver  

D    Final result files                           ELPLA-Solver 

 

Further more, Table D-3 shows filenames, contents and groups of all files that may be read or 

created by ELPLA-Solver. 

 

Table D-3 Names and contents of files 

 

A Main data files 

Filename    Contents  

FIRMA    Firm header 

STEU                        Default directory for files that are saved by ELPLA 

NOFORMAT             Number formats 

RFT     Design code parameters 

UNITS     System of units 

PREFEREN.DAT   FE-Net and calculation preferences 
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B Project data files 

Filename  Contents 

* .PO1          System data (Analysis of isolated raft) 

* .PO2          System data (Analysis of system of rafts) 

*. BAU        Soil properties 

*. LDH      Data of the limit depth  

*. PC1         Load data for slab and grid 

*. PCF         Load data for plane frame 

*. PCW        Load data for plane stress 

*. PL6       Node coordinates and element connectivity 

*. PL8       Slab boundary 

*. GL1       Girder data (Part 1) 

*. GL2       Girder data (Part 2) 

*. P21         Data of slab properties/ levels/ coordinates 

*. P23         Reinforcement data 

*. P31        Data of supports/ boundary conditions for slab and grid 

*. P61        Data of supports/ boundary conditions for plane frame 

*. P71        Data of supports/ boundary conditions for plane stress 

*. P35       Data of spring supports for slab and grid 

*. P81       Data of spring supports for plane frame 

*. P91       Data of spring supports for plane stress 

*. P41        File of boring fields 

*. PT1        Data of temperature change 

*. PP1        File of neighboring foundations 

*. PV1       Data of additional soil settlements 

*. DSS   Net of soil elements in z-direction 

*. PIL       Data of piles 
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C Intermediate result files 

Filename  Contents 

*. PL3   Indicators for old/ new nodes 

*. PL4    Area around nodes 

*. PL5                         Node type and node art 

*. PL7                       Element areas 

*. PL9                       Node coordinates, element types and element groups 

*. PC3             Groundwater pressure on the raft 

*. PC4              Overburden pressure 

*. PC5                       Load vector  (Part 1) 

*. PC6              Load vector  (Part 2) 

*. PC7   Foundation properties 

*. PC8   Average contact pressure, eccentricity and area of slab 

*. PC9                       Coordinates of element centers 

*. P33   Vector of supports/ boundary conditions 

*. PI1   Vector of contact pressures (Iteration method) 

*. PI2   Flexibility band matrix (Iteration method) 

*. PT2      Load vector due to temperature change 

*. PP2       Load vector due to neighboring foundations 

*. QUB  Main ultimate bearing capacity (qb) 

*. PW2  Main moduli of subgrade reactions (kb) 

*. GF1  Girder stiffness matrix 

*. PE1      Soil stiffness matrix 

*. PE2  Load vector due to reloading 

*. PD1                      Flexibility soil matrix for loading for raft 

*. PD2                       Flexibility soil matrix for reloading for raft 

*ji. PD3  Flexibility coefficients of raft j due to contact pressures of raft i 

*. FP1                     Flexibility soil matrix due to end bearing of piles for loading 

*. FP2                       Flexibility soil matrix due to end bearing of piles for reloading 

*. FP3                     Flexibility soil matrix due to skin friction of piles for loading 

*. FP4                       Flexibility soil matrix due to skin friction of piles for reloading 

*. FP5                       Stiffness vector of piles 

*. PF1             Slab stiffness matrix 

*. PF2   Load vector from special cases 

*. PG1   Deformation vector  (w, x, y) 

*. PS1   Deformations of the rigid raft (wo, tan xo, tan xo) 
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D Final result files 

Filename  Contents 

*. PT3        Displacements due to temperature change (st) 

*. PP3        Settlements due to neighboring foundations (se) 

*. PV2       Load vector due to additional settlements 

*. LD1       Limit depth 

*. GH1       Internal forces of girders 

*. QUN      Ultimate bearing capacities at nodes (qul) 

*. PW1       Modulus of subgrade reaction (ks) 

*. PH1        Settlements (s) 

*. PH2        Contact pressures (q) 

*. PH3        Moments (mx) 

*. PH4        Moments (my) 

*. PH5        Moments (mxy) 

*. PH6        Shear forces (Qx) 

*. PH7        Shear forces (Qy) 

*. PH8        Settlements due to reloading (sw) 

*. PH9        Overburden pressures (Qu) 

*. H10      Support reactions (V) 

*. H11      Support reactions (My) 

*. H12      Support reactions (Mx) 

*. H13      Reinforcement of the slab (Asx1) 

*. H14      Reinforcement of the slab (Asx2) 

*. H15      Reinforcement of the slab (Asy1) 

*. H16      Reinforcement of the slab (Asy2) 

*. THX      Rotations about x-axis (θx) 

*. THY      Rotations about y-axis (θy) 

*. THZ      Rotations about z-axis (θz) 

*.U_X      X-Displacements in soil (u) 

*.V_Y      Y-Displacements in soil (v) 

*.W_Z      Z-Displacements in soil (w=s) 

*.S_X      X-Stresses in soil (σx) 

*.S_Y      Y-Stresses in soil (σy) 

*.S_Z      Z-Stresses in soil (σz) 

*.TXY      XY-Shear stresses in soil (τxy) 

*.TXZ      XZ-Shear stresses in soil (τxz) 

*.TYZ      YZ-Shear stresses in soil (τyz) 

*.VAX      X-Strains in soil (εx) 

*.VAY      Y-Strains in soil (εy) 

*.VAZ                        Z-Strains in soil (εz) 

*.VXY      XY-Shear strains in soil (γxy) 

*.VXZ      XZ-Shear strains in soil (γxz) 

*.VYZ      YZ-Shear strains in soil (γyz) 

*. PPU      Punching results 

*. FP6                       Settlement vector of piles 

*. PEI                          Pile loads and displacements 

The asterisk (*) matches any filename with the specified extension. 

 

Next paragraphs describe the purpose and function of each ELPLA-Solver command. 
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3 Starting ELPLA-Solver 

 

Start ELPLA-Solver by clicking on the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure D-1) appears. 

 

 
Figure D-1 Introduction screen of the program ELPLA-Solver 

 

The menu head of Figure D-1 contains the following four commands: 

 

- File 

- Calculation 

- View 

- Help 

 

After clicking one of the four menu commands other sub-commands or options become 

available. The four menu commands and their sub-commands are presented and described in the 

following paragraphs 4 to 8. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu–"Open" command 

 

By clicking "Open" command the current project is closed, if one is loaded, and an existing 

project is opened. Figure D-2 shows "Open" Dialog box used to open a specified project. 

 

ELPLA is used to analyze not only an isolated raft but also a system of rafts. Therefore the 

program can read two types of file names. One has the extension PO1, which represents the 

isolated raft and the other has the extension PO2, which represents the system of rafts. 

 

 
Figure D-2 "Open project" Dialog box 

 

4.2 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

 

4.3 File Menu–"Exit" command 

 

Here the current project is closed and ELPLA-Solver is quitted, Figure D-3. 

 

 
Figure D-3 "Exit" Message box 

 

 

5 Calculation Menu 

 

The Calculation Menu is the main menu, which is used to carry out the problem analysis. The 

Calculation Menu commands are: 

 

- Assembling the load vector 

- Preparing the calculation 

- Determining the ultimate bearing capacity 

- Determining the limit depth 

- Determining the modulus of subgrade reaction 

- Determining flexibility coefficients of piles 

- Determining flexibility coefficients of the soil 
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- Determining flexibility coefficients for system of rafts 

- Assembling the soil stiffness matrix 

- Influence of neighboring foundations on settlements 

- Influence of the temperature change on raft 

- Influence of additional settlements on raft 

- Assembling the girder stiffness matrix 

- Assembling the slab stiffness matrix 

- Solving the system of linear equations 

- Iteration process 

- Analysis of the rigid raft 

- Analysis of the flexible foundation 

- Performing the nonlinear analysis 

- Performing the nonlinear analysis of piled raft foundation 

- Determining deformation, internal forces, contact pressures 

- Design of the slab 

- Determining displacements, stresses and strains in soil 

- Analysis of the plane frame 

- Analysis of the plane stress 

- Computation of all 

 

5.1 Calculation Menu–"Assembling the load vector" command  

 

By "Assembling the load vector" command the load vector is assembled for all calculation 

methods. When this command is chosen, "Foundation properties" list box appears as shown in 

Figure D-4. 

 

 
Figure D-4 "Foundation properties" list box 

 

Overburden pressure and groundwater pressure can be also displayed and edited. Clicking 

"Overburden pressure" and "Groundwater pressure" Buttons can edit these pressures. Figure D-5 

shows the Dialog box that appears when "Overburden pressure" Button is clicked. In this Dialog 

box the overburden pressure can be edited. 
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Figure D-5 "Overburden pressures" Dialog box 

 

5.2 Calculation Menu–"Preparing the calculation" command  

 

By "Preparing the calculation" command the optimization of band width is carried out and the 

load vector is assembled for plane frame and plane stress analyses. 

 

5.3 Calculation Menu–"Determining the ultimate bearing capacity" command 

 

By "Determining the ultimate bearing capacity" command determining the ultimate bearing 

capacity is carried out. When clicking this option, the program calculates the ultimate bearing 

capacity and the following menu in Figure D-6 appears. In this menu the main ultimate bearing 

capacity qb of each boring is displayed. In the menu of Figure D-6 the ultimate bearing 

capacities of borings can be redefined, if desired. By clicking the Button "OK", the main 

ultimate bearing capacities are considered. After that the program calculates the ultimate bearing 

capacities qul at all nodes through interpolation or according to the subareas method whenever is 

applicable (Figure D-7). In the menu of Figure D-7 the ultimate bearing capacities qul at nodes 

are displayed and can be redefined, if desired. 

 

 
Figure D-6 Main ultimate bearing capacities of borings qb 
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Figure D-7 Ultimate bearing capacities at nodes qul 

 

5.4 Calculation Menu–"Determining the limit depth" command  

 

By "Determining the limit depth" command the limit depth for the soil layers is determined for 

layered soil model. 

 

5.5 Calculation Menu–"Determining the modulus of subgrade reaction" command 

 

By "Determining the modulus of subgrade reaction" command determining the modulus of 

subgrade reaction is carried out for the following calculation methods: 

 

- Constant modulus of subgrade reaction (method 2) 

- Variable modulus of subgrade reaction (method 3) 

 

The methods for determining the modulus of subgrade reaction are: 

 

- Modulus is defined by the user 

- Modulus is calculated from isotropic elastic half-space soil medium 

- Modulus is calculated from layered soil medium 

 

When clicking this option, the program calculates the modulus of subgrade reaction. Then the 

following menu (Figure D-8) appears. In this menu the average modulus of subgrade reaction 

ksm of each borings is displayed. In the menu of Figure D-8 the average moduli of subgrade 

reactions for borings can be redefined, if desired. By clicking the Button "OK", the average 

moduli of subgrade reactions are considered. After that, the program calculates the moduli of 

subgrade reactions ks at all nodes through interpolation or according to the subareas method, 

Figure D-9. In the menu of Figure D-9 the moduli of subgrade reactions ks at nodes can be 

redefined, if desired. 
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Figure D-8 Average modulus of subgrade reactions of boring ksm 

 

 
Figure D-9 Modulus of subgrade reactions at node ks 

 

5.6 Calculation Menu–"Determining flexibility coefficients of piles" command 

 

By this command assembling the flexibility matrix of piles is carried out. 

 

5.7 Calculation Menu–"Determining flexibility coefficients" command 

 

By "Determining flexibility coefficients" command assembling the flexibility matrix is carried 

out for the following calculation methods: 

 

- Modification of modulus of subgrade reaction by iteration (method 4) 

- Modulus of compressibility (half-space, method 5) 

- Modulus of compressibility (Iteration, method 6) 

- Modulus of compressibility (Elimination, method 7) 

- Rigid raft (method 8) 

- Flexible foundation (method 9) 

 

5.8 Calculation Menu–"Determining flexibility coefficients for system of rafts"    

command 

 

By "Determining flexibility coefficients for system of rafts" command assembling the flexibility 

matrix for system of slab foundations is carried out. 
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5.9 Calculation Menu–"Assembling the soil stiffness matrix" command 

 

By this command the soil stiffness matrix is carried out for the following calculation methods: 

 

- Modulus of compressibility (half-space, method 5) 

- Modulus of compressibility (Iteration, method 6) 

- Modulus of compressibility (Elimination, method 7) 

- Rigid raft (method 8) 

 

5.10 Calculation Menu–"Influence of neighboring foundations on settlements" command 

 

By "Influence of neighboring foundations on settlements" command determining the settlements 

due to influence of neighboring foundations is carried out for the following calculation methods: 

 

- Modification of modulus of subgrade reaction by iteration (method 4) 

- Modulus of compressibility (half-space, method 5) 

- Modulus of compressibility (Iteration, method 6) 

- Modulus of compressibility (Elimination, method 7) 

- Rigid raft (method 8) 

- Flexible foundation (method 9) 

 

5.11 Calculation Menu–"Influence of the temperature change on raft" command 

 

Determining displacements due to temperature change is carried out. 

 

5.12 Calculation Menu–"Influence of additional settlements on raft" command  

 

Determining the influence of additional settlements is carried out. 

 

5.13 Calculation Menu–"Assembling the girder stiffness matrix" command 

 

Assembling the girder stiffness matrix is carried out when girders are in the slab. 

 

5.14 Calculation Menu–"Assembling the slab stiffness matrix" command 

 

Assembling the slab stiffness matrix is carried out for the following calculation methods: 

 

- Linear contact pressure (method 1) 

- Constant modulus of subgrade reaction (method 2) 

- Variable modulus of subgrade reaction (method 3) 

- Modulus of compressibility (half-space, method 5) 

- Modulus of compressibility (Elimination, method 7) 
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5.15 Calculation Menu –"Solving the system of linear equations" command 

 

Solving the system of linear equations is carried out for the following methods: 

 

- Linear contact pressure (method 1) 

- Constant modulus of subgrade reaction (method 2) 

- Variable modulus of subgrade reaction (method 3)  

- Modulus of compressibility (half-space, method 5) 

- Modulus of compressibility (Elimination, method 7) 

 

5.16 Calculation Menu–"Iteration process" command 

 

When choosing the command "Iteration process", the iteration process for analyzing the isolated 

raft (methods 4, 6) or system of rafts is carried out. 

 

Iteration parameters 

The iteration process continues until one of the following conditions is met (Figure D-10): 

 

-  The accuracy number reaches to the specified tolerance, which means that a sufficient 

compatibility between the raft deflection and the soil settlement is reached in the slab-soil 

interface 

 

-  The iteration process reaches the specified steps of iterations 

 

An accuracy number controls the convergence progress of the solution. The solution is 

considered convergent if the accuracy number of the step I + 1 is less than that of the previous 

step i. The maximum difference between the soil settlement and the raft deflection in [m] is 

considered as an accuracy number.  

 

In the menu of Figure D-10 select the option of the iteration condition. Then click "OK" Button. 

 

 
Figure D-10 "Iteration parameters" selection box 

 

Iteration Process 

The menu of Figure D-11 displays information about the convergence progress of the solution 

during the iteration process. 

 

- The iteration processing can be halted at any step by clicking "Stop" Button 

- A pause is possible at any step by clicking "Pause" Button. Then "Pause" Button changes 

to "Continue" Button 

- To continue the iteration processing, click "Continue" Button 
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Figure D-11 Menu "Iteration process" 

 

5.17 Calculation Menu–"Analysis of the rigid raft" command  

 

By this command performing the analysis of the rigid raft is carried out (method 8). 

 

5.18 Calculation Menu–"Analysis of the flexible foundation" command  

 

By "Analysis of the flexible foundation" command performing the analysis of the flexible 

foundation is carried out (method 9). 

 

Negative contact pressures 

If a negative value of contact pressure appears (Figure D-12), it indicates tension at the soil raft 

interface. Since the soil cannot resist tensile forces at the contact surface, a separation occurs 

between the raft and the soil. An iterative procedure is used to eliminate the negative contact 

pressures. To eliminate negative contact pressures, click "Yes" Button in the menu of Figure D-

12. 

 

 
Figure D-12 Menu "Negative contact pressures" 
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5.19 Calculation Menu–"Performing the nonlinear analysis" command  

 

The nonlinear analysis for methods 2 to 8 is carried out. 

 

5.20 Calculation Menu–"Performing the nonlinear analysis of piled raft foundation" 

command  

 

Here performing the nonlinear analysis of piled raft foundation is carried out. 

 

5.21 Calculation Menu–"Determining deformation, internal forces, contact pressures" 

command 

 

When clicking this command, the program calculates the settlements, contact pressures, 

deformation, rotations, moments and shear forces. By the rigid raft the program calculates only 

the settlements (= displacement), rotations and contact pressures, while by the flexible 

foundation, the program calculates only the settlements. 

 

Check of the solution 

After determining internal forces and deformation, a check of the solution by comparison 

between the values of actions and reactions is carried out for all calculation methods. Through 

this comparative examination, the calculation accuracy is determined, Figure D-13. 

 

 
Figure D-13 Menu "Check of the solution" 

 

5.22 Calculation Menu–"Design of the slab" command  

 

By "Design of the slab" command the reinforcement of the slab is determined and a check of 

punching stress due to column loads, pile reactions and support reactions are carried out for 

calculation methods 1 to 7. 

 

5.23 Calculation Menu–"Determining displacements, stresses and strains in soil" 

command 

 

By this command determining displacements, stresses and strains in soil is carried out. 

 

5.24 Calculation Menu–"Analysis of the plane frame" command 

 

By "Analysis of the plane frame" command analyzing plane frame is carried out. 
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5.25 Calculation Menu–"Analysis of the plane stress" command  

 

By "Analysis of the plane stress" command analyzing plane stress is carried out. 

 

5.26 Calculation Menu–"Computation of all" command 

 

The progress of all computations according to the defined method is carried out. 

 

Different computations are carried out for each method. At the start of the calculation and only 

by the iteration methods you are asked whether accuracy or iteration No. is to be used for ending 

the iteration cycles (Figure D-10). Table D-4 shows an overview of the individual calculations 

for different methods. 

 

Table D-4 Overview of the individual calculations for different methods  

Calculation Numerical calculation method 

 1 2 3 4 5 6 7 8 9 10 

Assembling the load vector  

Determining the ultimate bearing capacity 

Determining the limit depth 

Determining the modulus of subgrade 

Determining flexibility coefficients of piles 

Determining flexibility coefficients 

Determining flexibility coefficients for system of rafts 

Assembling the soil stiffness matrix 

Influence of neighboring foundations on settlements 

Influence of the temperature change on raft 

Influence of additional settlements on raft  

Assembling the girder stiffness matrix 

Assembling the slab stiffness matrix 

Solving system equations (full matrix) 

Solving system equations (banded matrix) 

Analysis of the rigid raft 

Analysis of the flexible foundation 

Iteration process 

Performing the nonlinear analysis 

Performing the nonlinear analysis of piled raft foundation 

Determining def., internal forces and contact pressures 

Determining deformation and contact pressures 

Design of the slab 

Determining displacements, stresses and strains in soil 

Computation of all 

x 

- 

- 

- 

- 

- 

- 

- 

- 

- 

- 

x 

x 

- 

x 

- 

- 

- 

- 
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x 
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x 

x 

x 

 

* Only by the two especial cases of influence of neighboring foundations on settlements 

and influence of the temperature change on the raft 
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The numerical calculation methods in the last 10 cells of Table D-4 are: 

 

a) Analysis of isolated raft 

 

1 Linear contact pressure 

2 Constant modulus of subgrade reaction 

3 Variable modulus of subgrade reaction 

4 Modification of modulus of subgrade reaction by iteration 

5 Modulus of compressibility (half-space) 

6 Modulus of compressibility (Iteration) 

7 Modulus of compressibility (Elimination) 

8 Rigid raft 

9 Flexible foundation 

 

b) Analysis of system of rafts 

 

10 Analysis of system of many flexible, rigid and elastic rafts 

 

 

6 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 

 

6.1 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of calculation. 

 

6.2 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

7 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Solver 

 

7.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure D-14. 
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Figure D-14 Menu "Contents" 

 

7.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

7.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

7.4 Help Menu–"About ELPLA-Solver" command 

 

Clicking the command "About ELPLA-Solver" displays the information form of ELPLA-Solver 

as shown in Figure D-15, which gives information about ELPLA-Solver and the calculation 

method of the loaded project. 
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Figure D-15 Information form of ELPLA-Solver 

 

 

8 Tips and Tricks 

8.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table D-5 to Table D-9: 

 

Table D-5 Shortcut keys of menu head 

Shortcut keys Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+c]     "Calculation" 

[Alt+h]     "Help" 

 

Table D-6 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [1]  Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command  "Exit" 
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Table D-7 Shortcut keys of Calculation-Command  

Shortcut keys  Action 

[Alt+c] then [t]  Calling command  "Assembling the load vector" 

[Alt+c] then [p]    "Preparing the calculation" 

[Alt+c] then [m]     "Determining the ultimate bearing capacity" 

[Alt+c] then [z]     "Determining the limit depth" 

[Alt+c] then [m]    "Determining the modulus of subgrade reaction" 

[Alt+c] then [f]    "Determining flexibility coefficients of piles" 

[Alt+c] then [f]    "Determining flexibility coefficients" 

[Alt+c] then [x]    "Determining flexibility coefficients for system of 

   rafts" 

[Alt+c] then [l]    "Assembling the soil stiffness matrix" 

[Alt+c] then [e]    "Influence of neighboring foundations on  

   settlements" 

[Alt+c] then [i]    "Influence of the temperature change on raft" 

[Alt+c] then [u]    "Influence of additional settlements on raft" 

[Alt+c] then [g]    "Assembling the girder stiffness matrix" 

[Alt+c] then [b]    "Assembling the slab stiffness matrix" 

[Alt+c] then [s]    "Solving the system of linear equations" 

[Alt+c] then [s]    "Solving the rigid raft" 

[Alt+c] then [s]    "Solving the flexible foundation" 

[Alt+c] then [t]    "Iteration process" 

[Alt+c] then [n]    "Performing the nonlinear analysis" 

[Alt+c] then [n]    "Performing the nonlinear analysis of piled raft 

   foundation" 

[Alt+c] then [d]    "Determining deformation, internal forces, contact 

   pressures" 

[Alt+c] then [r]    "Design of the slab" 

[Alt+c] then [d]    "Determining displacements, stresses and strains in 

   soil" 

[Alt+c] then [a]    "Analysis of the plane frame" 

[Alt+c] then [a]    "Analysis of the plane stress" 

[Alt+c] then [c]    "Computation of all" 
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Table D-8 Shortcut keys of View-Command 

Shortcut keys  Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then[t], then [f]    "Tool bars-File" 

[Alt+v] then[t], then [c]    "Tool bars-Calculation" 

[Alt+v] then[t], then [h]    "Tool bars-Help" 

[Alt+v] then[t], then [r]    "Tool bars-Reset Toolbar" 

 

Table D-9 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "Short description of ELPLA" 

[Alt+h] then [n]    "New in ELPLA" 

[Alt+h] then [a]     "About ELPLA-Solver" 

 

8.2 Mouse 

 

By clicking the right mouse Button on the screen, the user can also obtain the Popup-

Calculation-Menu (Figure D-16). 

 

 
Figure D-16 Menu "Popup-Calculation" 
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1 An overview of ELPLA-Graphic 

 

ELPLA-Graphic is used to display graphically the calculated results and input project data. The 

drawing of the results and data can be displayed first on the screen, and then can be sent to the 

printer or plotter. The calculated results and input project data can be presented graphically as 

follows: 

 

- Results in isometric view 

- Results as contour lines 

- Result values in the plan 

- Distribution curves of results in the plan 

- Results as circular diagrams 

- Deformation 

- Principal moments as streaks 

- Support reactions as arrows 

- Soil deformation as vectors 

- Soil deformation as deformed mesh 

- Principal soil stresses as streaks 

- Principal soil strains as streaks 

- Data in isometric view 

- Data in the plan 

- Boring locations 

- Boring logs/ Limit depth 

- Punching shear 

- Beam results 

 

The drawings, if desired, can be saved as WMF-format files, in which they can be exported to 

other Windows applications to prepare reports, slide presentations or add further information. 

 

 

2 Description of ELPLA-Graphic 

 

ELPLA-Graphic is a 32-bit, graphical software product that operates under Microsoft Windows 

9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows applications makes it 

easy to learn how to use ELPLA-Graphic, especially if you are already familiar with the 

Windows environment. The program package ELPLA consists of 7 separate programs. These 

programs can run independently. The name and short description of the seven separate programs 

are given in Table E-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed by using ELPLA-Solver. Finally, 

the results can be presented as graphical drawing, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor.  
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Table E-1 Names and descriptions of the 7 separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

In order to use ELPLA-Graphic, first the user must define the project data by ELPLA-Data, and 

then must analyze the problem by ELPLA-Solver. Table E-2 gives a list of files, which are read 

or created by ELPLA-Graphic. The files can be classified in four groups. 

Table E-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Graphic files (*.GRA)              ELPLA-Graphic 

C    Project data files                      ELPLA-Data 

D    Final result files                           ELPLA-Solver 

 

Further more, Table E-3 shows the filenames, contents and groups of all files that may be read or 

created by ELPLA-Graphic. 

Table E-3 Names and contents of files 

 

A Main data files 

Filename    Contents  

FIRMA    Firm header 

STEU                        Default directory for files that are saved by ELPLA 

NOFORMAT             Number formats  

UNITS     System of units 

 

B Graphic files 

Filename           Contents 

LINEFORM.GRA        Line formats 

FONT.GRA                                     Font data 

LEGENDE.GRA                         Legend data 

PAINT.GRA                          Fill color data 

PLOTPAR.GRA                         Plot parameters 

NODISPLA.GRA                             Data of display values 

ORDINATE.GRA                            Max. ordinate data 
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C Project data files 

Filename  Contents 

*. AUF        3 lines text to identify the project 

* .PO1          System data (calculation method-isolated slab) 

* .PO2          System data (calculation method-system of slabs) 

*. P23         Reinforcement data 

*. P33        Data of supports/ boundary conditions 

*. P35       Data of spring supports 

*. P81       Data of spring supports for plane frame 

*. P91       Data of spring supports for plane stress 

*. P61        Data of supports/ boundary conditions for plane frame 

*. P71        Data of supports/ boundary conditions for plane stress 

*. P31        Data of supports/ boundary conditions for slab and grid 

* .BAU               Soil data 

*. PC1                         Load data  

*. PCF         Load data for plane frame 

*. PCW        Load data for plane stress 

*. PL6              FE-Net data 

*. PL4    Area around nodes 

*. GL1       Girder data  

*. P21               Data of material/ slab thickness/ levels/ coordinates 

*. P41                          File of boring fields 

*. PP1                          File of external foundations 

*. PV1       Data of additional soil settlements 

*. DSS      FE-Net in z-direction 

*. PIL       Pile properties 
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D Final result files 

Filename  Contents 

*. GH1       Internal forces of girders 

*. PT3        Displacements due to temperature change (st) 

*. PP3        Settlements due to neighboring foundations (se) 

*. QUN      Ultimate bearing capacities at nodes (qul) 

*. PW1       Modulus of subgrade reaction (ks) 

*. PH1        Settlements (s) 

*. PH2        Contact pressures (q) 

*. PH3        Moments (mx) 

*. PH4        Moments (my) 

*. PH5        Moments (mxy) 

*. PH6        Shear forces (Qx) 

*. PH7        Shear forces (Qy) 

*. H10      Support reactions (V) 

*. H11      Support reactions (My) 

*. H12      Support reactions (Mx) 

*. H13      Reinforcement of the slab  (Asx1) 

*. H14      Reinforcement of the slab  (Asx2) 

*. H15      Reinforcement of the slab  (Asy1) 

*. H16      Reinforcement of the slab  (Asy2) 

*.U_X      X-Displacements in soil (u)             

*.V_Y      Y-Displacements in soil (v)           

*.W_Z      Z-Displacements in soil (w=s)          

*.S_X      X-Stresses in soil (σx) 

*.S_Y      Y-Stresses in soil (σy) 

*.S_Z      Z-Stresses in soil (σz)            

*.TXY      XY-Shear stresses in soil (τxy)  

*.TXZ      XZ-Shear stresses in soil (τxz) 

*.TYZ      YZ-Shear stresses in soil (τyz) 

*.VAX      X-Strains in soil (εx) 

*.VAY      Y-Strains in soil (εy) 

*.VAZ                        Z-Strains in soil (εz) 

*.VXY      XY-Shear strains in soil (γxy) 

*.VXZ      XZ-Shear strains in soil (γxz)            

*.VYZ      YZ-Shear strains in soil (γyz) 

*. PPU      Punching results 

The asterisk (*) matches any filename with the specified extension. 

 

Next paragraphs describe the purpose and function of each ELPLA-Graphic command. 

 

 

3 Starting ELPLA-Graphic 

 

Start ELPLA-Graphic by clicking on the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure E-1) appears.  
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Figure E-1 Introduction screen of ELPLA-Graphic 

 

The menu head of Figure E-1 contains the following seven commands: 

 

- File 

- View 

- Graphic 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the seven menu commands, other sub-commands or options become 

available. The seven menu commands and their sub-commands are presented and described in 

the following paragraphs 4 to 11. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Make WMF-File 

- Send to ELPLA-Section 

- Print 

- Page setup 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu–"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure E-2 shows "Open" Dialog box used to open a specified project.  

 

ELPLA is used to analyze not only isolated slab foundation but also system of rafts. Therefore 

the program can read two types of file names. One has the extension of PO1, which represents 

the isolated raft and the other has the extension of PO2, which represents the system of rafts. 

 

 
Figure E-2 "Open project" Dialog box 

 

4.2 File Menu–"Make WMF-File" command 

 

The drawing can be saved in a format that can be read by other programs. This feature allows 

you to include your drawing in reports and presentations and to enhance the drawing using other 

drawing or CAD software packages. The drawing can be exported in the Windows Metafile 

format (WMF). Figure E-3 shows "Save as" Dialog box used to export the drawing with the 

filename you wish to give the exported file, including extension and the directory in which to 

save the file. 

 

 
Figure E-3 "Save as" Dialog box 

 

4.3 File Menu–"Send to ELPLA-Section" command 

 

By "Send to ELPLA-Section" command it is possible, to define a diagram in ELPLA-Graphic by 

Mouse and end it to ELPLA-Section, Figure E-4. 
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Figure E-4 Defining a diagram in ELPLA-Graphic 

 

4.4 File Menu–"Print" command 

 

By "Print" command data and results can be graphically plotted or printed. Only the objects 

currently displayed on the drawing are printed. Figure E-5 shows "Print" Dialog box. The printer 

group box contains controls for selecting the printer and changing its properties. Use "Name" 

Combo box to select the printer and use "Properties" Button to set printer settings. The number 

of printing copies can be defined in "Copies" Input box, Figure E-5.  

 

 
Figure E-5 "Print" Dialog box 
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4.5 File Menu–"Page setup" command  

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size, and paper source, as well as other printing 

options. Figure E-6 shows "Page setup" Dialog box. 

 

 
Figure E-6 "Page setup" Dialog box 

 

4.6 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

 

4.7 File Menu–"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-Graphic is quitted, Figure E-7. 

 

 
Figure E-7 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 
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5.1 View Menu–"Status bar" command 

 

The status bar displays information about the progress of the current operation. 

 

5.2 View Menu–"Tool bars" command 

 

Tool bars located just below the menu head are displayed with icons of program menus. 

 

 

6 Graphic Menu 

 

The graphic menu is the main menu, used to display the specified drawing with the setting given 

by options, format and window menus. The Graphic Menu commands are: 

 

- Results in isometric view 

- Results as contour lines 

- Result values in the plan 

- Distribution curves of results in the plan 

- Results as circular diagrams 

- Deformation 

- Principal moments as streaks 

- Support reactions as arrows 

- Soil deformation as vectors 

- Soil deformation as deformed mesh 

- Principal soil stresses as streaks 

- Principal soil strains as streaks 

- Data in isometric view 

- Data in the plan 

- Boring locations 

- Boring logs/ Limit depth 

- Punching shear 

- Beam results 

 

6.1 Graphic Menu–"Results in isometric view" command  

 

Calculated results can be displayed on the screen and plotted in isometric shape. In the Dialog 

box of Figure E-8 select an item to draw and click "OK". Figure E-9 shows the contact pressures 

in isometric view. 

 
Figure E-8 "Results in isometric view" items 
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Figure E-9 Contact pressures in isometric view 

 

6.2 Graphic Menu–"Results as contour lines" 

 

By this command the calculated results can be contoured and shaded to reflect the variation of 

results. When "Results as contour lines" command is chosen, the selection Dialog box shown in 

Figure E-10 appears. In this dialog box select an item to draw and then click "OK" Button.  

 

 
Figure E-10 "Results as contour lines" items 

 

Contours with a constant interval 

Contours can be displayed with a constant interval by checking "Contours with a constant 

interval" check box in "Plot parameters" form, Figure E-11. For drawing the contours, the 

minimum and maximum contour values, and also the contour interval are required. As an 

example, Figure E-12 shows the settlements as contours with a constant interval. 
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Figure E-11 "Contour lines parameters" Dialog box 

 

 
Figure E-12 Settlements as contour lines with a constant interval  

 

Contours with a variable interval 

Contours can be displayed with a variable interval by making "Contours with a constant interval" 

check box unchecked in "plot parameters" form, Figure E-41. For drawing the contour lines with 

a variable interval, the contour values are required to define in the form "Contour lines", Figure 

E-13. 
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Figure E-13 "Contours with a variable interval" Dialog box 

 

Color contours 

Contours can be colored and shaded by checking "Color contours" check box in "Plot 

parameters" form, Figure E-41. The number of shaded colors is 13, start at color blue, which 

represents the minimum value and end at color red, which represents the maximum value. The 

lines between shaded contours will be displayed, if "Display lines" check box in "Plot 

parameters" form is checked. As an example, Figure E-14 shows the settlements in color 

contours. 

 

 
Figure E-14 Color contours for settlements 

 

6.3 Graphic Menu–"Result values in the plan" command 

 

The calculated results can be tabulated on the mesh. When this command is chosen, the selection 

Dialog box shown in Figure E-15 appears. Select an item to draw and then click "OK" Button. 

As an example, Figure E-16 shows the values of top reinforcement in x-direction on the mesh. 
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Figure E-15 "Result values in the plan" items 

 

 
Figure E-16 Tabulation of the top reinforcement in x-direction on the mesh 

 

6.4 Graphic Menu–"Distribution curves of results in the plan" command 

 

By "Distribution curves of results in the plan" command the calculated results can be plotted as 

distribution curves on the mesh. When "Distribution curves of results in the plan" command is 

chosen, the selection Dialog box shown in Figure E-17 appears. In this Dialog box select an item 

to draw and then click "OK" Button. As an example, Figure E-18 shows the distribution curves 

of moment mx on the slab. 
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Figure E-17 "Distribution curves of results in the plan" items 

 

 
Figure E-18 Distribution curves of moment mx on the slab 

 

6.5 Graphic Menu–"Results as circular diagrams" command  

 

By this command the calculated results can be plotted as circular diagrams on the mesh. When 

"Results as circular diagrams" command is chosen, the selection Dialog box shown in Figure E-

19 appears. In this Dialog box select an item to draw, then click "OK" Button. As an example, 

Figure E-20 shows the circular diagrams for shear forces Qx. 

 

Color circles 

Circular diagrams can be colored and shaded by checking "Color circles" check box in "Plot 

parameters" form, Figure E-41.  
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Figure E-19 "Results as circular diagrams" items 

 

 
Figure E-20 Circular diagrams for shear forces Qx 

 

6.6 Graphic Menu–"Deformation" command 

 

By "Deformation" command the slab deformation can be displayed as a deformed mesh plot as 

shown in Figure E-21. 
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Figure E-21 Slab deformation 

 

6.7 Graphic Menu–"Principal moments as streaks" command 

 

By "Principal moments as streaks" command the principal moments hm1 and hm2 can be 

displayed as streaks as shown in Figure E-22. 

 

 
Figure E-22 Principal moments as streaks 
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6.8 Graphic Menu–"Support reactions as arrows" command 

 

By "Support reactions as arrows" command the support reactions V, Mx and My can be displayed 

in isometric shape as arrows. When this command is chosen, the selection Dialog box shown in 

Figure E-23 appears. In this Dialog box select an item to draw, then click "OK" Button. As an 

example, Figure E-24 shows the support reactions V as arrows. 

 

 
Figure E-23 "Support reactions as arrows" items 

 

 
Figure E-24 Support reactions V as arrows  

 

6.9 Graphic Menu–"Soil deformation as vectors" command  

 

By "Soil deformation as vectors" command the soil deformation can be displayed as vectors. 

When this command is chosen, the selection Dialog box shown in Figure E-25 appears. In this 

Dialog box select an item to draw, then click "OK" Button. As an example, Figure E-26 shows 

the soil deformation as vectors. 
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Figure E-25 "Soil deformation as vectors" items 

 

 
Figure E-26 Soil deformation as vectors 

 

6.10 Graphic Menu–"Soil deformation as deformed mesh" command  

 

By this command the soil deformation can be displayed as deformed mesh. As an example, 

Figure E-27 shows the soil deformation as deformed mesh. 
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Figure E-27 Soil deformation as deformed mesh 

 

6.11 Graphic Menu–"Principal soil stresses as streaks" command 

 

Here the principal soil stresses can be displayed as streaks. As an example, Figure E-28 shows 

the principal soil stresses as streaks. 

 

 
Figure E-28 Principal soil stresses as streaks 
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6.12 Graphic Menu–"Principal soil strains as streaks" command 

 

By this command the Principal soil strains can be displayed as streaks. As an example, Figure E-

29 shows the principal soil strains as streaks. 

 

 
Figure E-29 Principal soil strains as streaks 

 

6.13 Graphic Menu–"Data in isometric view" command 

 

By "Data in isometric view" command the input data can be displayed on the screen and plotted 

in isometric shape. When "Data in isometric view" command is chosen, the selection Dialog box 

shown in Figure E-30 appears. In this Dialog box select an item to draw, then click "OK" Button. 

As an example, Figure E-31 shows the loading in isometric view. 

 

 
Figure E-30 "Data in isometric view" items 
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Figure E-31 Loading in isometric view 

 

6.14 Graphic Menu–"Data in the plan" command 

 

By "Data in the plan" command the input data can be displayed in the plan view. When "Data in 

the plan" command is chosen, the selection Dialog box shown in Figure E-32 appears. In this 

Dialog box select an item to draw and click "OK" Button. As an example, Figure E-33 shows the 

loading in the plan. 

 

 
Figure E-32 "Data in the plane" items 
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Figure E-33 Loading in the plan 

 

6.15 Graphic Menu–"Boring locations" command 

 

By "Boring locations" command the boring locations in global coordinates can be displayed with 

the slab geometry as shown in Figure E-34.  

 

 
Figure E-34 Location of boring with zone types 
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6.16 Graphic Menu–"Boring logs/ Limit depth" command 

 

Here the boring logs (boring layers, soil material, water table and limit depth) can be displayed 

through ELPLA-Boring as shown in Figure E-35. The stress on soil under a specified point on 

the foundation with effective stress can be also displayed beside the corresponding boring log 

through ELPLA-Boring as shown in Figure E-36. The stress on soil is used to determine the limit 

depth of the soil layers. To get information about ELPLA-Boring, see the User’s Guide of 

ELPLA-Boring. 

 

 
Figure E-35 Boring logs with multi-layers with different soil material 
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Figure E-36 Limit depth of the soil layers 

 

6.17 Graphic Menu–"Beam results" command 

 

In ELPLA the finite element method was used to analyze both of the raft and girders, in which 

the raft was represented by plate bending elements while the girders were represented by grid 

elements. Furthermore, a combination between plate elements and grid elements may be used to 

represent ribbed rafts. If girders are considered in the project, "Beam results" command will 

appear in the graphic menu. 

 

"Beam results" command has the following options (commands): 

 

- Distribution of internal forces in the plan 

- Internal forces in isometric view  

 

"Distribution of internal forces in the plan"–Option 

This option displays the beam internal forces (torsion moments, bending moments and shear 

forces) with the slab geometry in the plan. The selection Dialog box shown in Figure E-37 

appears. In this Dialog box select an item to draw and click "OK" Button. As an example, Figure 

E-38 shows the distribution of bending moments in the plan. 

 

 
Figure E-37 "Distribution of internal forces in the plan" items 
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Figure E-38 Distribution of bending moments in the plan 

 

"Internal forces in isometric view"–Option 

This option displays the beam internal forces (torsion moments, bending moments and shear 

forces) with the slab geometry in isometric view. When "Distribution of internal forces isometric 

view"-Option is chosen, the selection Dialog box shown in Figure E-39 appears. In this Dialog 

box select an item to draw, then click "OK" Button. As an example, Figure E-40 shows the 

distribution of shear forces in isometric view. 

 

 
Figure E-39 "Distribution of internal forces in isometric view" items 
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Figure E-40 Distribution of shear forces in isometric view 

 

 

7 Options Menu 

 

The Options menu has the following commands: 

 

- Plot parameters 

- Display values 

- Scale 

- Set range 

- Axes 

- Title 

- Page No. 

- Copy 

- View grouping 

 

7.1 Options Menu–"Plot parameters" command 

 

Plot parameters may be set as default values by the program or be fully specified by the user. By 

"Plot parameters" command the following plot parameters can be specified (Figure E-41):   

 

- Display FE-Net, Axes, slab dimensions, FE-Net in separated elements, reference points         

and lines, axis arrows 

- Pages with or without a frame 

- Color element groups and slab thickness 

- Color section of punching shear 

- Color girders 
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- Draw girder thickness 

- Color circles of circular diagrams. If "color circles" is checked, the positive circles are red 

and the negative circles are blue 

- Color contours with or without display contour lines. If "color contours" is checked, the 

contours will have 13 constant intervals with 13 colors. Colors start at color blue, which 

represents the minimum value and end at color red representing the maximum value 

- Writing factor. If "Writing factor" is checked, the intensity of numbers on the contour 

lines will be defined 

- Display contours with a constant interval 

- Display boring subareas boundary 

- Color boring subareas 

- Mark boring subareas 

- Draw neighboring foundations 

- Draw block element 

- Draw element border 

- Color solid element 

- Display FE-Net in separated elements 

- Display reference points/ lines 

 

 

Figure E-41 "Plot parameters" Dialog box 

 

7.2 Options Menu–"Display values" command 

 

By "Display values" command the values of the following items can be displayed, if desired, on 

the drawing (Figure E-42): 

 

- Loads 

- Boundary conditions 

- Spring supports 

- Element groups 

- Girder system 

- Piles 

- Internal forces of girders 

- Axes 
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- Support reactions as arrows 

- Slab thickness 

- Isometric views 

- Contour lines 

- Circular diagrams 

- Distribution curves of results 

- Soil deformation as vectors 

- Soil deformation as deformed mesh 

- Punching shear 

- Column types 

 

 
Figure E-42 "Display values" Dialog box 

 

7.3 Options Menu–"Scale" command 

 

By "Scale" command the scale factor of the drawing can be defined as shown in Figure E-43. 

The defaulted value for the scale factor is chosen to pass the active printer-paper format. By 

graphical drawing in the plan the scale is changed to scale factor, "scale factor" = "scale 1: ". 

 

 
Figure E-43 "Scale" Dialog box 

 

7.4 Options Menu–"Set range" command 

 

By "Set range" command the area of the slab, that will be drawn, can be defined. In the Dialog 

box shown in Figure E-44 define ranges, which bound this slab area. 
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Figure E-44 "Set range" Dialog box 

 

7.5 Options Menu–"Axes" command 

 

By "Axes" command scaled axes can be defined on the drawing, Figure E-45. 

 

 
Figure E-45 "Axes" Dialog box 

 

7.6 Options Menu–"Title" command 

 

By "Title" command the text data (two lines text above the drawing and two lines text under the 

drawing) can be defined, Figure E-46. 

 

Default texts are: 

 

- A-Title1: Method No. 

- A-Title2:      Name of method 

- U-Title1:      Name of drawing 

- U-Title2:      No. of nod columns and nod rows that define the drawing 
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Figure E-46 "Title" Dialog box 

 

7.7 Options Menu–"Page No." command 

 

By "Page No." command the page No. can be defined, Figure E-47.  

 

 
Figure E-47 "Page No." Dialog box 

 

7.8 Options Menu–"Copy" command 

 

By "Copy" command the current drawing can be copied in Metafile-Format to Clipboard. Then it 

can be inserted directly to other Windows programs such as Word and AutoCAD, Figure E-48. 

 

 
Figure E-48 Drawing can be copied to other Windows programs 
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7.9 Options Menu–"View grouping" command 

 

Draw a group of data with results or a group of data together in one presentation (contour lines of 

settlements with loads and slab thickness, or loads with boring locations), Figure E-49. 

 

 
Figure E-49 Presentation of a group of data with results 

8 Format Menu 

 

The Format menu has the following commands: 

 

- Line formats  

- Fill color 

- Max. ordinate 

- Font 

- Legend 

 

8.1 Format Menu–"Line formats" command 

 

By "Line formats" command the color, style and thickness of drawing lines can be defined, 

Figure E-50. The way a line is drawn depends on the setting of the color and style properties. 

There are available 15 different colors and 5 styles for line formats. The following list shows the 

available lines, which can be formatted: 

 

- Slab boundary 

- Elements 

- Isometric view 

- Distribution curves of results 

- Contour lines 
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- Legends 

- Circular diagrams 

- Arrows of support reactions 

- Page boundary 

- Identification box  

- Streaks of principal moments (+ve) 

- Streaks of principal moments (-ve)  

- Slab dimensions 

- Loads 

- Boundary conditions 

- Boring logs 

- Slab thickness 

- Axes of symmetry  

- Beam elements 

- Spring supports 

- Axes of symmetry 

- Symbol of symmetry 

- Vectors of soil deformation 

- Deformed mesh of soil deformation 

- Axis arrows 

- Girder axes 

- Piles in plan 

- Pile length 

- Pile hatching 

- Additional settlements 

- Reference points and lines 

- Columns 

- Cartesian grid 

- Punching shear 

- Borders of block elements 

 

 
Figure E-50 "Line formats" Dialog box 

 

8.2 Format Menu–"Fill color" command 

 

By "Fill color" command the fill color of drawing can be defined, Figure E-51. The following list 

shows the available items, which can be filled with a specified color: 
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- Loads 

- Boundary conditions 

- Springs 

- Zone type I: Bilinear interpolation 

- Zone type II: Linear interpolation 

- Zone type III: Node corresponds to boring 

- Circle of boring 

- Additional settlements 

- (+ve) Circular diagrams 

- (-ve) Circular diagrams 

- Punching shear 

- Material No. 

- Girder group No. 

- Sub area of boring No. 

- Pile group No. 

- Column group No. 

 

 
Figure E-51 "Fill color" Dialog box 

 

 

8.3 Format Menu–"Max. ordinate" command 

 

By "Max. ordinate" the max. ordinate, max. diameter, max. side, max. width and max. length for 

the drawing can be defined, Figure E-52. 

 

 
Figure E-52 "Max. ordinate" Dialog box 

 

8.4 Format Menu–"Font" command 

 

By "Font" command the font size (Figure E-53) and font type (Figure E-54) can be defined. 
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Figure E-53 "Font size" Dialog box 

 

 
Figure E-54 "Font type" Dialog box 

 

8.5 Format Menu–"Legend" command 

 

By this command the height and width of legends can be specified as shown in Figure E-55. 

Display legend 

In "Display legend" Group box check the legend that you wish to display. 

 

Legend size 

In "Legend size" Group box the height and width of the legend can be defined.  

 

 
Figure E-55 "Legend" Dialog box 

 

 

9 Window Menu 
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The Window menu has the following commands: 

 

- Zoom in 

- Zoom out  

- Zoom window  

- Zoom % 

- Original size 

- Viewing angle 

 

9.1 Window Menu–"Zoom in" command 

 

By "Zoom in" command the size of the drawing on the screen can be reduced. 

 

9.2 Window Menu–"Zoom out" command 

 

By "Zoom out" command the size of the drawing on the screen can be increased. 

 

9.3 Window Menu–"Zoom window" command 

 

By "Zoom window" command the size of the drawing on a specified area can be increased. 

 

9.4 Window Menu–"Zoom %" command 

 

When you choose "Zoom %" command, the following Dialog box in Figure E-56 appears. 

 

 
Figure E-56 "Zoom %" Dialog box 

 

By "Zoom %" command the size of drawing on the screen can be specified. Choosing "Zoom %" 

allows you to increase or decrease the size at which the drawing is displayed. Choosing 100% 

displays the drawing at its original size. Clicking on the percentage, changes the drawing size to 

the specified percentage. The drawing can be displayed at any size by typing the desired 

percentage in the specified Edit box. 

 

9.5 Window Menu–"Original size" command 

 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using "Original size" command. 

 

9.6 Window Menu–"Viewing angle" command 

 

The perspective drawing in a three dimensional view can be defined, Figure E-57. 
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The default viewing angle for isometric drawing, Figure E-58: 

 

Viewing angle about x-Axis  = 295 

Viewing angle about y-Axis  = 0 

Viewing angle about z-Axis  = 20 

 

The default viewing angle for drawing in the plans: 

 

Viewing angle about x-Axis  = 0 

Viewing angle about y-Axis  = 0 

Viewing angle about z-Axis  = 0 

 

 
Figure E-57 "Viewing angle" Dialog box 
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Figure E-58 Contour lines of settlements with viewing angles 295, 0, and 20 

about the x-, y-, and z-axes, respectively 

 

10 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Graphic 

 

10.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure E-59. 
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Figure E-59 Menu "Contents" 

 

10.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

10.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

10.4 Help Menu–"About ELPLA-Graphic" command 

 

Clicking the command "About ELPLA-Graphic" displays the information form of ELPLA-

Graphic as shown in Figure E-60, which gives information about ELPLA-Graphic and the 

calculation method of the loaded project. 
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Figure E-60 Information form of program ELPLA-Graphic 

 

 

11 Tips and Tricks 

11.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table E-4 to Table E-11: 

 

Table E-4 Shortcut keys of menu head 

Shortcut keys  Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+g]     "Graphic" 

[Alt+o]     "Options" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table E-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [w]    "Make WMF-File" 

[Alt+f] then [s]    "Send to ELPLA-Section" 

[Ctrl +p] or [Alt+f] then [p]    "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table E-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [g]    "Tool bars-Graphic" 

[Alt+v] then [t], then [o]    "Tool bars-Options" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 
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Table E-7 Shortcut keys of Graphic-Command  

Shortcut keys Action 

[Alt+g] then [r] Calling command  "Results in isometric view" 

[Alt+g] then [e]    "Results as contour lines" 

[Alt+g] then [v]    "Result values in the plan" 

[Alt+g] then [d]    "Distribution curves of results in the plan" 

[Alt+g] then [f]    "Deformation" 

[Alt+g] then [p]    "Principal moments as streaks" 

[Alt+g] then [s]    "Support reactions as arrows" 

[Alt+g] then [v]    "Soil deformation as vectors" 

[Alt+g] then [m]    "Soil deformation as deformed mesh" 

[Alt+g] then [s]    "Principal soil stresses as streaks" 

[Alt+g] then [p]    "Principal soil strains as streaks" 

[Alt+g] then [a]    "Data in isometric view" 

[Alt+g] then [n]    "Data in the plan" 

[Alt+g] then [b]    "Boring locations" 

[Alt+g] then [o]    "Boring logs/ Limit depth" 

[Alt+g] then [g]    "Beam results" 

 

Table E-8 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [d]     "Display values" 

[Alt+o] then [c]     "Scale"  

[Alt+o] then [s]     "Set range"  

[Alt+o] then [a]     "Axes" 

[Alt+o] then [t]     "Title"  

[Alt+o] then [p]     "Page No."  

[Alt+o] then [c]     "Copy" 

[Alt+o] then [v]     "View grouping" 

 

 

 

 

 



 

 

ELPLA-Graphic 

 

 

 E-45 

Table E-9 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+t] then [i]     "Fill color"  

[Alt+t] then [x]     "Max. ordinate"  

[Alt+t] then [f]     "Font"  

[Alt+t] then [d]     "Legend" 

 

Table E-10 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out"  

[Alt+w] then [w]     "Zoom window"  

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 

[Alt+w] then [v]     "Viewing angle" 

 

Table E-11 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "New in ELPLA" 

[Alt+h] then [n]    "Short description of ELPLA" 

[Alt+h] then [a]     "About ELPLA-Graphic" 

 

11.2 Mouse 

 

By double-clicking the left mouse Button on a specified screen position the user can obtain 

almost menus of the program. 

 

- By double-clicking on legend, firm header, title or project identification the 

corresponding menu appears 

- By double-clicking on scale in the identification box "Scale"-Menu appears 

- By double-clicking on file name in the identification box "Open"-Menu appears 

- By double-clicking on page No. in the identification box "Page No."-Menu appears 

- By clicking the right mouse Button at any position on the screen the user can also obtain 

the Popup-Options-Menu, Figure E-61 

- By double-clicking on a specified node on the FE-Net the corresponding node 

information appears, Figure E-62 
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Figure E-61 Menu "Popup-Options" 

 

 
Figure E-62 Node information 
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12 Samples for graphical drawings using ELPLA-Graphic 

 

ELPLA-Graphic gives the ability to present more than 100 different graphical drawings for data 

and results. In this paragraph some graphical drawings for data and results of example problems 

"gb7" (an irregular raft on irregular subsoil) and "rib" (a ribbed raft) are presented. 

 

The pages P1 to P10 show some graphical presentations of data and results for example problem 

"gb7", while pages P11 and P12 show the graphical presentation of girders for example problem 

"rib". 

 

12.1 Graphical drawings of data 

 

Data in isometric view   Loading    Page  P1 

 

Data in the plan    Geometry of slab with loading  P2 

      Location of borings    P3 

 

12.2 Graphical drawings of results 

 

Results in isometric view   Contact pressures q    P4 

 

Deformation     Deformation w    P5 

 

Results as contour lines   Settlements s     P6 

 

Result values in the plan   Bottom Rafts y-Direction Asy2  P7 

 

Distribution curves of results in the plan Moments my     P8 

 

Results as circular diagrams   Moments mx     P9 

 

Principal moments as streaks   Principal moments    P10 

 

Girders presentation in the plan  Beam-Bending moments Mb   P11 

 

Girders presentation in isometric view  Beam-Bending moments Mb   P12 
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13 Index 

A 

Axes ........................................................................ 29, 32 

B 

Boring locations ...................................................... 25, 44 

Boring logs ................................................................... 26 

C 

Color circles .................................................................. 17 

Color contours .............................................................. 15 

Contours with a constant interval ................................. 13 

Contours with a variable interval .................................. 14 

Copy ................................................................. 29, 33, 44 

D 

Data in isometric view ............................................ 23, 47 

Data in the plan ............................................................. 24 

Deformation .................................................................. 18 

Display FE-Net ............................................................. 29 

Display values ......................................................... 29, 30 

Distribution of internal forces in the plan ..................... 27 

Distribution of internal forces in isometric view .......... 28 

Distribution of results in the plan ................................. 16 

E 

Exit ........................................................................... 8, 11 

F 

File .................................................................................. 8 

File groups ...................................................................... 5 

Files 1, 2, 3, 4 ........................................................... 8, 11 

Fill color ................................................................. 35, 36 

Final result files .............................................................. 7 

Font ......................................................................... 35, 37 

Format ............................................................................. 8 

Format menu ................................................................. 35 

G 

Girders .................................................................... 27, 44 

Graphic ........................................................................... 8 

Graphic files.................................................................... 5 

Graphic Menu ............................................................... 12 

H 

Help ................................................................................ 8 

Help Menu .................................................................... 41 

I 

Internal forces in isometric view ................................... 28 

L 

Legend ..................................................................... 35, 37 

Limit depth .................................................................... 26 

Line formats ................................................................... 35 

M 

Main data files ................................................................. 5 

Make WMF-File .......................................................... 8, 9 

Max. ordinate........................................................... 35, 37 

Mouse ............................................................................ 45 

N 

New in ELPLA .............................................................. 41 

O 

Open ................................................................................ 8 

Options ............................................................................ 8 

Original size ............................................................ 38, 39 

P 

Page No. .................................................................. 29, 33 

Page setup .................................................................. 8, 11 

Plot parameters .............................................................. 29 

Principal moments as streaks ......................................... 19 

Print ........................................................................... 8, 10 

Project data files .............................................................. 6 

R 

Result values in the plan ................................................ 15 

Results as circular diagrams .......................................... 17 

Results as contour lines ................................................. 13 

Results in isometric view ............................................... 12 

S 

Scale ........................................................................ 29, 31 

Set range .................................................................. 29, 31 

Short description ..................................................... 41, 45 

Shortcut keys ................................................................. 42 

Status bar ....................................................................... 11 

Support reactions as arrows ........................................... 20 

T 

Tips and Tricks .............................................................. 42 

Title ......................................................................... 29, 32 

Tool bars .................................................................. 11, 12 

V 

View .......................................................................... 8, 11 

View grouping ......................................................... 29, 34 

Viewing angle .......................................................... 38, 39 



 

 

ELPLA-Graphic 

 

 

 E-49 

W 

Window .......................................................................... 8 

WMF-File ....................................................................... 9 

Z 

Zoom % ......................................................................... 38 

Zoom in ......................................................................... 38 

Zoom out ....................................................................... 38 

Zoom window ................................................................ 38 
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1 An overview of ELPLA-Section 

 

ELPLA-Section is used to display graphically the calculated results (settlements, contact 

pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) and 

input project data (additional settlements) at specified sections. The drawing of the results and 

data can be displayed first on the screen, and then can be sent to the printer or plotter. Also, all 

drawing sections can be exported to MS Excel. 

 

The calculated results and input project data can be presented graphically as follows: 

 

1 Section in x-direction 

2 Max./ Min. values in x-direction 

3 Overlapping in x-direction 

4 Section in y-direction 

5 Max./ Min. values in y-direction 

6 Overlapping in y-direction 

7 Arbitrary section 

 

The drawings, if desired, can be saved as WMF-Format files, in which they can be exported to 

other Windows applications such as Word and AutoCAD to prepare reports, slide presentations 

or add further information. 

 

 

2 Description of ELPLA-Section 

 

ELPLA-Section is a 32-bit analysis and design software product that operates under Microsoft 

Windows 9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows 

applications makes it easy to learn how to use ELPLA-Section, especially if you are already 

familiar with the Windows environment. 

 

The program package ELPLA consists of 7 separate programs. The separate programs can be run 

independently. The name and short description of the programs are given in Table F-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed by using ELPLA-Solver. Finally, 

the results can be presented as graphical drawing, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor.  

 

In order to use ELPLA-Section, first the user must enter the project data by ELPLA-Data, and 

then must analyze the problem by ELPLA-Solver. Table F-2 gives a list of files, which are read 

or created by ELPLA-Section. The files can be classified in four groups. 
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Table F-1 Names and descriptions of the seven separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

Table F-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Section files (*.SEC)              ELPLA-Section 

C    Project data files                      ELPLA-Data 

D    Final result files                           ELPLA-Solver 

 

Further more, Table F-3 shows filenames, contents and groups of all files that may be read or 

created by ELPLA-Section. 

 

Table F-3 Names and contents of files 

 

A Main data files 

Filename                         Contents  

FIRMA    Firm header 

STEU                        Default directory for files that are saved by ELPLA 

NOFORMAT             Number formats  

UNITS     System of units 

 

B Section files 

Filename           Contents 

PLOTPAR.SEC    Plot parameters 

LEGENDE.SEC    Legend data 

ORDINATE. SEC        Max. ordinate data 

LINEFORM.SEC         Line formats 

FONT.SEC                Font data 

 

C Project data files 

Filename    Contents 

*. AUF          3 line texts to identify the project 

*. BAU          Soil properties 

* .PO1            System data (calculation method) 

*. PL6            FE-Net data 

*. P33          Data of supports/ boundary conditions 

*. PV1         Data of additional soil settlements 
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D Final result files 

Filename  Contents 

*. PT3        Displacements due to temperature change (st) 

*. PP3        Settlements due to neighboring foundations (se) 

*. QUN      Ultimate bearing capacities at nodes (qul) 

*. PW1       Modulus of subgrade reaction (ks) 

*. PH1        Settlements (s) 

*. PH2        Contact pressures (q) 

*. PH3        Moments (mx) 

*. PH4        Moments (my) 

*. PH5        Moments (mxy) 

*. PH6        Shear forces (Qx) 

*. PH7        Shear forces (Qy) 

*. PH8        Settlements due to reloading (sw) 

*. PH9        Overburden pressures (Qu) 

*. H10      Support reactions (V) 

*. H11      Support reactions (My) 

*. H12      Support reactions (Mx) 

*. H13      Reinforcement of the slab  (Asx1) 

*. H14      Reinforcement of the slab  (Asx2) 

*. H15      Reinforcement of the slab  (Asy1) 

*. H16      Reinforcement of the slab  (Asy2) 

The asterisk (*) matches any filename with the specified extension. 

 

Next paragraphs describe the purpose and function of each ELPLA-Section command. 
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3 Starting ELPLA-Section 

 

Start ELPLA-Section by clicking on the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure F-1) appears.  

 

 
Figure F-1 Introduction screen of ELPLA-Section 

 

The menu head of Figure F-1 contains the following seven commands: 

 

- File 

- View 

- Sections 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the seven menu commands, another sub-commands or options become 

available. The seven menu commands and their sub-commands are presented and described in 

the following paragraphs 4 to 11. 
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4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Combination of many projects 

- Make WMF-File 

- Print 

- Page setup 

- Send to Excel 

- Files 1, 2, 3, 4 

- Exit 

 

4.1 File Menu–"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure F-2 shows "Open" Dialog box used to open a specified project.  

 

 
Figure F-2 "Open project" Dialog box 

 

4.2 File Menu–"Combination of many projects" command 

 

The extreme values of calculated results (settlements, contact pressures, deformation, internal 

forces, modulus of subgrade reaction and reinforcement) of many projects can be drawn. 

 

For determining results as extreme values or drawing results of many projects in a diagram, 

project names and their comments are required. 

 

When the command is chosen, the input Dialog box shown in Figure F-3 appears. In this input 

Dialog box the project name and its identification can be defined. 

 

4.3 File Menu–"Make WMF-File" command 

 

By "Make WMF-File" command the drawing can be saved in a format that can be read by other 

programs. This feature allows you to include your drawing in reports and presentations and to 

enhance the drawing using other drawing or CAD software packages. The drawing can be 

exported in the Windows Metafile (WMF) format. 

 



 

 

ELPLA-Section 

 

 

F-9 

 
Figure F-3 "Combination of many projects" input Dialog box 

 

4.4 File Menu–"Print" command 

 

By "Print" command data and results can be graphically plotted or printed. Only the objects 

currently displayed on the drawing are printed. Figure F-4 shows "Print" Dialog box. The printer 

group box contains controls for selecting the printer and changing its properties. Use "Name" 

Combo box to select the printer and use "Properties" Button to set printer settings. The number 

of printing copies can be defined in "Copies" Input box.  

 

 
Figure F-4 "Print" Input box 

 

4.5 File Menu–"Page setup" command 

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size and paper source, as well as other printing 

options. Figure F-5 shows "Page setup" Dialog box. 

 



 

 

ELPLA-Section 

 

 

F-10 

 
Figure F-5 "Page setup" Dialog box 

 

4.6 File Menu–"Send to Excel" command 

 

By this command, it is possible to export results as diagrams to MS Excel. 

 

4.7 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

4.8 File Menu–"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-Section is quitted (Figure F-7). 

 

 
Figure F-7 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 

 

 

 

 



 

 

ELPLA-Section 

 

 

F-11 

5.1 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of the current operation. 

 

5.2 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

6 Sections Menu 

 

The Section menu is the main menu, which is used to display the specified drawing with the 

setting given by options, format and window menus. 

 

The Sections Menu commands are: 

 

- Section in x-direction 

- Max./ Min. values in x-direction 

- Overlapping in x-direction 

- Section in y-direction 

- Max./ Min. values in y-direction 

- Overlapping in y-direction 

- Arbitrary section 

 

 

 

 

 

6.1 Sections Menu–"Section in x-direction" command 

 

By "Section in x-direction" command the calculated results (settlements, contact pressures, 

deformation, internal forces, modulus of subgrade reaction and reinforcement) and input data 

(additional settlements) can be plotted at a specified section in x-direction.  

 

When this command is chosen, the selection Dialog box shown in Figure F-8 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 
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Figure F-8 "Section in x-direction" items 

 

For drawing results at a specified section in x-direction, ranges of the section are required as 

shown in Figure F-9. 

 

 
Figure F-9 "Section in x-direction" Dialog box 

 

As an example, Figure F-10 shows a specified section of settlement in x-direction. 
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Figure F-10 Section of settlement in x-direction 

 

6.2 Sections Menu–"Max./ Min. values in x-direction" command 

 

By "Max./ Min. values in x-direction" command the extreme values of results (settlements, 

contact pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) 

and input data (additional settlements) can be plotted at a specified range in x-direction. When 

the command is chosen, the selection Dialog box shown in Figure F-11 appears. In this Dialog 

box select one item to draw and then click "OK" Button.  

 

 
Figure F-11 "Max./ Min. values in x-direction" items 

 

For drawing extreme values of results at a specified range in x-direction, ranges of the section 

are required as shown in Figure F-12. 
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Figure F-12 "Section in x-direction" Dialog box 

 

As an example, Figure F-13 shows extreme values of moments mx in x-direction for the whole 

raft. 

 

 
Figure F-13 Extreme values of moments mx in x-direction for the whole raft 
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6.3 Sections Menu–"Overlapping in x-direction" command 

 

Values of calculated results (settlements, contact pressures, deformation, internal forces, 

modulus of subgrade reaction and reinforcement) and input data (additional settlements) can be 

plotted in many sections for a specified range in x-direction in one graph. 

 

When "Overlapping in x-direction" command is chosen, the selection Dialog box shown in 

Figure F-14 appears. In this Dialog box select one item to draw, then click "OK" Button.  

 

 
Figure F-14 "Overlapping in x-direction" items 

 

For drawing values of calculated results at a specified range in x-direction in one graph, ranges 

of the section are required as shown in Figure F-15. 

 

 
Figure F-15 "Overlapping in x-direction" Dialog box 

 

As an example, Figure F-16 shows values of shear forces Qy in x-direction in a specified zone of 

the raft. 
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Figure F-16 Sections of shear forces Qy in x-direction for a specified zone 

 

6.4 Sections Menu–"Section in y-direction" command 

 

By "Section in y-direction" command the calculated results (settlements, contact pressures, 

deformation, internal forces, modulus of subgrade reaction and reinforcement) and input data 

(additional settlements) can be plotted at a specified section in y-direction.  

 

When this command is chosen, the selection Dialog box shown in Figure F-17 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-17 "Section in y-direction" items 
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For drawing results at a specified section in y-direction, ranges of the section are required as 

shown in Figure F-18. 

 

 
Figure F-18 "Section in y-direction" Dialog box 

 

As an example, Figure F-19 shows a specified section of contact pressures in y-direction. 

 

 
Figure F-19 Section of contact pressures in y-direction 
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6.5 Sections Menu–"Max./ Min. values in y-direction" command 

 

By "Max./ Min. values in y-direction" command the extreme values of results (settlements, 

contact pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) 

and input data (additional settlements) can be plotted at a specified range in y-direction.  

 

When the command is chosen, the selection Dialog box shown in Figure F-20 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-20 "Max./ Min. values in y-direction" items 

 

For drawing extreme values of results at a specified range in y-direction, ranges of the section are 

required as shown in Figure F-21. 

 

 
Figure F-21 "Section in y-direction" Dialog box 

 

As an example, Figure F-22 shows the extreme values of moments my in y-direction for the 

whole raft. 
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Figure F-22 The extreme values of moments my in y-direction for the whole slab 

 

6.6 Sections Menu–"Overlapping in y-direction" command 

 

By "Overlapping in y-direction" command the values of calculated results (settlements, contact 

pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) and 

input data (additional settlements) can be plotted at a specified range in y-direction in one graph.  

 

When this command is chosen, the selection Dialog box shown in Figure F-23 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-23 "Overlapping in y-direction" items 
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For drawing values of calculated results at a specified range in y-direction in one graph, the 

ranges of the section required as shown in Figure F-24. 

 

 
Figure F-24 "Section in y-direction" Dialog box 

 

As an example, Figure F-25 shows values of shear forces Qx in y-direction in a specified zone of 

the raft. 

 

 
Figure F-25 Sections of shear forces Qx in y-direction 
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6.7 Sections Menu–"Arbitrary section" command 

 

By "Arbitrary section in x-direction" command the calculated results (settlements, contact 

pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) and 

input data (additional settlements) can be plotted at any arbitrary section.  

 

When "Arbitrary section" command is chosen, the selection Dialog box shown in Figure F-26 

appears. In this Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-26 "Section in x-direction" items 

 

For drawing results at any arbitrary section, ranges of the section are required as shown in Figure 

F-27. 

 

 
Figure F-27 "Section in x-direction" Dialog box 

 

As an example, Figure F-28 shows an arbitrary section of settlement. 
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Figure F-28 Arbitrary section of settlement 

 

 

7 Options Menu 

 

The Options Menu has the following commands: 

 

- Plot parameters 

- Scale 

- Axes 

- Title 

- Page No. 

- Copy 

 

7.1 Options Menu–"Plot parameters" command 

 

Plot parameters may be set as default values by the program, or be fully specified by the user. 

The following plot parameters can be specified (Figure F-29):   

 

- Display grid 

- Page with or without frame 

- Display values on lines 

- Display marks on lines 

 



 

 

ELPLA-Section 

 

 

F-23 

 
Figure F-29 "Plot parameters" Dialog box 

 

7.2 Options Menu–"Scale" command 

 

By "Scale" command the scale factor of the drawing can be defined as shown in Figure F-30. 

The defaulted value for the scale factor is chosen to pass the active printer-paper format. 

 

 
Figure F-30 "Scale" Dialog box 

 

7.3 Options Menu–"Axes" command 

 

By "Axes" command scaled axes can be defined on the drawing, Figure F-31. 

 

 
Figure F-31 "Axes" Dialog box 

 

7.4 Options Menu–"Title" command 

 

By "Title" command the text data (two line texts above the drawing and two line texts under the 

drawing) can be defined, Figure F-32. Default texts are: 

 

- A-Title1:      Method No. 

- A-Title2:      Name of method 

- U-Title1:      Name of drawing 

- U-Title2:      Ranges that define the section 
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Figure F-32 "Title" Dialog box 

 

7.5 Options Menu–"Page No." command 

 

By "Page No." command the page No. can be defined, Figure F-33.  

 

 
Figure F-33 "Page No." Dialog box 

 

7.6 Options Menu–"Copy" command 

 

By "Copy" command the current drawing can be copied in Metafile-Format to Clipboard. Then it 

can be inserted directly to another Windows programs such as Word, WordPerfect and 

AutoCAD. 

 

 

8 Format Menu 

 

The Format menu has the following commands: 

 

- Line formats  

- Max. ordinate 

- Font 

- Legend 

 

8.1 Format Menu–"Line formats" command 

 

Color, style and thickness of drawing lines can be defined, Figure F-34. The way a line is drawn 

depends on the setting of the color and style properties. There are available 15 different colors 

and 5 styles for line formats. 
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The following list shows the available lines, which can be formatted: 

 

- Grid 

- Page boundary 

- Identification box 

- Axes 

- Location of the section 

- Sections 

 

Note: The asterisk (*) matches drawing section number. 

 

 
Figure F-34 "Line formats" Dialog box 

 

8.2 Options Menu–"Max. ordinate" command 

 

By "Max. ordinate" command the maximum ordinate of the vertical axis and the maximum size 

of markers can be defined in [mm], Figure F-35. 

 

 
Figure F-35 "Max. ordinate" Dialog box 

 

8.3 Format Menu–"Font" command 

 

By "Font" command font size (Figure F-36) and font type (Figure F-37) for the drawing can be 

defined. 
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Figure F-36 "Font size" Dialog box 

 

 
Figure F-37 "Font" Dialog box 

 

8.4 Format Menu–"Legend" command 

 

By "Legend" command the height and width of legends (Identification box, symbol and location 

of the section) can be specified as shown in Figure F-38. 

 

Display legend 

In "Display legend" Group box check the legend that you wish to display. 

 

Legend size 

In "Legend size" Group box the height and width of the legend can be defined.  

 

 
Figure F-38 "Legend" Dialog box 
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9 Window Menu 

 

The Window menu has the following commands: 

 

- Zoom in 

- Zoom out  

- Zoom window  

- Zoom % 

- Original size 

 

9.1 Window Menu–"Zoom in" command 

 

By "Zoom in" command the size of the drawing on the screen can be reduced. 

 

9.2 Window Menu–"Zoom out" command 

 

By "Zoom out" command the size of the drawing on the screen can be increased. 

 

9.3 Window Menu–"Zoom window" command 

 

By "Zoom window" command the size of the drawing on a specified area can be increased. 

 

9.4 Window Menu–"Zoom %" command 

 

When you choose "Zoom %" command, the following Dialog box appears, Figure F-39. 

 

 
Figure F-39 "Zoom %" Dialog box 

 

By "Zoom %" command the size of drawings on the screen can be specified. Choosing "Zoom 

%" allows you to increase or decrease the size at which the drawing is displayed. Choosing 

100% displays the drawing at its original size. Clicking on the percentage, changes the drawing 

size to the specified percentage. The drawing can be displayed at any size by typing the desired 

percentage in the specified Edit box. 

 

9.5 Window Menu–"Original size" command 

 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using "Original size" command. 
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10 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Section 

 

10.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure F-40. 

 

 
Figure F-40 Menu "Contents" 

 

10.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

10.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 
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10.4 Help Menu–"About ELPLA-Section" command 

 

Clicking the command "About ELPLA-Section" displays the information form of ELPLA-

Section as shown in Figure F-41 This gives information about ELPLA-Section and the 

calculation method of the loaded project. 

 

 
Figure F-41 Information form of ELPLA-Section 

 

 

11 Tips and Tricks 

11.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table F-4 to Table F-11: 

 

Table F-4 Shortcut keys of menu head 

Shortcut keys Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+s]     "Sections" 

[Alt+o]     "Options" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table F-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [c]    "Combination of many projects" 

[Alt+f] then [w]    "Make WMF-File" 

[Ctrl +p] or [Alt+f] then [p]    "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [s]    "Send to Excel" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table F-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [s]    "Tool bars-Sections" 

[Alt+v] then [t], then [o]    "Tool bars-Options" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 
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Table F-7 Shortcut keys of Sections-Command  

Shortcut keys Action 

[Alt+s] then [x]  Calling command  "Section in x-direction" 

[Alt+s] then [m]     "Max./ Min. values in x-direction" 

[Alt+s] then [o]    "Overlapping in x-direction" 

[Alt+s] then [y]    "Section in y-direction" 

[Alt+s] then [a]    "Max./ Min. values in y-direction" 

[Alt+s] then [r]    "Overlapping in y-direction" 

[Alt+s] then [a]    "Arbitrary section" 

 

Table F-8 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [s]     "Scale" 

[Alt+o] then [a]     "Axes" 

[Alt+o] then [t]     "Title" 

[Alt+o] then [p]     "Page No." 

[Alt+o] then [c]     "Copy" 

 

Table F-9 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+o] then [x]     "Max. ordinate" 

[Alt+t] then [f]     "Font" 

[Alt+t] then [d]     "Legend" 

 

Table F-10 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out" 

[Alt+w] then [w]     "Zoom window" 

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 
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Table F-11 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "Short description of ELPLA" 

[Alt+h] then [n]    "New in ELPLA" 

[Alt+h] then [a]     "About ELPLA-Section" 

 

11.2 Mouse 

 

By double-clicking the left mouse Button on a specified screen position, the user can obtain 

almost menus of the program. 

 

- By double-clicking on Legend, Firm header, Title or Project identification, the 

corresponding menu appears 

 

- By double-clicking on Scale in the identification box, "Scale"-Menu appears 

 

- By double-clicking on File name in the identification box, "Open"-Menu appears 

 

- By double-clicking on Page No. in the identification box, "Page No."-Menu appears 

 

- By clicking the right mouse Button at any position on the screen, the user can also obtain 

the Popup- Options-Menu, Figure F-42 

 

 

 
Figure F-42 Menu "Popup- Options" 
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12 Samples for graphical drawings using ELPLA-Section 

 

ELPLA-Section gives the ability to present many different graphical drawings for results. In this 

paragraph the graphical drawings for results of example problem gb7, an irregular raft on 

irregular subsoil, is presented. 

 

The pages P1 to P3 show some graphical presentations of example gb7 in different possibilities 

according to Table F-12. There is also a great number of presentation possibilities that are not 

consider in this paragraph. Color presentation is also possible by ELPLA-Section. 

 

Table F-12 Graphical drawings for results 
 
Presentation       Page 

Contact pressure q                                             P1 

Max./ Min. values of moments mx                                      P2 

Overlapping of 3 Sections of shear forces Qy   P3 
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1 An overview of ELPLA- List  

 

ELPLA-List is used to display and print input data and calculated results. Listing data and results 

can be displayed first on the screen, and then can be sent to the printer or MS Word.  

 

The data and results can be viewed as follows: 

 

- Display tables of data 

- Print tables of data 

- List tables of data through Text-Editor 

- Display tables of results 

- Print tables of results 

- List tables of results through Text-Editor 

 

The data and results, if desired, can be saved as ASCII-format Files, in which they can be 

exported to other Windows applications to prepare reports or add further information. 

 

 

2 Description of ELPLA-List 

 

ELPLA-List is a 32-bit software product that operates under MS Windows 9x/ NT/ ME/ XP. The 

common "what you see is what you get" of Windows applications makes it easy to learn how to 

use ELPLA-List, especially if you are already familiar with the Windows environment.  

 

The program package ELPLA consists of 7 separate programs. They can be run independently. 

The name and short description of the seven separate programs are given in Table G-1. The 

usage of the program is typically such that first data files are created describing a certain problem 

by ELPLA-Data. Then the project problem is analyzed by ELPLA-Solver. Finally, the results can 

be presented as graphical drawing, graphs and tables using the five separate programs ELPLA-

Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor. 

 

Table G-1 Names and description of the seven separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                        Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

In order to use ELPLA-List, first the user must define the project data by ELPLA-Data, and then 

analyze the problem by ELPLA-Solver. Table G-2 gives a list of files, which are read or created 

by ELPLA-List. The files can be classified in four groups. 
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Table G-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    List files (*.LST)                ELPLA-List 

C    Project data files                      ELPLA-Data 

D    Result files                           ELPLA-Solver 

 

Further more, Table G-3 shows filename, contents and groups of all files that may be read by 

ELPLA-List. 

 

Table G-3 Names and contents of files 

 

A Main data files 

Filename            Contents  

FIRMA  Firm header 

STEU                      Default directory for files that are saved by ELPLA 

NOFORMAT           Number formats 

RFT   Design code parameters  

UNITS   System of units 

 

B List file 

Filename           Contents 

PAGELAYO.LST                         Page format 

FONT.LST    Font format 

 

C Project data files 

Filename    Contents 

*. AUF                          3 lines text to identify the project 

*. BAU                            Soil properties 

*. LDH                          Data of limit depth  

* .PO1            System data (Analysis of isolated raft) 

*. PC1                                     Load data 

*. PL6                           FE-Net data 

*. P21                            Data of slab properties/ levels/ coordinates 

*. P23                            Reinforcement data 

*. GL1                           Girder data 

*. P31                           Data of supports/ boundary conditions 

*. P35                            Data of spring supports 

*. P41                            File of boring fields 

*. PT1                            Data for temperature change 

*. PP1                            File of neighboring foundations 

*. PV1                            Data of additional soil settlements 
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D Result files  

Filename  Contents 

*. PL4    Area around nodes 

*. PC7   Foundation properties 

*. PC8   Average contact pressure, eccentricity and area of slab 

*. PS1   Deformations of the rigid slab (wo, tan xo, tan xo) 

*. PT2      Load vector due to temperature change 

*. PP2       Load vector due to neighboring foundations 

*. PW2  Moduli of subgrade reactions of borings 

*. QUB  Main ultimate bearing capacity (qb) 

*. PD1                        Flexibility matrix for loading 

*. PD2                        Flexibility matrix for reloading 

*. PE1                        Soil stiffness matrix  

*. LD1              Limit depth 

*. GH1    Internal forces of grid elements 

*. PT3        Displacements due to temperature change (st) 

*. PP3        Settlements due to neighboring foundations (se) 

*. PV2     Load vector due to additional settlements 

*. QUN      Ultimate bearing capacities at nodes (qult) 

*. PW1       Modulus of subgrade reaction (ks) 

*. PH1        Settlements (s) 

*. PH2        Contact pressures (q) 

*. PH3        Moments (mx) 

*. PH4        Moments (my) 

*. PH5        Moments (mxy) 

*. PH6        Shear forces (Qx) 

*. PH7        Shear forces (Qy) 

*. PH8        Settlements due to reloading (sw) 

*. PH9        Overburden pressures (Qu) 

*. H10      Support reactions (V) 

*. H11      Support reactions (My) 

*. H12      Support reactions (Mx) 

*. H13      Reinforcement of the slab  (Asx1) 

*. H14      Reinforcement of the slab  (Asx2) 

*. H15      Reinforcement of the slab  (Asy1) 

*. H16      Reinforcement of the slab  (Asy2) 

*. THY      Rotations about y-axis (θy) 

*. THZ      Rotations about z-axis (θz) 

*. PPU      Punching results 

The asterisk (*) matches any filename with the specified extension. 

 

Next paragraphs describe the purpose and function of each ELPLA-List command.  

 

 

3 Starting ELPLA-List 

 

Start ELPLA-List by clicking on the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure G-1) appears. 
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Figure G-1 Introduction screen of ELPLA-List 

 

The menu head of Figure G-1 contains the following 6 commands: 

 

- File 

- View 

- List 

- Format 

- Window 

- Help 

 

After clicking one of the six menu commands other sub-commands become available. These are 

presented and described in the following paragraphs 4 to 10. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Close project 

- Print setup 

- Send to Word 

- Send to Excel 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu –"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure G-2 shows "Open" Dialog box used to open a specified project.  

 

 
Figure G-2 "Open project" Dialog box 

 

4.2 File Menu –"Close project" command 

 

By "Close project" command the current project is closed.  

 

4.3 File Menu –"Print setup" command 

 

By this command the standard "Print setup" Dialog box can be displayed with options to specify 

printer, page orientation, paper size and paper source, as well as other printing options. 

 

Table G-3 shows "Print setup" Dialog box. The printer group box contains controls for selecting 

the printer and changing its properties. Use "Name" combo box to select the printer and use 

"Properties" Button to set printer settings. 

  

 
Figure G-3 "Print setup" Dialog box 
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4.4 File Menu –"Send to Word" command 

 

By "Send to Word" command it is possible to export data to MS Word, Figure G-4. 

 

 
Figure G-4 Export data to MS Word 

 

4.5 File Menu –"Send to Excel" command 

 

By "Send to Excel" command it is possible to export results to MS Excel, Figure G-5. 

 

4.6 File Menu –"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 
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Figure G-5 Export results to MS Excel 

 

4.7 File Menu –"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-List is quitted, Figure G-6. 

 

 
Figure G-6 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Project explorer 

- Status bar 

- Tool bars 

 

5.1 View Menu–"Project explorer" command 

 

"Project explorer" command displays an explorer window on the screen at the left. It is possible 

to swap between data and results easily, Figure G-7. 
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Figure G-7 "Project explorer"-Window 

 

5.2 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of the current operation. 

 

5.3 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

6 List Menu 

 

The List menu is the main menu, which is used to view or print the calculated results and input 

project data with the setting given by option format menus. 

 

The Menu List commands are: 

 

- Display tables of data 

- Print tables of data 

- List tables of data through Text-Editor 

- Display tables of results 

- Print tables of results 

- List tables of results through Text-Editor 
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6.1 List Menu –"Display tables of data" command 

 

By "Display tables of data" command the input project data can be tabulated.  

 

The input project data, which can be tabulated, are: 

    

- Node coordinates 

- Node boundaries 

- Data of supports/ Boundary conditions 

- Spring supports 

- Girders 

- Loading 

- Slab properties/ Foundation level/ Global coordinates  

- Data of reinforcement 

- Data of temperature change 

- Data of neighboring foundations  

- Data of additional soil settlements 

- Data of boring fields  

- Soil properties 

 

When the command is chosen, the selection Dialog box shown in Figure G-8 appears. In this 

Dialog box select one item to be tabulated and click "OK" Button. As an example, Figure G-9 

shows a list of soil data. 

 

 
Figure G-8 "Display tables of data" items 
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Figure G-9 List of node coordinates 

 

6.2 List Menu –"Print tables of data" command 

 

By "Print tables of data" command the title page of ELPLA can be printed. The input project data 

that can be viewed can be also printed. When "Print tables of data" command is chosen, the 

selection Dialog box shown in Figure G-10 appears. In this Dialog box check the items that you 

want to print, then click "OK" Button. 

 

 

Figure G-10 "Print tables of data" items 

 

For printing tables of data, the header options, page numbering and also number of copies are 

required as shown in Figure G-11. 

 

Header 

- To print headers (Company), check the control box "Print header (Company)" 

- To print an identification header, check the control box "Print identification header" 
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Page numbering 

- By the option "Start at" renumbering pages can be defined. To change the page number, 

type the new number in "Start at" Text box 

- If the option "No page numbering" is activated, the page numbers will not be included in 

the document 

 

Copies 

- In Dialog box "No. of copies" the number of printing copies can be defined 

 

 
Figure G-11 "Print" Dialog box 

 

6.3 List Menu –"List tables of data through Text-Editor" command 

 

By this command the title page of ELPLA can be displayed through the ELPLA Text-Editor. The 

input project data that can be viewed can be also displayed. When the command is chosen, the 

selection Dialog box shown in Figure G-12 appears. In this Dialog box check the items that you 

want to list through Text-Editor, then click "OK" Button. 

 

 
Figure G-12 "List tables of data through Text-Editor" items 

 

For listing tables of data through Text-Editor, the header options and page numbering are 

required before loading Text-Editor. Figure G-13 shows Title page of ELPLA through the 

ELPLA Text-Editor (program GEOTEC-Editor). To get information about GEOTEC-Editor, see 

the User’s Guide of GEOTEC-Editor. 
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Figure G-13 Title page of ELPLA through GEOTEC-Editor 

 

6.4 List Menu –"Display tables of results" command 

 

By "Display tables of results" command the calculated results can be tabulated.  

 

The calculated results, which can be tabulated, are: 

 

- Settlements, contact pressures, deformation and internal forces 

- Flexibility matrix [Ce] 

- Flexibility matrix [CW] 

- Stiffness matrix [ks] 

- Modulus of subgrade reaction (ks) 

- Ultimate bearing capacity (qult) 

- Settlements due to temperature change (st) 

- Settlements due to neighboring foundations (se) 

- Additional soil settlements (ss) 

- Support reactions (V) 

- Limit depth (zg) 

- Reinforcement (As) 

- Punching results 

 

When "Display tables of results" command is chosen, the selection Dialog box shown in Figure 

G-14 appears. In this Dialog box select one item to be tabulated, then click "OK" Button. As an 

example, Figure G-15 shows a list of settlements. 
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Figure G-14 "Display tables of results" items 

 

 

Figure G-15 List of settlements 

 

6.5 List Menu –"Print tables of results" command 

 

The calculated results can be printed. When "Print tables of results" command is chosen, the 

selection Dialog box shown in Figure G-16 appears. In this Dialog box check the items that you 

want to print, then click "OK" Button. 

 

For printing tables of results, the header options, page numbering and also number of copies are 

required as shown in Figure G-11. 
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Figure G-16 "Print tables of results" items 

 

6.6 List Menu –"List tables of results through Text-Editor" command 

 

By "List tables of data through Text-Editor" command the calculated results can be displayed 

through ELPLA Text-Editor. When the command is chosen, the selection Dialog box shown in 

Figure G-17 appears. In this Dialog box check the items that you want to list through Text-

Editor, then click "OK" Button. 

 

 
Figure G-17 "List tables of results through Text-Editor" items 

 

For listing tables of data through Text-Editor, the header options and page numbering are 

required before loading Text-Editor. Figure G-18 shows moments through ELPLA Text-Editor. 

To get information about GEOTEC-Editor, see the User’s Guide of GEOTEC-Editor. 
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Figure G-18 Moments through GEOTEC-Editor 

 

 

7 Format Menu 

 

The Format menu has the following commands: 

 

- Page format 

- Font 

 

7.1 Format Menu –"Page format" command 

 

By "Page format" command the page margins, number of lines per page and number of 

characters per line can be defined, Figure G-19. The user has the possibility at any time to 

specify one of the following left, top or bottom boundaries. 

 

 
Figure G-19 "Page format" Dialog box 
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7.2 Format Menu –"Font" command 

 

By this command font size (Figure G-20) and font type (Figure G-21) for the text can be defined. 

 

 
Figure G-20 "Font size" Dialog box 

 

 
Figure G-21 "Font type" Dialog box 

 

 

8 Window Menu 

 

The Window menu has the following commands: 

 

- Cascade 

- Tile horizontally 

- Tile vertically 

- Arrange icons 

- Window 1, 2, 3, … 

 

8.1 Window Menu–"Cascade" command 

 

By "Cascade" command all non-minimized forms are cascaded. 
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8.2 Window Menu–"Tile horizontally" command 

 

By "Tile horizontally command all non-minimized forms are tiled horizontally. 

 

8.3 Window Menu–"Tile vertically" command 

 

By "Tile vertically" command all non-minimized forms are tiled vertically. 

 

8.4 Window Menu–"Arrange icons" command 

 

When choosing "Arrange icons" command, the icons of minimized forms are arranged. 

 

8.5 Window Menu–"Window 1, 2, 3 …" command 

 

By "Window 1, 2, 3 …" command the user can display a list of the previous loaded data or 

results. 

 

 

9 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-List 

 

9.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete User’s 

Guide of ELPLA, Figure G-22. 
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Figure G-22 Menu "Contents" 

 

9.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

9.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

9.4 Help Menu–"About ELPLA-List" command 

 

Clicking the command displays the information form of ELPLA-List as shown in Figure G-23, 

which gives information about ELPLA-List and the calculation method of the loaded project. 
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Figure G-23 Information form of ELPLA-List 

 

 

10 Tips and Tricks 

10.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table G-4 to Table G-10. 

 

Table G-4 Shortcut keys of menu head 

Shortcut keys Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+l]     "List" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table G-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [c]    "Close project" 

[Alt+f] then [u]    "Print setup" 

[Alt+f] then [w]    "Send to Word" 

[Alt+f] then [e]    "Send to Excel" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table G-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [x] Calling command  "Project explorer" 

[Alt+v] then [b]    "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [l]    "Tool bars-List 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 

 

Table G-7 Shortcut keys of List-Command  

Shortcut keys Action 

[Alt+l] then [t]  Calling command  "Display tables of data" 

[Alt+l] then [a]     "Print tables of data" 

[Alt+l] then [b]    "List tables of data through Text-Editor" 

[Alt+l] then [e]    "Display tables of results" 

[Alt+l] then [p]    "Print tables of results" 

[Alt+l] then [l]    "List tables of results through Text-Editor" 
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Table G-8 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [p]  Calling command  "Page format" 

[Alt+t] then [f]     "Font"  

 

Table G-9 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [c]  Calling command  "Cascade" 

[Alt+w] then [h]     "Tile horizontally" 

[Alt+w] then [v]     "Tile vertically" 

[Alt+w] then [a]     "Arrange icons" 

[Alt+w] then [1, 2, 3, …]     "Window 1, 2, 3 …" 

 

Table G-10 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "Short description of ELPLA" 

[Alt+h] then [n]    "New in ELPLA" 

[Alt+h] then [a]     "About ELPLA-List" 

 

10.2 Mouse 

 

By clicking the right mouse Button on the screen, the user can obtain the Popup-Format-Menu, 

Figure G-24. 
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Figure G-24 Menu "Popup-Format" 

 

 

11 Listing samples for data and results using ELPLA-List 

 

ELPLA-List gives the ability to print data and results in arranged tables. In this paragraph some 

of the printed text for data and results of example problems gb7, an irregular raft on irregular 

subsoil, are presented. 

 

The pages 1 to 2 contain some printed text of input project data for the example problem gb7, 

while pages 3 to 7 contain some printed text of results for the same example problem, according 

to Table G-11 and Table G-12.  

 

11.1 Listing input project data 

 

Table G-11 Input project data 

Presentation                      Page 

Title page of program ELPLA                  - 

Loading                             1 – 2 

 

11.2 Listing of calculated results 

 

Table G-12 Results 

Presentation                      Page 

Moments m       3 – 7 
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 **************************************************************************************** 

                                Analysis of slab foundation 

                                by the program package ELPLA 

                                         Version 9.0 

**************************************************************************************** 

 

 

 

 

 

 

 

 

 

 

 

 

                       Title     : An irregular raft on irregular subsoil 

                       Date        : 13.07.1998 

                       Project     : Method 7 

                       File        : gb7 

 

 

 

 

 

 

 

 

 

 

 

 

 Calculation method: 

 Method (7) (Layered soil model) 

 Modulus of Compressibility (Elimination) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Program authors: M. El Gendy/ A. El Gendy 

GEOTEC: PO Box 14001 Richmond Road PO - Calgary AB, Canada T3E 7Y7 
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                                      GEOTEC-Software 

PO Box 14001 Richmond Road PO - Calgary AB, Canada T3E 7Y7 

---------------------------------------------------------------------------------------- 

Loading                                                                           Page 1 

---------------------------------------------------------------------------------------- 

 Title     : An irregular raft on irregular subsoil 

 Date         : 13.07.1998 

 Project      : Method 7 

 File         : gb7 

 

                                 Analysis of slab foundation 

                                  by the program package ELPLA 

                                         Version 9.0 

 

 Calculation method: 

 Method (7) (Layered soil model) 

 Modulus of Compressibility (Elimination) 

 

 

 L o a d i n g 

 Point loads: 

 ----------------------------------------------------- 

 Load No.     Load value     x-position     y-position 

        I              P              x              y 

      [1]           [kN]            [m]            [m] 

 ----------------------------------------------------- 

        1           1265            1,5            1,4 

        2           1600            1,5            5,5 

        3           1350            1,5            9,9 

        4           1368            1,5           12,6 

        5           1560              5            1,4 

        6           1538              5           12,6 

        7            800            9,2            1,4 

        8            750            9,2            5,5 

        9           1565            9,2           12,6 

       10           2150           13,4            5,5 

       11           1450           13,4            9,9 

       12           1254           13,4           12,6 

 ----------------------------------------------------- 

 

 Moments Mx: 

 --------------------------------------------------- 

 Moment   Moment value     x-position     y-position 

    No.             Mx              x              y 

    [1]         [kN.m]            [m]            [m] 

 --------------------------------------------------- 

      1            350              5            1,4 

 --------------------------------------------------- 

 

 Moments My: 

 --------------------------------------------------- 

 Moment   Moment value     x-position     y-position 

    No.             My              x              y 

    [1]         [kN.m]            [m]            [m] 

 --------------------------------------------------- 

      1            500            9,2            5,5 

 --------------------------------------------------- 

 

 

 Line loads: 

 -------------------------------------------------------------------- 

 Load No.  Load value  Load start  Load start    Load end    Load end 

        I          Pl          x1          y1          x2          y2 

      [1]      [kN/m]         [m]         [m]         [m]         [m] 

 -------------------------------------------------------------------- 

 

        1          89        10,5         4,8          15         2,8 

 -------------------------------------------------------------------- 
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---------------------------------------------------------------------------------------- 

Loading                                                                           Page 2 

---------------------------------------------------------------------------------------- 

 

 

 Distributed loads: 

 -------------------------------------------------------------------- 

 Load No.  Load value  Load start  Load start    Load end    Load end 

        I           P          x1          y1          x2          y2 

      [1]     [kN/m2]         [m]         [m]         [m]         [m] 

 -------------------------------------------------------------------- 

        1         120           0           0         0,5          14 

 -------------------------------------------------------------------- 

 

 

 Loading data: 

 

 Slab weight                                   Pe    [kN]  = 0,0 

 Force on slab                                 Pa    [kN]  = 17927,1 

 Groundwater force                             Pw    [kN]  = 2031,2 

 Total load  (P =  Pe + Pa - Pw)               P     [kN]  = 15895,9 

 Groundwater pressure on slab                  Qw   [kN/m2]= 12,0 

 Average contact pressure                      Qo   [kN/m2]= 93,9 

 

 Sum Mx from loads                             Mx   [kN.m] = 7039,1 

 Sum My from loads                             My   [kN.m] = -6683,2 

 

 Eccentricity of loading in x-direction        ex    [cm]  = -42,04 

 Eccentricity of loading in y-direction        ey    [cm]  = 44,28 

 

 Moment of inertia of slab about x-Axis        Ix    [m4]  = 2923,08 

 Moment of inertia of slab about y-Axis        Iy    [m4]  = 3423,36 

 Product of inertia                            Ixy   [m4]  = 366,19 

 Area of slab                                  A     [m2]  = 169,27 
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 Title     : An irregular raft on irregular subsoil 

 Date         : 13.07.1998 

 Project      : Method 7 

 File         : gb7 

 

                                 Analysis of slab foundation 

                                  by the program package ELPLA 

                                         Version 9.0 

 

 

 Calculation method: 

 Method (7) (Layered soil model) 

 Modulus of Compressibility (Elimination) 

 

 Moments: 

 

 ---------------------------------------------------------------------------- 

   Node        Moment        Moment        Moment     Principal     Principal 

    No.                                                  moment        moment 

      I            mx            my           mxy           mh1           mh2 

    [1]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m] 

 ---------------------------------------------------------------------------- 

      1          -0,2           2,4          -5,3           6,6          -4,4 

      2          32,6          -1,4          -7,1          34,1          -2,8 

      3          34,9          -1,9         -22,2          45,4         -12,3 

      4         -29,2           0,6         -23,4          13,4         -42,0 

      5         -46,1          -3,2          -2,3          -3,1         -46,2 

      6          -6,9          -0,9           7,9           4,6         -12,3 

      7         -17,3           4,0           0,6           4,0         -17,3 

      8         -87,9          -5,4           5,2          -5,1         -88,2 

      9        -154,1          -0,3          25,1           3,7        -158,1 

     10        -102,8          -1,3          33,2           8,6        -112,7 

     11         -25,6          -4,0          24,3          11,8         -41,4 

     12           5,7           7,3          13,7          20,3          -7,2 

     13          -0,7          31,9         -13,0          36,4          -5,2 

     14          61,6          77,6         -16,2          87,7          51,5 

     15         103,4         106,5         -26,4         131,4          78,6 

     16         -50,1          58,9         -26,7          65,1         -56,3 

     17         -67,6          63,3          -4,8          63,5         -67,7 

     18          30,5         126,5           9,7         127,4          29,5 

     19          58,0         151,8          -6,7         152,3          57,5 

     20        -115,9          64,8          -0,8          64,8        -115,9 

     21        -166,9          32,6          30,4          37,1        -171,4 

     22         -99,7          41,4          40,6          52,3        -110,5 

     23          22,5          61,3          39,1          85,5          -1,7 

     24          -6,4          -0,9          33,6          30,1         -37,4 

     25           0,1          14,7         -31,6          39,8         -25,1 

     26          61,2          57,5         -36,4          95,8          22,9 

     27          99,5          88,5         -30,6         125,1          62,9 

     28         -56,6          44,4         -31,0          53,1         -65,3 

     29         -81,6          70,5         -34,8          78,0         -89,2 

     30          20,9         147,6         -19,7         150,6          17,9 

     31          50,1         170,4           2,4         170,5          50,0 

     32        -139,9          92,9          29,2          96,5        -143,5 

     33        -176,7          35,5          46,9          45,4        -186,6 

     34        -105,7          36,2          47,2          50,5        -120,0 

     35           4,9          51,6          61,0          93,5         -37,0 

     36           6,3         -18,5          90,6          85,4         -97,5 

     37          -1,3         -56,0         -36,0          16,6         -73,9 

     38          35,6         -64,0         -42,4          51,2         -79,7 

 

                                                         Continue of table at next page 
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 Continue of table 

 ---------------------------------------------------------------------------- 

   Node        Moment        Moment        Moment     Principal     Principal 

    No.                                                  moment        moment 

      I            mx            my           mxy           mh1           mh2 

    [1]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m] 

 ---------------------------------------------------------------------------- 

     39          27,7         -69,8         -41,5          43,0         -85,0 

     40         -39,2         -40,7         -52,4          12,5         -92,3 

     41         -82,9          -9,8         -73,5          35,7        -128,5 

     42         -64,9           3,3         -58,5          36,9         -98,6 

     43         -89,4          15,2           1,2          15,2         -89,4 

     44        -167,2          38,0          57,2          52,9        -182,1 

     45        -178,3           5,2          69,5          28,5        -201,7 

     46        -117,9         -19,5          64,7          12,6        -150,0 

     47         -52,1         -45,1          83,9          35,4        -132,6 

     48        -130,8         -48,6         115,7          33,1        -212,5 

     49         -19,8          10,5          40,8          38,8         -48,1 

     50          50,5          -1,8          17,9          56,0          -7,3 

     51          68,3           1,8           3,8          68,5           1,6 

     52          -0,6          -3,2           2,5           0,9          -4,7 

     53          -2,2         -76,6         -27,6           6,9         -85,7 

     54          37,4         -87,1         -32,0          45,1         -94,9 

     55          30,6         -97,5         -50,0          47,8        -114,7 

     56         -21,9         -92,4         -75,8          26,5        -140,8 

     57         -93,2         -61,4        -100,7          24,7        -179,3 

     58        -114,0         -41,7         -74,2           4,7        -160,4 

     59        -180,4         -10,8         -25,6          -7,0        -184,2 

     60        -224,0           9,9          78,8          33,9        -248,1 

     61        -166,6         -18,4          84,5          19,8        -204,9 

     62        -123,3         -35,3          80,9          12,7        -171,4 

     63         -72,8         -38,4          84,3          30,4        -141,7 

     64         -83,3          -4,7          81,3          46,3        -134,3 

     65         -16,3          17,9          43,1          47,2         -45,6 

     66          77,1          32,4          24,4          87,9          21,7 

     67          86,3          32,0          -0,2          86,3          32,0 

     68          -2,2          23,0          -3,8          23,6          -2,7 

     69          -1,5         -32,6         -13,5           3,6         -37,7 

     70          60,2         -53,2         -15,6          62,3         -55,3 

     71          67,6         -82,3         -47,4          81,3         -96,0 

     72           6,8         -94,7         -84,7          54,8        -142,7 

     73         -91,3        -176,1        -134,9           7,7        -275,1 

     74        -151,5          24,1        -110,3          77,3        -204,7 

     75        -185,9           4,7         -48,1          16,1        -197,4 

     76        -335,8          17,1         140,5          66,2        -384,9 

     77        -154,3         -35,2          96,2          18,3        -207,9 

     78        -129,0         -23,6          91,0          28,9        -181,5 

     79         -57,5         -12,2          95,3          63,1        -132,8 

     80         -39,9          41,2          49,2          64,4         -63,1 

     81           4,5          88,3          44,2         107,3         -14,5 

     82         117,1          90,3          31,7         138,1          69,3 

     83         123,2          83,1          -7,1         124,4          81,9 

     84           1,4         102,7         -18,2         105,9          -1,7 

     85           0,0          51,8          -7,0          52,7          -0,9 

     86         111,9         100,6          -7,4         115,5          96,9 

     87         195,3         116,3         -22,2         201,1         110,5 

     88          -3,6         -24,0         -30,2          18,0         -45,7 

     89          15,1         -73,6         -33,8          26,5         -85,0 

     90          16,3         -82,6         157,7         132,1        -198,4 

     91        -139,6         -23,5          90,4          25,8        -189,0 

     92        -101,0          10,0          77,9          50,1        -141,2 

                                                         Continue of table at next page 
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 Continue of table 

 ---------------------------------------------------------------------------- 

   Node        Moment        Moment        Moment     Principal     Principal 

    No.                                                  moment        moment 

      I            mx            my           mxy           mh1           mh2 

    [1]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m] 

 ---------------------------------------------------------------------------- 

     93          12,0          98,4          71,8         139,0         -28,7 

     94         -40,8          99,1          30,7         105,6         -47,2 

     95          -4,7         132,9          22,7         136,6          -8,4 

     96         200,0         274,1          14,0         276,6         197,5 

     97         237,9         320,7          -8,6         321,6         237,0 

     98          -3,3         204,9         -17,4         206,4          -4,8 

     99          -0,3          39,2          -9,9          41,6          -2,6 

    100         103,2          66,1         -10,1         105,7          63,5 

    101         167,2          68,9           9,8         168,2          67,9 

    102          14,1         -15,2          18,8          23,3         -24,4 

    103          -0,9         -58,0          13,0           1,9         -60,8 

    104         -10,6         -69,4          63,2          29,8        -109,7 

    105        -105,4         -23,4          61,8           9,7        -138,6 

    106         -97,2          14,8          47,7          32,3        -114,8 

    107          23,4          67,9          24,3          78,5          12,7 

    108          -8,5          68,3          22,3          74,3         -14,5 

    109           8,6         104,2         -14,9         106,4           6,3 

    110         185,7         210,6         -25,3         226,4         169,9 

    111         214,3         248,2          -7,0         249,6         212,9 

    112          -1,4         182,6          -2,3         182,7          -1,5 

    113          -1,6         -46,3           1,8          -1,5         -46,4 

    114          59,0         -62,1           2,3          59,1         -62,2 

    115          68,3         -81,1          23,3          71,9         -84,6 

    116          25,5         -76,4          34,5          36,1         -87,0 

    117          -1,8         -84,4          28,9           7,3         -93,5 

    118           7,4          12,9          33,2          43,4         -23,2 

    119        -113,5          -7,6          42,9           7,6        -128,7 

    120        -109,1          -3,7          40,0           9,7        -122,6 

    121          -9,0           0,7          22,0          18,4         -26,7 

    122          53,6         -25,8           0,0          53,6         -25,8 

    123          29,6          21,3         -34,0          59,7          -8,8 

    124         115,6          26,9         -39,9         130,9          11,6 

    125         119,8          33,6         -18,4         123,6          29,8 

    126           0,2          56,1         -15,4          60,0          -3,7 

    127          -1,7         -68,3          19,3           3,4         -73,5 

    128          45,1         -78,6          23,1          49,2         -82,8 

    129          47,8         -86,3          22,7          51,5         -90,0 

    130          23,5         -83,5          26,1          29,5         -89,5 

    131          -4,9         -83,4          33,1           7,2         -95,5 

    132          -9,1         -39,1         -45,2          23,5         -71,7 

    133          33,2         -33,2         -35,9          49,0         -48,9 

    134          92,0         -31,6         -33,3         100,3         -40,0 

    135          92,5         -26,5         -35,6         102,3         -36,4 

    136          -2,3         -23,9         -38,9          27,2         -53,4 

    137          -1,0          26,7          36,0          51,4         -25,7 

    138          75,1          18,4          41,1          96,7          -3,1 

    139          95,2           1,7          21,3          99,8          -2,9 

    140          16,2           9,1          18,6          31,6          -6,3 

    141           8,0         -17,9          52,4          49,0         -58,9 

    142           7,8         -36,7         -69,0          58,1         -86,9 

    143           8,8          -2,3         -36,5          40,2         -33,6 

    144         117,5          19,7         -29,4         125,7          11,5 

    145         124,8          25,8         -49,4         145,3           5,3 

    146           0,1          34,7         -57,2          77,1         -42,3 
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   Node        Moment        Moment        Moment     Principal     Principal 

    No.                                                  moment        moment 

      I            mx            my           mxy           mh1           mh2 

    [1]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m]      [kN.m/m] 

 ---------------------------------------------------------------------------- 

    147           0,3         124,8          32,2         132,6          -7,5 

    148         122,4         204,8          36,2         218,4         108,8 

    149         221,6         252,2          37,5         277,4         196,4 

    150         -10,1          95,1          41,2         109,3         -24,3 

    151        -106,0          47,9          54,2          65,1        -123,1 

    152         -93,4           0,2          11,4           1,6         -94,7 

    153        -103,5           2,7           0,8           2,7        -103,5 

    154        -124,9          -2,4         -11,9          -1,2        -126,1 

    155        -136,1          -2,6         -16,8          -0,6        -138,1 

    156        -110,0          -1,9         -26,1           4,1        -115,9 

    157         -90,7           9,3         -55,7          34,2        -115,6 

    158        -113,7         -35,6        -106,2          38,5        -187,8 

    159         -13,0          36,3         -71,6          87,4         -64,1 

    160         171,0         187,5         -54,6         234,5         124,1 

    161         209,9         232,5         -49,5         272,0         170,5 

    162          -5,5          97,8         -46,4         115,6         -23,3 

    163          -0,6         109,2          34,2         119,0         -10,4 

    164          92,4          86,2          36,2         125,7          52,9 

    165         106,8          59,9          50,0         138,6          28,1 

    166          12,1          85,5          62,6         121,3         -23,8 

    167         -65,9          69,8          62,3          94,1         -90,2 

    168         -67,1          38,8          32,8          48,1         -76,5 

    169         -66,2          20,9          -1,5          20,9         -66,2 

    170        -108,9          30,6         -19,6          33,3        -111,6 

    171        -131,4          31,9         -13,7          33,0        -132,5 

    172         -81,3          25,3         -17,2          28,0         -84,0 

    173         -48,6          13,2         -55,7          46,0         -81,4 

    174         -74,9          43,8        -102,0         102,4        -133,6 

    175         -18,6          54,4         -93,4         118,2         -82,4 

    176         107,2          50,3         -73,3         157,4           0,1 

    177         128,7          49,3         -50,2         153,1          25,0 

    178           2,2          79,0         -41,8          97,3         -16,1 

    179          -0,3         103,2          48,5         122,3         -19,4 

    180          96,8         130,9          47,9         164,7          63,0 

    181         138,9         147,8          44,8         188,3          98,3 

    182         -11,1         113,3          48,7         130,1         -27,8 

    183         -54,5         116,1          57,0         133,4         -71,7 

    184          19,0         150,3          41,5         162,3           7,0 

    185          40,5         154,1           2,2         154,1          40,5 

    186        -102,9         101,0         -18,5         102,7        -104,6 

    187        -137,1          81,4         -11,7          82,0        -137,7 

    188         -42,6         116,6         -14,7         117,9         -43,9 

    189          84,4         156,3         -56,5         187,4          53,4 

    190         -63,0          94,5         -90,8         135,9        -104,4 

    191         -43,3          71,2         -81,4         113,4         -85,6 

    192          98,4          93,6         -63,9         159,9          32,0 

    193         134,4          95,7         -55,0         173,3          56,8 

    194          -1,2          53,0         -55,2          87,4         -35,6 

    195          -1,3          77,6          32,3          89,1         -12,8 

    196          94,6         145,7          32,9         161,8          78,6 

    197         156,7         182,1          44,8         216,0         122,9 

    198         -28,2         106,8          49,4         123,0         -44,3 

    199         -53,0         108,6          38,4         117,2         -61,7 

    200          61,0         179,0          24,6         183,9          56,1 
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    201         100,7         201,7          15,4         204,0          98,3 

    202         -98,6         106,3           3,3         106,4         -98,7 

    203        -136,6          79,1         -14,6          80,1        -137,6 

    204         -19,9         137,7         -32,2         144,0         -26,2 

    205         156,1         212,4         -46,6         238,7         129,8 

    206         -60,7          90,9         -61,1         112,5         -82,2 

    207         -60,2          61,6         -71,4          94,5         -93,2 

    208          88,6         114,1         -63,2         165,8          36,9 

    209         134,9         123,9         -43,7         173,4          85,4 

    210          -5,2          33,1         -35,3          54,1         -26,2 

    211          -1,1           4,1          20,2          21,8         -18,8 

    212          41,6          -2,3          21,5          50,3         -11,1 

    213          51,5          -3,3          43,9          75,9         -27,6 

    214         -18,1           1,0          50,3          42,6         -59,7 

    215         -39,2          -0,1          27,6          14,2         -53,5 

    216          20,1          -1,7          13,4          26,5          -8,1 

    217          16,9          -3,8          18,9          28,1         -15,0 

    218         -75,7           0,6          11,5           2,3         -77,4 

    219        -127,1          -1,1         -14,9           0,6        -128,8 

    220         -20,6          -0,1         -37,5          28,5         -49,2 

    221          59,9          -4,0         -39,9          79,1         -23,2 

    222         -33,3           0,6         -46,2          32,9         -65,5 

    223         -61,0          -0,6         -66,2          41,9        -103,6 

    224          34,1          -0,7         -61,2          80,3         -47,0 

    225          57,1          -3,5         -35,4          73,4         -19,7 

    226           5,4           4,0         -21,3          26,1         -16,6 

 ---------------------------------------------------------------------------- 
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1 An overview of ELPLA-Boring 

 

ELPLA-Boring is used to edit and display graphically the boring logs (boring layers, soil 

material, foundation level and water table). The drawing of the boring logs can be displayed first 

on the screen, and then can be sent to the printer or plotter. The program draws the soil layers by 

different symbols according to the German Standard DIN 4023. 

 

ELPLA-Boring can also display the stress in soil under a specified point on the foundation with 

effective stress beside the corresponding boring log. The stress in soil is used to determine the 

limit depth of the soil layers. 

  

The drawings, if desired, can be saved as WMF-format files, in which they can be exported to 

other Windows applications to prepare reports, slide presentations, or add further information. 

 

 

2 Description of ELPLA-Boring 

 

ELPLA-Boring is a 32-bit, graphical software product that operates under Microsoft Windows 

9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows applications makes it 

easy to learn how to use ELPLA-Boring, especially if you are already familiar with the Windows 

environment. 

 

The program package ELPLA consists of 7 separate programs. These can be run independently. 

Name and short description of the seven separate programs are given in Table H-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed using ELPLA-Solver. Finally, 

results can be presented as graphical drawings, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor. 

 

Table H-1 Names and descriptions of the seven separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and Displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

In order to use ELPLA-Boring, first the user must define the project data by ELPLA-Data, and 

then must analyze by ELPLA-Solver. Table H-2 gives a list of files, which are read or created by 

ELPLA-Boring. The files can be classified in four groups. 
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Table H-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Boring files (*.BOR)         ELPLA-Boring 

C    Project data files                      ELPLA-Data 

D    Final result files                           ELPLA-Solver 

 

Further more, Table H-3 shows filenames, contents and groups of all files that may be read or 

created by ELPLA-Boring. 

 

Table H-3 Names and contents of files 

 

A Main data files 

Filename   Contents  

FIRMA   Firm header 

STEU                       Default directory for files that are saved by ELPLA 

NOFORMAT            Number formats  

UNITS    System of units 

 

B Boring files 

Filename   Contents 

LINEFORM. BOR               Line formats 

FONT. BOR                          Font data 

LEGENDE. BOR              Legend data 

PAINT. BOR                         Fill color data 

PLOTPAR. BOR              Plot parameters 

NODISPLA. BOR        Data of display values 

ORDINATE. BOR            Max. width data 

 

C Project data files 

Filename   Contents 

*. AUF         3 lines text to identify the project 

*. P21          Data of slab properties/ levels/ coordinates 

*. BAU         Soil properties 

*. LDH       Data of the limit depth 

 

D Final result files 

Filename   Contents 

*. LD1    Results of the limit depth 

The asterisk (*) matches any filename with the specified extension. 

 

 

3 Starting ELPLA-Boring 

 

Start ELPLA-Boring by clicking on the program icon. The introduction screen (Figure H-1) 

appears. 
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Figure H-1 Introduction screen of ELPLA-Boring 

 

The menu head of Figure H-1 contains the following 7 commands: 

 

- File 

- View 

- Graphic 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the seven menu commands, other sub-commands or options become 

available. The seven menu commands and their sub-commands are presented and described in 

the following paragraphs 4 to 11. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Make WMF-File 

- Print 

- Page setup 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu–"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure H-2 shows “Open” Dialog box used to open a specified project. 

 

 
Figure H-2 "Open project" Dialog box 

 

4.2 File Menu–"Make WMF-File" command 

 

By "Make WMF-File" command the drawing can be saved in a format that can be read by other 

programs. This feature allows you to include your drawing in reports and presentations and to 

enhance the drawing using other drawing or CAD software packages. The drawing can be 

exported in the Windows Metafile (WMF) format. 

 

Figure H-3 shows the “Save as” Dialog box used to export the drawing with the filename you 

wish to give the exported file, including extension and the directory in which to save the file. If 

the file name already exists, you may select to overwrite the existing file. 

 

 
Figure H-3 "Save as" Dialog box 

 

4.3 File Menu–"Print" command  

 

By "Print" command data and results can be graphically plotted or printed. Only the objects 

currently displayed on the drawing are printed. Figure H-4 shows "Print" Dialog box. The printer 

group box contains controls for selecting the printer and changing its properties. Use "Name" 

Combo box to select the printer and use "Properties" Button to set printer settings. The number 

of printing copies can be defined in "Copies" Input box. 
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Figure H-4 "Print" Input box 

 

4.4 File Menu–"Page setup" command 

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size, and paper source, as well as other printing 

options (Figure H-5). 

 

 
Figure H-5 "Page setup" Dialog box 

 

4.5 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

 

4.6 File Menu–"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-Boring is quitted, Figure H-6. 
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Figure H-6 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 

 

5.1 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of the current operation. 

 

5.2 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

6 Graphic Menu 

 

The graphic menu is the main menu, used to display the specified drawing. The Graphic Menu 

command is: 

 

- Drawing boring logs/ Limit depth 

 

6.1 Graphic Menu–"Boring logs/ Limit depth" command 

 

By this command the boring logs (boring layers, soil material, foundation level and water table) 

can be displayed. The stress in soil under the foundation with effective stress can be displayed 

beside the corresponding boring log. The stress in soil is used to determine the limit depth of the 

soil layers. 

 

When "Drawing boring logs/ Limit depth" command is chosen, the selection Dialog box shown 

in Figure H-7 appears. In this Dialog box select the boring logs or the limit depths to draw, then 

click "OK" Button. Figure H-8 shows boring logs, while Figure H-9 shows a limit depth of soil 

layers. 
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Figure H-7 "List of borings" Dialog box 

 

 
Figure H-8 Drawing of 3 borings with multi-layers and different soil material 
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Figure H-9 Limit depth of the soil layers 

 

 

7 Options Menu 

 

The Options menu has the following commands: 

 

- Plot parameters 

- Display values 

- Scale 

- Title 

- Page No. 

- Copy 

 

7.1 Options Menu–"Plot parameters" command 

 

Figure H-10 shows the parameters, set as default values by the program, or specified by the user.   

 

- Color soil layers 

- Draw the water table 

- Simple drawing of boring logs 

- Setting soil colors according to DIN 4023 

- Display soil properties C, Phi and Nue 

- Color foundation 

- Draw foundation 

- Draw measurement bar 

- Color limit depth 

- Page with frame 
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Figure H-10 "Plot parameters" Dialog box 

 

7.2 Options Menu–"Display values" command 

 

By "Display values" command the values of the following items can be displayed, if desired, on 

the drawing (Figure H-11): 

 

- Label of the boring 

- Layer description 

- Layer depth 

- Display text of soil symbols 

- Measurement bar 

- Foundation 

- Water level 

- Limit depth 

- Stress value 

 

 
Figure H-11 "Display values" Dialog box 

 

7.3 Options Menu–"Scale" command 

 

By "Scale" command the scale of the drawing can be defined as shown in Figure H-12. The 

defaulted value for the scale factor is chosen to pass the active printer-paper format. 
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Figure H-12 "Scale" Dialog box 

 

7.4 Options Menu–"Title" command 

 

By "Title" command the text data (two line texts above the drawing and two line texts under the 

drawing) can be defined, Figure H-13.   

 

 

Figure H-13 "Title" Dialog box 

 

7.5 Options Menu–"Page No." command 

 

By "Page No." command the page No. can be defined, Figure H-14.  

 

 
Figure H-14 "Page No. " Dialog box 

 

7.6 Options Menu–"Copy" command 

 

By "Copy" command the current drawing can be copied in Metafile-Format to Clipboard. Then it 

can be inserted directly to other Windows programs such as Word, WordPerfect and AutoCAD. 
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8 Format Menu 

 

The Format menu has the following commands: 

 

- Line formats 

- Fill color 

- Max. width 

- Font 

- Legend 

 

8.1 Format Menu–"Line formats" command 

 

Color, style and thickness of drawing lines can be defined (Figure H-15). The way a line is 

drawn depends on the setting of the color and style properties. 15 different colors and 5 styles for 

line formats are available. The following list shows the available lines, which can be formatted: 

 

- Identification box 

- Page boundary 

- Boring boundary 

- Soil layer levels 

- Soil symbols 

- Groundwater 

- Foundation 

- Measurement bar 

- Limit depth 

 

 
Figure H-15 "Line formats" Dialog box 

 

8.2 Format Menu–"Fill color" command 

 

The following list shows available items, which can be filled with a specified color, Figure H-16: 

 

- Groundwater 

- Foundation 

- Measurement bar 

- Stress due to foundation 

- Stress from neighboring foundations 

- Stress from soil weight 
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Figure H-16 "Fill color" Dialog box 

 

8.3 Format Menu–"Max. width" command 

 

By "Max. width" command the maximum width for the drawing can be defined, Figure H-17. 

 

 
Figure H-17 "Max. width" Dialog box 

 

8.4 Format Menu–"Font" command 

 

By "Font" command the font size (Figure H-18) and font type (Figure H-19) for the drawing can 

be defined. 

 

 
Figure H-18 "Font size" Dialog box 
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Figure H-19 "Font type" Dialog box 

 

8.5 Format Menu–"Legend" command 

 

By "Legend" command height and width of legends can be specified as shown in Figure H-20. 

Also the legend that you wish to display can be chosen. 

 

 
Figure H-20 "Legend" Dialog box 

 

 

9 Window Menu 

 

The Window menu has the following commands: 

 

- Zoom in 

- Zoom out 

- Zoom window 

- Zoom % 

- Original size 

 

9.1 Window Menu–"Zoom in" command 

 

By "Zoom in" command the size of the drawing on the screen can be reduced. 
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9.2 Window Menu–"Zoom out" command 

 

By "Zoom out" command the size of the drawing on the screen can be increased. 

 

9.3 Window Menu–"Zoom window" command 

 

By "Zoom window" command the size of the drawing on a specified area can be increased. 

 

9.4 Window Menu–"Zoom %" command 

 

By "Zoom %" command the size of drawing on the screen can be specified (Figure H-21). 

Choosing "Zoom %" allows you to increase or decrease the size at which the drawing is 

displayed. Choosing 100% displays the drawing at its original size. Clicking on the percentage, 

changes the drawing size to the specified percentage. The drawing can be displayed at any size 

by typing the desired percentage in the specified Edit box. 

 

 
Figure H-21 "Zoom %" Dialog box 

 

9.5 Window Menu–"Original size" command 

 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using "Original size" command. 

 

 

10 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Boring 

 

10.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure H-22. 
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Figure H-22 Menu "Contents" 

 

10.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

10.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

10.4 Help Menu–"About ELPLA-Boring" command 

 

The command, as shown in Figure H-23, gives information about ELPLA-Boring. 
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Figure H-23 Information form of ELPLA-Boring 

 

 

11 Tips and Tricks 

11.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table H-4 to Table H-11: 

 

Table H-4 Shortcut keys of menu head 

Shortcut keys  Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+g]     "Graphic" 

[Alt+o]     "Options" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table H-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [w]    "Make WMF-File" 

[Ctrl +p] or [Alt+f] then [p]    "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table H-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [g]    "Tool bars-Graphic" 

[Alt+v] then [t], then [o]    "Tool bars-Options" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 

 

Table H-7 Shortcut keys of Graphic-Command 

Shortcut keys Action 

[Alt+g] then [o] Calling command  "Drawing boring logs/ Limit depth" 
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Table H-8 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [d]     "Display values" 

[Alt+o] then [s]     "Scale"  

[Alt+o] then [t]     "Title"  

[Alt+o] then [p]     "Page No."  

[Alt+o] then [c]     "Copy" 

 

Table H-9 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+t] then [i]     "Fill color"  

[Alt+t] then [x]     "Max. width"  

[Alt+t] then [f]     "Font"  

[Alt+t] then [d]     "Legend" 

 

Table H-10 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out"  

[Alt+w] then [w]     "Zoom window"  

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 

 

Table H-11 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "New in ELPLA" 

[Alt+h] then [n]    "Short description of ELPLA" 

[Alt+h] then [a]     "About ELPLA-Boring" 
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11.2 Mouse 

 

By double-clicking the left mouse Button on a specified screen position, the user can obtain the 

almost menu of the program. 

 

- By double-clicking on legend, firm header, title or project identification, the 

corresponding menu appears 

 

- By double-clicking on scale in the identification box, "Scale"-Menu appears 

 

- By double-clicking on file name in the identification box, "Open"-Menu appears 

 

- By double-clicking on page No. in the identification box, "Page No."-Menu appears 

 

- By clicking the right mouse Button at any position on the screen, the user can also obtain 

the "Popup-Options"-Menu, Figure H-24 

 

 

 
Figure H-24 Menu "Popup-Options" 

 

 

12 Samples for graphical drawings using ELPLA-Boring 

 

ELPLA-Boring draws the soil layers by different symbols, where the same layers are presented 

with the same symbols for easy identification. For drawing the boring logs, the main symbols of 

German specification code are considered in ELPLA-Boring. It is possible to draw a total 

number of 46 soil and rock arts in boring logs according to German Standard DIN 4023.  
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Samples for symbols of soil layers according to German Standard DIN 4023 are presented in 

page P1. The pages P2 to P3 show also some graphical presentations of boring logs and limit 

depth according to Table H-12 and Table H-13. 

 

12.1 Graphical drawings of boring logs 

 

Table H-12 Boring logs 

Presentation                      Page 

Boring logs according to DIN 4023     P1 

Simple presentation of boring logs    P2 

 

12.2 Graphical drawings of limit depth 

 

Table H-13 Limit depth 

Presentation       Page 

Limit depth       P3  

 

 

13 Reference 

 

[1] DIN 4023. Baugrund- und Wasserbohrungen. Zeichnerische Darstellung der Ergebnisse 

 Beuth-Verlag, Berlin 1984 
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1 An overview of GEOTEC-Editor 

 

GEOTEC-Editor is a simple word processing program. The project data or results can be 

displayed, changed or printed through GEOTEC-Editor. Data or results, if desired, can be saved 

as ASCII-format or RTF-Format files. These files can be exported to other Windows-

applications (for example WordPerfect or Word) to prepare reports or add further information. 

 

 

2 Description of GEOTEC-Editor 

 

GEOTEC-Editor is a 32-bit software product that operates under Microsoft Windows 9x/ NT/ 

ME/ XP. The common "what you see is what you get" of Windows applications makes it easy to 

learn how to use GEOTEC-Editor, especially if you are already familiar with the Windows 

environment. 

 

The program package ELPLA consists of 7 separate subprograms. The seven separate 

subprograms can be run independently. The name and short description of the seven separate 

subprograms are given in Table I-1. 

 

The usage of ELPLA is typically such that first data files are created describing a certain problem 

by ELPLA-Data. Then the project problem is analyzed by using ELPLA-Solver. Finally, the 

results can be presented as graphical drawings, graphs and tables using the five separate 

subprograms ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-

Editor. 

 

Table I-1 Names and descriptions of the seven separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing the project data 

ELPLA-Solver                        Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

The next paragraphs describe the purpose and function of each GEOTEC-Editor command.  

 

 

3 Starting GEOTEC-Editor 

 

Start GEOTEC-Editor by clicking the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure I-1) appears.  
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Figure I-1 Introduction screen of GEOTEC-Editor 

 

The menu head of Figure I-1 contains the following 6 commands: 

 

- File 

- Edit 

- View 

- Format 

- Window 

- Help 

 

After clicking a command, other sub-commands or options become available. These commands 

and their sub-commands are presented and described in the following paragraphs 4 to 10. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- New 

- Open 

- Close 

- Save 

- Save as 

- Print 

- Page setup 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu –"New" command 

 

By "New" command a new file is created. 

 

4.2 File Menu –"Open" command 

 

By "Open" command an existing file is opened. Figure I-2 shows "Open" Dialog box used to 

open a specified file. 

 

 
Figure I-2 "Open" Dialog box 

 

4.3 File Menu –"Close" command 

 

By "Close" command the current file is closed. 

 

4.4 File Menu –"Save" command 

 

By "Save" command the current file is saved. 

 

4.5 File Menu –"Save as" command 

 

By "Save as" command the current file is saved under a new file name. 

 

4.6 File Menu–"Print" command 

 

By "Print" command text can be printed. Only the text file currently displayed is printed. Figure 

I-3 shows "Print" Dialog box. The printer group box contains controls for selecting the printer 

and changing its properties. Use "Name" Combo box to select the printer and use "Properties" 

Button to set printer settings. The number of printing copies can be defined in "Copies" Input 

box (Figure I-3). For more information about printer settings, see your Windows documentation. 
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Figure I-3 "Print" Input box 

 

4.7 File Menu–"Page Setup" command 

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size, and paper source, as well as other printing 

options. Figure I-4 shows "Page setup" Dialog box. 

 

 
Figure I-4 "Page setup" Dialog box 

 

4.8 File Menu –"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last loaded four files. 

 

4.9 File Menu –"Exit" command 

 

By "Exit" command all files are closed and GEOTEC-Editor is quitted, Figure I-6. 
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Figure I-5 "Exit" Message box 

 

 

5 Edit Menu 

 

The Edit Menu commands are: 

 

- Undo 

- Redo 

- Cut 

- Copy 

- Paste 

- Clear 

- Select all 

- Find 

- Find next 

- Replace 

 

5.1 Edit Menu–"Undo" command 

 

By "Undo" command the user can undo the last action. 

 

5.2 Edit Menu–"Redo" command 

 

By "Redo" command the user can redo the last action. 

 

5.3 Edit Menu–"Cut" command 

 

Here the selected text can be removed, so that it can be placed in another part of the text file. 

 

5.4 Edit Menu–"Copy" command 

 

By "Copy" command the selected text is copied in the Clipboard so that it can be placed in 

another part of the text file. 

 

5.5 Edit Menu–"Paste" command 

 

By "Paste" command the contents of the Clipboard are placed in the text file. 

 

5.6 Edit Menu–"Clear" command 

 

By "Clear" command the selected text can be removed from the text file. 
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5.7 Edit Menu–"Select all" command 

 

By "Select all" command all text at once can be selected. 

 

5.8 Edit Menu–"Find" command 

 

By "Find" command the user can search for a specified text. Figure I-6 shows "Find" Dialog box. 

In "Find what" Text box the user enters the text to search for. Then click "Find next" Button. 

GEOTEC-Editor will start searching according to the following options: 

 

Match case 

Finds only text that has the same pattern of uppercase and lowercase characters as the text was 

specified in "Find what" Text box 

 

Find whole words only 

Finds only whole words instead of searching for text inside longer words 

 

Find in selection only 

Searches inside only the selected text instead of searching for text inside all file 

 

 
Figure I-6 "Find" Message box 

 

5.9 Edit Menu–"Find next" command 

 

By "Find next" command the user can search for more instances of the same text that was 

specified in "Find what" Text box of Figure I-6. 

 

5.10 Edit Menu–"Replace" command 

 

By "Replace" command the user can search for and replace a specified text. Figure I-7 shows 

"Replace" Dialog box. In "Find what" Text box the user enters the text to search for. In "Replace 

with" Text box the user enters the text to replace with "Find what" Text box. Then click 

"Replace" Button. GEOTEC-Editor searches for the next instance of the text that matches the 

text in "Find what" Text box and replaces it with the text in "Replace with" Text box according 

to the following options: 

 

Match case 

Finds and replaces only text that has the same pattern of uppercase and lowercase characters as 

the text was specified in "Find what" 

 

Find whole words only 

Finds and replaces only whole words instead of searching for text inside longer words 
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Find in selection only 

Searches and replaces inside only the selected text instead of searching for text inside all file 

 

Note 

By "Replace All" command all instances of the text can be replaced 

 

 
Figure I-7 "Replace" Message box 

 

 

6 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 

 

6.1 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of the current operation. 

 

6.2 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

7 Format Menu 

 

The Format Menu commands are: 

 

- Font 

- Paragraph 

- Numbering 

- Bullets 

- Protect 

 

7.1 Format Menu –"Font" command 

 

By "Font" command the font type, style, or size (Figure I-8) for the selected text, if existing, or 

new text can be defined. 
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Figure I-8 "Font" Dialog box 

 

7.2 Format Menu –"Paragraph" command 

 

By "Paragraph" command the paragraphs (Figure I-9) for the selected text, if existing, or new 

text can be formatted. 

 

The following formats can be defined: 

 

Left 

Specifies the number of units (inches) to indent text from the left margin 

 

Right 

Specifies the number of units (inches) to indent text from the right margin 

 

First line 

Specifies the number of units (inches) to indent text from the left margin of the first line 

 

Alignments 

The alignments that are available for the selected paragraph can be listed as follows:  

 

Left   Aligns text at the left indent 

Right   Aligns text at the right indent 

Centered Centers the text between margins 

Justified Justifies the text between margins 

 

Before 

Specifies the number of units (Twips) to leave before the paragraph 

 

After 

Specifies the number of units (Twips) to leave after the paragraph 
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Line spacing 

The line spacing that is available for the selected paragraph can be listed as follows:  

 

Single  The line spacing is single space 

1.5 single The line spacing is 1.5 single space 

Double The line spacing is double space 

 

 
Figure I-9 "Paragraph" Dialog box 

 

7.3 Format Menu –"Numbering" command 

 

By "Numbering" command the selected text can be numbered. 

 

7.4 Format Menu –"Bullets" command 

 

By "Bullets" command the selected text can be bulleted. 

 

7.5 Format Menu –"Protect" command 

 

By "Protect" command the text file can be protected from any editing process. Before applying 

any editing process a message will appear as shown in Figure I-10.  

 

 
Figure I-10 Edit Message box 
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8 Window Menu 

 

The Window menu has the following commands: 

 

- Cascade 

- Tile horizontally 

- Tile vertically 

- Arrange icons 

- Window 1, 2, 3, … 

 

8.1 Window Menu–"Cascade" command 

 

By "Cascade" command all non-minimized forms are cascaded. 

 

8.2 Window Menu–"Tile horizontally" command 

 

By "Tile horizontally" command all non-minimized forms are tiled horizontally. 

 

8.3 Window Menu–"Tile vertically" command 

 

By "Tile vertically" command all non-minimized forms are tiled vertically. 

 

8.4 Window Menu–"Arrange icons" command 

 

When choosing "Arrange icons" command, the icons of minimized forms are arranged. 

 

8.5 Window Menu–"Window 1, 2, 3, …" command 

 

By this command the user can display one list of the pervious loaded data or results. 

 

 

9 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About GEOTEC-Editor 

 

9.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide . 

 

 

9.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 
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9.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

9.4 Help Menu–"About GEOTEC-Editor" command 

 

Clicking the command "About GEOTEC-Editor" displays the information form of GEOTEC-

Editor, which gives information about GEOTEC-Editor. 

 

 

10 Tips and Tricks 

10.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Tables I-2 to I-8: 

 

Table I-2 Shortcut keys of menu head 

Shortcut keys Action 

[Alt+f] Calling menu head  "File" 

[Alt+e]    "Edit" 

[Alt+v]    "View" 

[Alt+f]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 

 

Table I-3 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +n] or [Alt+f] then [n]  Calling command  "New" 

[Ctrl +o] or [Alt+f] then [o]     "Open" 

[Alt+f] then [c]    "Close" 

[Ctrl +s] or [Alt+f] then [s]     "Save" 

[Alt+f] then [a]     "Save as" 

[Ctrl +p] or [Alt+f] then [p]     "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [1] Calling the first file from the last four loaded files 

[Alt+f] then [2]  Calling the second file from the last four loaded files 

[Alt+f] then [3]  Calling the third file from the last four loaded files 

[Alt+f] then [4]  Calling the fourth file from the last four loaded files 

[Ctrl+q] or [Alt+f] then [x]  Calling command  "Exit" 
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Table I-4 Shortcut keys of Edit-Command 

Shortcut keys Action 

[Ctrl+z] or [Alt+e] then [u] Calling command  "Undo" 

[Ctrl+y] or [Alt+e] then [r]    "Redo" 

[Ctrl+x] or [Alt+e] then [t]    "Cut" 

[Ctrl+c] or [Alt+e] then [c]    "Copy" 

[Ctrl+v] or [Alt+e] then [p]    "Paste" 

[Del] or [Alt+e] then [c]    "Clear" 

[Alt+e] then [a]    "Select all" 

[Ctrl+f] or [Alt+e] then [f]    "Find" 

[F3] or [Alt+e] then [n]    "Find next" 

[Ctrl+h] or [Alt+e] then [r]    "Replace" 

 

Table I-5 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b] Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [e]    "Tool bars-Edit" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [s]    "Tool bars-Style-Transparent" 

 

Table I-6 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [f]  Calling command  "Font"  

[Alt+t] then [p]     "Paragraph" 

[Alt+t] then [n]     "Numbering" 

[Alt+t] then [b]     "Bullets" 

[Alt+t] then [r]     "Protect" 
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Table I-7 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [c]  Calling command  "Cascade" 

[Alt+w] then [h]     "Tile horizontally"  

[Alt+w] then [v]     "Tile vertically"  

[Alt+w] then [a]     "Arrange icons" 

[Alt+w] then  

[1, 2, 3, …]  

   "Window 1, 2, 3, …" 

 

Table I-8 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "New in ELPLA" 

[Alt+h] then [n]    "Short description of ELPLA" 

[Alt+h] then [a]     "About GEOTEC-Editor" 

 

 

10.2 Mouse 

 

By clicking the right mouse Button on the screen the user can also obtain the Popup-Format-

Menu, Figure I-13. 

 

 
Figure I-13 Menu "Popup-Format" 
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